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OpenWorkse Software Installation Procedures

Introduction

About the OpenWorks. 5000.8.1.0 Software

Supported Platforms

The OpenWorks® database instance created with the OpenWorks®
software is a repository for geoscience project data for the oil and gas
industry. The integrated applications from Landmark® software and
third-party applications built with the OpenWorks® Development Kit
can access and manage the data in the OpenWorks® database instance.

This guide will help you install and configure the OpenWorks®
software and its database instance on the following operating systems:

Red Hat Enterprise Linux 4.x and 5.x, 32-bit and 64-bit
Windows XP, 32-bit Service Pack 3 and 64-bit Service Pack 2
Windows Server 2008, 64-bit Service Pack 2

Windows Server 2003, 32-bit and 64-bit Service Pack 2
Windows Vista, 64-bit Service Pack 2

Windows 7, 64-bit

New Installations of the OpenWorks® Software

The procedures for installing the OpenWorks® software are delineated
in the chapters following this one. They are divided into Windows and
Linux procedures.

The OpenWorks® software has two basic installation components:

Database Installation: Includes the database server software and
the OpenWorks® database schemas to create an OpenWorks®
database instance.

Software Installation: Includes the utilities and managers of the
OpenWorks® software as well as the data importers and exporters
of the GeoDatalLoad™ software. The GeoDatal.oad™ software
requires a license acquired separately from the OpenWorks®
software.

5000.8.1.0

About the OpenWorks® 5000.8.1.0 Software 1
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Database Software Installation: 64-bit versus 32-bit

The database server software included in the database installation is the
Oracle 11g database software and runs in a 64-bit operating system,
Windows or Linux.

If you want to install the OpenWorks® database schemas in an already
installed Oracle 10g or 11g database server, or if you want to install the
database server in a 32-bit operating system, the Oracle software must
be acquired and installed separately from the OpenWorks® software.

Installing on an Existing Oracle Database

You can install the OpenWorks® schemas on an existing Oracle
database server. See “OpenWorks® Schemas on an Existing Oracle
Database” on page 87.

After you install the OpenWorks® schemas, you install the
OpenWorks® software on the server and on the client.

Upgrading from Oracle 10g to 11g

The OpenWorks® software can use the Oracle 10g (10.2.0.5) database
server and client, or the Oracle 11g (11.2.0.2) database server and
client. Information about upgrading an Oracle database server and its
software is in “Upgrade the Oracle Software: 10g to 11g” on page 105.

Do Not Mix Oracle Versions

When the OpenWorks® server uses the Oracle 11g database server, only
Oracle 11g clients should access the database server.

Likewise, when the OpenWorks® server uses the Oracle 10g database server, only
Oracle 10g clients should access the database server.

Upgrading Projects

You can upgrade projects from the following OpenWorks® releases:

1998.x
 2003.x
*  5000.x

2 About the OpenWorks® 5000.8.1.0 Software 5000.8.1.0
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Project upgrades can be performed through Project Administration, or
Database Administration. Project Administration and Database
Administration are available in the Command Menu or Start Menu.

For software upgrades from previous release 5000.x versions,

see “Upgrade the OpenWorks® Software” on page 95. The
OpenWorks® software does not support in-place OpenWorks®
software upgrades from releases before version 5000.0.2.5. You will
need to install this version of the OpenWorks® software in a different
location from a previous version.

If you are upgrading from an OpenWorks® 2003.x environment, you
can use the Project Administration backup/restore functionality or an
Oracle full database export/import process to migrate your projects to
this version of the OpenWorks® software. For upgrades from
OpenWorks® R2003.x, see “Upgrade OpenWorks® R2003.12
Database” on page 139.

5000.8.1.0 About the OpenWorks® 5000.8.1.0 Software 3
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Introduction

System Requirements

Platform/Hardware Specifications

This section contains the platform and software specifications for the
OpenWorks® software.

Requirements: Running Other Landmark Applications with the
OpenWorks® Software

The requirements in this section are only for running the OpenWorks® software and
its database. If you are running other software (such as the DecisionSpace® Desktop
software), look to the documentation of that software for additional requirements.

The OpenWorks® software supports the Linux and Windows platforms.

Server Client
Minimum/ Minimum/
Platform | Operating System Processor? | Recommended | Recommended
RAM |Swap® | RAM | Swap
Linux Red Hat Enterprise Linux 5.x (primary | X86 64 2 GB/ 4 GB/ 1 GB/ 2 GB/
64-bit Linux version) 8 GB 16 GB 2 GB 4GB
Red Hat Enterprise Linux 4.x (The
OpenWorks® software will not run with
RHEL 4.5 using AMD processors)
Linux Red Hat Enterprise Linux 4.x 1A32 2GB/ | 4GB/ 1 GB/ 2 GB/
32-bit | Red Hat Enterprise Linux 5.¢ 8GB |16GB |2GB |4GB
Windows | Microsoft Windows XP 1A32, 2 GB/ 4 GB/ 1 GB/ 2 GB/
32-bit Microsoft Windows Server 2003 X86 64 8 GB 16 GB 2 GB 4GB
Windows | Microsoft Windows XP X86 64 2GB/ | 4GB/ 1 GB/ 2 GB/
64-Dit | NMicrosoft Windows Vista 8§GB | 16GB |2GB |4GB
Microsoft Windows 7
Microsoft Windows Server 2003
Microsoft Windows Server 2008
a. Processor
TA32 = Intel Pentium IV, Xeon
X86_64 = Intel: Xeon EM64T. AMD: Opteron, Athlon 64, and Athlon 64FX
b. Swap: If the machine is an Oracle server, the swap space must be at least two times that of the
machine’s memory.
4 System Requirements 5000.8.1.0
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Notice to Solaris platform users

With version 5000.0.3.0, the OpenWorks® software is no longer supported on
Solaris. Landmarke® Customer Support will continue to provide support for
Solaris products through March 31, 2011.

Hard Drive Space

Besides the swap space requirements mentioned above, an installation
has other hard drive space requirements.

Server Disk Space

The following are the minimal disk space requirements for the
OpenWorks database server:

Type Minimum Space Comments

Database Software Files 4.4 GB Linux Installation files of the Oracle
8.1 GB Windows software.

Data Files of Database 1.7 GB Additional space may be required
depending on the amount of data in
the database.

Fast Recovery Area of 160 GB The amount of free space needed by

Database the processes and files of the
ArchiveLog mode.

OpenWorks Software 1.7 GB Installation files of the OpenWorks
software.

Client Disk Space

The following are the minimal disk space requirements for an
OpenWorks client installation:

Type Minimum Space Comments

Oracle Client Software 1.4 GB Linux Installation files of the Oracle

Files 730 MB Windows software.

OpenWorks Software 1.7 GB Installation files of the OpenWorks
software.
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Graphics Card

The OpenWorks® software runs on systems with the NVIDIA
QuadroFX family of graphics cards.

Software Specifications

All Platforms

Windows Only

All platforms require a browser and software from Oracle and Adobe.
The Oracle software is included in the database installer of
OpenWorks. Adobe Reader should be obtained from Adobe. Windows
platforms also require Open Text Exceed.

Oracle client software:

*  The client software is available on the Landmark Software
Manager (https://esd.halliburton.com/download/download.jsp).
The Oracle client must be version 11.2.0.2.

+  Ifthe OpenWorks® schemas and software will be used with the
Oracle 10g database and client must be version 10.2.0.5.0. The
software must be acquired and installed separately from the
OpenWorks® software.

Some of the documentation for the OpenWorks® software is provided
in Portable Document Format (PDF). To view these files, all platforms
require Adobe Reader 7.x, or later.

A browser is required on all platforms:

*  Linux: Mozilla Firefox 3.0 or higher
*  Windows: Internet Explorer 6.0.x or higher; or Mozilla Firefox 3.0
or higher

Open Text Exceed is required unless you are installing only the
OpenWorks® Basic software. For more information about configuring
Open Text Exceed, see “Exceed Configuration Instructions” in the
5000 Release Notes.

6 System Requirements 5000.8.1.0
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Licensing

The Landmark® Application Manager (LAM) is the license system
used to control access to applications from Landmark® software. LAM
is based on FLEXnet Publisher from Acresso Software. A new LAM
version is required for Release 5000.x. You should install the latest
LAM server software, version 5000.0.3.x.

You must obtain new licenses for all Release 5000 products. Contact
Landmark® Support or your account manager for updated licenses.

For instructions on how to install LAM and to obtain licenses, refer to
the Landmark Application Manager User s Guide
(LAM_UserGuide.pdf) for complete details.

Third-Party Applications: License Agreements

The applications from Landmark® software use various third-party
applications. Information about third-party applications is available for
all products. The Release Notes detail the third-party information or
define where the information is located. In addition, most applications
from Landmark® software have included a file titled Third Party.pdf
which includes attribution and license information for all third-party
products used in Landmark® software.

5000.8.1.0
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OpenWorks:. Documentation

Online Help

The online help and online manuals for OpenWorks® documentation
require a Web browser and Adobe Reader.

Some of the OpenWorks® documentation is available in a platform-
independent HTML format. A Web browser meeting the specifications
listed earlier in this chapter is required to view the OpenWorks® Online
Help (Linux: SOWHOME/docs/onlinehelp.htm;

Windows: $OWHOME%\docs\onlinehelp.htm).

Documents in PDF Format

Some of the documentation for the OpenWorks® software is in PDF
format. The documentation for the OpenWorks®

software Release 5000.x.x.x is created for, and tested with, Adobe
Reader 7.x on all of the operating systems on which the OpenWorks®
software can be installed.

Downloading Adobe Reader

You can download the Adobe Reader free of charge from the Adobe
web site. (www.adobe.com).

Installing Adobe Reader on Linux

The Adobe installation program asks you to accept a default
installation location or enter the path where Adobe Reader will install
its files. The path is used by the OpenWorks® help system to find
Adobe Reader. Therefore, it is recommended that you accept the
default location for the Adobe Reader files.

If you install Adobe Reader in another location, edit the
startAcrobat scriptin SOWHOME /bin, or make a link to
acroread (the Adobe Reader executable) in /usr/bin .

OpenWorks® Documentation 5000.8.1.0



Introduction OpenWorkse Software Installation Procedures

Installing Adobe Reader on Windows

Download the reader from the Adobe Web site. No configuration is
necessary when the reader is downloaded prior to installing the
OpenWorks® software.

5000.8.1.0 OpenWorks® Documentation 9



OpenWorkse Software Installation Procedures Introduction

10 OpenWorks® Documentation 5000.8.1.0



Windows Procedures OpenWorkse Software Installation Procedures

Windows Procedures

Scope

This section includes the procedures for installing Oracle 11g, the
OpenWorks® database, and the OpenWorks® and GeoDatal.oad™
software on servers and clients running on Windows 64-bit operating
systems.

For the installations of the OpenWorks schemas on other supported
versions of the Oracle software, see the OpenWorks® Software
Installation Procedures manual for version 5000.8.0.0

(OW _5000.8 installprocedures.pdf, which is available on Landmark
Software Manager). After the installation of the OpenWorks schemas,
return to “Install the OpenWorks® Software” on page 26 in this chapter
to install the OpenWorks software.

Do Not Mix Oracle Versions

When the OpenWorks® server uses the Oracle 11g database server, only
Oracle 11g clients should access the database server.

Likewise, when the OpenWorks® server uses the Oracle 10g database server, only
Oracle 10g clients should access the database server.

Procedures described in this section are:
»  Database server installation tasks
—  Creating an Oracle user with administrative privilege

— Installing the Oracle software on the server as well as the
OpenWorks® database and schemas

*  Oracle client installation tasks
— Installing the Oracle Client software on the client machine
* Installing the OpenWorks® software

*  Performing post-OpenWorks®-installation tasks

5000.8.1.0 Scope 11
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Assumptions

The procedures in this chapter assume the following:

1. You are installing OpenWorks® software on systems that do not
have prior installations of the OpenWorks® software.

Warning: Do not use the installation program for the database
instance (schemas) on an existing OpenWorkse database
instance

Do not attempt to upgrade an existing OpenWorks® database instance with
a new release of an OpenWorks® database installation program. Such an
action will destroy vital information in the OpenWorks® database instance.

When you upgrade the OpenWorks® software, and then upgrade (or
extend) the projects in the database (as described in “Upgrade the
OpenWorks® Software” on page 95), you are upgrading the OpenWorks®
database instance.

2. You are installing the Oracle 11g database software with a new
OpenWorks® database instance, the OpenWorks® software, and
the GeoDatalLoad™ software on a machine designated as the
server, with one of the following operating systems:

*  Windows Server 2003, 64-bit Service Pack 2
*  Windows Server 2008, 64-bit Service Pack 2
*  Windows XP, 64-bit Service Pack 2

* Windows Vista, 64-bit Service Pack 2

e Windows 7, 64-bit

3. You are installing the Oracle 11g client software on a machine
designated as a client.

For other types of installations, refer to the appropriate section of this
manual:

*  “Linux Procedures” on page 41

*  “Upgrade the OpenWorks® Software” on page 95

*  “OpenWorks® Schemas on an Existing Oracle Database” on
page 87
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Windows Server Installation Tasks

Create a User Account on the Server

OpenWorks® components that must be installed on the server are the
Oracle software and the OpenWorks® database and schemas. To install
them, use the following general workflow:

e Create a User Account on the Server

* Install the Oracle Software and OpenWorks Database Instance

Create a user with administrative privileges on the system on which
you are installing the Oracle software and OpenWorks® database
before installing the Oracle database.

1. Access the New User window.

Operating System

Command Path

Windows Server 2003
Windows Server 2008

Control Panel > Administration Tools (double
click) > Computer Management (double click)

In Computer Management window: System Tools >
Local Users and Groups > Users > Action (from
toolbar) > New User

Windows XP

Control Panel > User Accounts > Advanced tab >
Advanced button.

Right-click the Users folder under Local Users And
Groups, and select New User in the shortcut menu.

Windows Vista

Control panel > Classic view > User Accounts >
Manage User Accounts > Advanced tab >
Advanced button, then File > New

Windows 7

Control Panel > User Accounts > Manage User
Accounts > Advanced tab > Advanced button.

Right-click the Users folder under Local Users And
Groups, and select New User in the shortcut menu.

2. Inthe New User dialog box, complete the procedure for your

operating system.

* Enter the configuration for the new user: user name, full name
(or given name), password (and password confirmation), and
description. A common practice is to use a name that identifies

5000.8.1.0
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4.

this user with the Oracle installation, for example, oracle. For
this user, the user name and full name can be the same.

* Uncheck the User Must Change Password At Next Logon box.
* Click Create.

* Click Close, and close the Local Users And Groups window.
Make the new user an administrator.

Refreshing the List of Users: After closing the Local Users and
Groups window, the new user name may not appear in the Users
tab of the User Accounts dialog box. If so, close the dialog and

reopen it to refresh the list.

* In the User Accounts dialog box, select the new user account
and click Properties.

*  On the Group Membership tab, click Other and select
Administrators from the list.

Click OK in the User Accounts window.

Install the Oracle Software and OpenWorks Database Instance

Use this procedure to install the Oracle software as well as the
OpenWorks database instance in the Oracle database on the system
used as the database server. This procedure installing version 11.2.0.2.0
of the Oracle software on Windows.

Before you begin, you should know your Oracle system identification
(SID), as you will need to supply this during the installation.

1.

Log on as the user created for the Oracle installation. Even though
the Oracle user must have administrator privileges, do not install
as Administrator or using your personal account.

Create a directory for the OW_HOME_DIR sysfem environment
variable. The directory needs to be unique for the user because this
folder is where the Oracle wallet credentials will be stored.
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Set the OW_HOME_DIR as a system environment variable.

* From the Control Panel, select System And Security >
System, and then Advanced System Settings. (For
Windows XP or Windows Server 2003 operating systems,
select System.) The System Properties dialog displays.

* In the Advanced tab of the System Properties dialog, click the
Environment Variables button. Use the System Variables
(lower) pane of the dialog box to set the system variable and
then close the dialogs.

Download the software appropriate for your operating system

from the Landmark® Software Manager (https://

esd.halliburton.com/download/download.jsp).
OWDBSetup Win_with Oracle.zip
Extract the ZIP file.

Run the installation executable (OWDB_5000_8_1.exe). The
OpenWorks Database 5000.8.1.0 dialog displays.

Click Next. The Select The Type Of Installation pane displays in
the dialog.

Select Install Oracle media and build new OpenWorks
database instance. If the amount of memory is incorrect, the

Memory Check pane displays in the dialog.

In Windows, the amount of virtual memory should be twice the
amount of physical memory (RAM) in the computer.

If the amount of virtual memory is incorrect:
* Click Cancel to end the installation.
* Adjust the amount of virtual memory.

* Restart this installation procedure.

10. If the amount of virtual memory is correct, click Next.

5000.8.1.0
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I1.

12.

13.

In the Choose Install Folder pane:

* Enter the directory where you want to install the OpenWorks®
database files. The default path is:

C:\Landmark\OpenWorksDatabase
* Click Next. The Get Oracle Information pane displays.
In the Get Oracle Information pane:

* In Oracle Base, enter a path for the Oracle base directory. For
example:

c:\oracle\product

* In Oracle Home, enter the path for Oracle software. For
example:

c:\oracle\product\1l1l.2.0\dbhome_1

* In Oracle SID, accept the machine name as the Oracle system
identifier, or enter another identifier. The identifier, or database
instance name, should contain a maximum of eight
alphanumeric characters and the alphabetical characters should
be all capital letters. The first character should be alphabetical.
Do not use any special characters.

* Click Next. The Get Database Domain pane displays.

In Database Domain, enter the domain name if the database has
one, or leave it blank. The default is blank. The domain name
specifies the logical location of the database within a network, and
if one is entered, you must include the domain name when
referring to the database instance.

Domain name and Oracle SID

If you enter a domain name here, you must always specify the domain
name, along with the SID, when referencing the database instance.

The domain name can be uppercase letters (A-Z), numbers (0-9), and
the dash character, separated by periods. For example, to put a database
instance in a domain, such as 1gc.com, enter LGC.COM in the field.

The combination of Oracle SID and database domain cannot be more
than 40 characters.
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14. Click Next. The First Set Of Datafiles pane displays.

15. In the First Set Of Datafiles pane

Specify the directory where you want to install the first set of
database files.

This directory must be empty. If not, the installation will fail.

Accept the default amounts for the block size (16 KB), system
tablespace (1024 MB), and SysAux tablespace (256 MB).

The data block size is the default logical block size used in the
database. The size should be a multiple of the physical block

size of the storage device where the database is stored.

Click Next. The Second Set Of Datafiles pane displays.

16. In the Second Set Of Datafiles pane

Specify the directory where you want to install the second set
of database files.

This directory must be empty. If not, the installation will fail.

Accept the sizes for the Undo tablespace (1024 MB) and the
Redo Logs (150 MB).

Redo Logs size and Oracle tuning

The Redo Logs size is one of the parameters that can be adjusted if
necessary to improve database performance. See “Appendix: Oracle
Tuning Parameters” on page 173 for additional information.

Click Next. The Third Set Of Datafiles pane displays.

17. In the Third Set Of Datafiles pane

Specify the directory where you want to install the third set of
database files.

This directory must be empty. If not, the installation will fail.

5000.8.1.0
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* Accept the default sizes for the Temp tablespace (1024 MB)
and the Users tablespace size (5 MB).

* Click Next. The Approximate Database Size pane displays.
18. In the Approximate Database Size pane:
» Enter the possible size of the database instance. The default
and the minimum is 30 GB. This value is used in calculations
for backup and recovery.

* Click Next. The ArchiveLog Mode pane displays.

19. In the ArchiveLog Mode pane:

ArchiveLog Mode or No ArchiveLog Mode

Depending on what you select in this pane, you have three possible paths
before they converge again with the configuration of the SGA (System
Global Area) Allocation: ArchiveLog Mode; No ArchiveLog Mode but
without automatic backups; and No ArchiveLog Mode and with automatic
backups.

* Select ArchiveLog Mode (the default) to archive redo logs
before they are overwritten. This mode allows the database to
be backed up while the database is in an inconsistent state (or
while the database is being accessed by users).

— Click Next. The Schedule Backup Time pane displays.
— In the Schedule Backup Time pane:

* Type the number of days a backup file will be
retained. The minimum is one day. The default is
two days. After this time a file (such as a full or level
zero incremental backup) will be considered
obsolete and deleted.

* Enter the hour and minute when a backup is
performed.

* Click Next. The Recovery Destination pane
displays.
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— In the Recovery Destination pane:

— Specify the location for recovery files (control files,
redo logs, archived redo logs, flashback logs, and
RMAN backups). The location can be a system
directory or network location.

— Specify the maximum size (or disk quota) of the
recovery file area in units of gigabytes.

The amount of space can vary depending on the
amount of data in the database instance, the size of
data blocks, the number of changes to the data, the
number of days in the retention policy, and other
configurations of the database.

Ideally, the area should be able to contain all data files
in the database and all current backup files.

— Click Next. The SGA (System Global Area)
Allocation pane displays.

» Select NoArchiveLog Mode to allow redo logs for the
database instance to be overwritten without archiving the old
redo logs.

In NoArchiveLog Mode, Backups Require Database
Shutdown

With NoArchiveLog Mode selected in the ArchiveLog Mode
pane, a backup can only be performed when the database is in
a consistent state.

For an Oracle database to be in a consistent state, it must be
shutdown with the normal, immediate, or transactional
parameter, and the restarted database must be backed up in a
mode (such as the Mount mode), where the database is closed
to access, except for certain database administrator (DBA)
activities.

— Click Next. The Configure Autobackups pane displays.

— Select Off (the default and is recommended) in order to
perform manual backups. Clicking Next displays the SGA
(System Global Area) Allocation pane.
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— Select On to allow the database to perform automatic
backups. Since NoArchiveLog Mode was chosen, the
database must be closed, and then be restarted in a mode
where only DBA activities can be performed while the
backup occurs.

— Click Next. The Schedule Backup Time pane displays.
— In the Schedule Backup Time pane:

* Type the number of days a backup file will be
retained. The minimum is one day. The default is
two days. After this time a file (such as a full or level
zero incremental backup) will be considered
obsolete and deleted.

* Enter the hour and minute when a backup is
performed.

* Click Next. The Recovery Destination pane
displays.

— In the Recovery Destination pane:

» Specify the location for recovery files (control files,
redo logs, archived redo logs, flashback logs, and
RMAN backups). The location can be a system
directory or network location.

* Specify the maximum size (or disk quota) of the
recovery file area in units of gigabytes.

The amount of space can vary depending on the
amount of data in the database instance, the size of
data blocks, the number of changes to the data, the
number of days in the retention policy, and other
configurations of the database.

Ideally, the area should be able to contain all data
files in the database and all current backup files.

* Click Next. The SGA (System Global Area)
Allocation pane displays.

20
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20. Inthe SGA (System Global Area) Allocation pane:

Specify the amount of memory as a percentage that the system
global area (SGA) will use.

As a guideline, use the following percentages for SGA:
— Large (typically: a dedicated database server): 85%
— Medium (typically: a workstation): 30%

— Small (typically: a laptop): 10%

Click Next. The Schemas Directory pane displays.

21. Inthe Schemas Directory pane:

Specify the directory where you want to create OpenWorks®
schema database files.

Click Next. The Projects Directories pane displays.

22. In the Projects Directories pane:

Specify the directory where you want to create project files.
You must have at least one project directory. You can create
additional directories in order to distribute the files over a
number of file systems.

If desired, enter additional directories for project files.

Click Next. The Pre-installation Summary pane displays.

5000.8.1.0
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23.

24.

25.

26.

27.

28.

29.

30.

In the Pre-installation Summary pane

» Verify that all settings are correct. If necessary, click Previous
and correct settings.

* Click Install if all settings are correct. The Oracle wallet and a
number of other settings are configured during installation.

The installation starts. Windows, such as the Oracle Universal
Installer command prompt window, will display during the
installation as well as various informational dialog boxes.

Click Next.

The file, sqlnet.ora, is modified to include configurations for the
Oracle wallet. A backup is made of the file and saved in the same

directory. The Modified SqlNet.ora dialog displays.

Click OK in the dialog. The Restart SID And Listener pane
displays.

Accept the default Yes to shutdown and startup the instance and
listener.

Click Next. The Listener Output pane displays
Verify that the commands completed successfully.
Click Next. The Install Complete pane displays.
Click Done.

If there are any errors, additional windows will appear describing
the errors.

Acceptable Oracle error messages

Some Oracle errors are acceptable; e.g., errors that occur because of the
drop user statements and IMP_FULL DATABASE,
EXP_FULL _DATABASE role conflicts.

22
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Windows Client Oracle Installation

Use the procedures in this section to install Oracle software on each
client machine that will access the database you installed on the server.
You do not need to install an Oracle client on your Windows server.

Install Oracle Software on the Client Machine

1. Log on to the client machine as a user with administrator
privileges. Do not install as Administrator.

2. Download the Oracle software appropriate for your operating
system from the Landmark® Software Manager (https://
esd.halliburton.com/download/download.jsp). Refer to the table

below.
Operating System Oracle Client Software
11.2.0.2.0
Windows XP 32-bit Oracle 112020 Win32 Client.zip
Windows Server 2003 32-bit
Windows XP 64-bit Oracle 112020 Win64 Client.zip

Windows Server 2003 64-bit
Windows Vista 64-bit
Windows Server 2008 64-bit
Windows 7 64-bit

3. Extract the ZIP file to a local directory.

4. Run the installation program by starting setup.exe from the
directory to which you extracted the Oracle software. The Oracle
Client Installer dialog displays with the Select Installation Type
pane.

5. Inthe Select Installation Type pane:

* Ifyou plan on installing the OpenWorks® Full software on the
server, select Administrator.

* Ifyou plan on installing the OpenWorks® Basic software,
choose either Administrator or Runtime, depending on
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10.

I1.

12.

whether you will use the Discovery™ software from
GeoGraphix® (see below).

Installation type and OpenWorks® Basic

For the OpenWorkse Basic software, the Oracle client can be installed
with the Runtime or Administrator installation type. If the OpenWorks®
software will be used with the Discovery™ software from GeoGraphixe,
the Oracle client can be installed with Administrator or Custom installation
type. If the Custom installation type is chosen, you must select the
following components among other components you may choose: Oracle
Database Utilities, Oracle JDBC/Thin Interfaces, Oracle New, and
SQL*Plus

The file sqlnet.ora should contain the following lines:

WALLET_LOCATION=
(SOURCE=
(METHOD=FILE)
(METHOD_DATA=
(DIRECTORY=%0W_HOME_DIR%\wallet)
)
)
SOLNET.WALLET OVERRIDE= TRUE

If you are installing with the Custom option, consult a certified Oracle
Database Administrator for more information about other Oracle
components your installation may require.

Click Next. The Download Software Updates pane displays.
Select Skip Software Updates.

Click Next. The Select Product Languages pane displays.
The default selected language should be English.

Click Next. The Specify Installation Location pane displays.

In Oracle Base, enter a path for the Oracle base directory. For
example:

c:\oracle\product

In Software Location, enter the path for Oracle 11g installation.
For example:

c:\oracle\product\11l.2.0\client_1
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13.

14.

15.

16.

17.

Click Next. The Prerequisite Checks pane displays and then the
Summary pane if all the prerequisites are correct.

» If the check did not pass, correct the problems and restart the
installation program.

In the Summary pane

» Verify that all settings are correct.
* Click Install.

In the Finish pane, click OK.

Update tnsnames.ora with the information for the databases you
will use.

If the TNS_ADMIN variable is not set in the environment, the default
location of the file is % ORACLE _HOME%\network\admin.

If needed, update sqlnet.ora as described in the note fore the step
about the Select Installation Type pane.

5000.8.1.0
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Install the OpenWorkse Software

Install the OpenWorks® software on both the server and the client. The
procedure for installing the OpenWorks® software on the client is the
same as for installing the software on the server.

To install the OpenWorks® software:

1. Log on as a user with administrator privileges. Do not install as
Administrator.

2. Create an installation directory. For example:
c:\Landmark\OpenWorks

3. Setthe OW_HOME_DIR user environment variable to the path of
the directory of this user.

OW_HOME_DIR: User versus System Environment Variable

Be aware of the difference between the user and system
OW_HOME_DIR environment variables. With installation of the
OpenWorks® database instance on a server, the system environment
variable OW_HOME_DIR was set up. When you install the OpenWorks®
software you set up the user environment variable OW_HOME_DIR .

* From the Control Panel, select System And Security >
System, and then Advanced System Settings. (For
Windows XP or Windows Server 2003 operating systems,
select System.) The System Properties dialog displays.

* In the Advanced tab of the System Properties dialog, click the
Environment Variables button. Use the User Variables
(upper) pane of the dialog box to set the user variable and then
close the dialogs.

4. Setthe LM _LICENSE_FILE user environment variable.
The LM license file contains connection information about the
Landmark® Application Manager (LAM), or license server. For

example, it contains a value like the following:

2013@hostname . company . com
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10.

11.

12.

where 2013 is the TCP port for the license server on the host
machine, and where hostname . company . com 1is the full host
name, or IP address, of the machine on which the license server is
running.
Setthe Oracle_Home system environment variable. For example,
depending on what is installed on your system, the full Oracle server
software or just the client, the variable must be set to a path like the
following:

c:\oracle\product\1l1l.2.0\dbhome_1
or

c:\oracle\product\11l.2.0\client_1

Download the OpenWorks® software from the Landmark® Software
Manager (https://esd.halliburton.com/download/download.jsp).

Extract the ZIP file to a local directory.
Launch the installation program.
The installation program guides you through the installation.

On the Introduction pane, click Next. The License Agreement pane
displays.

On the License Agreement pane, accept the agreement to continue the
installation and click Next. The Choose Install Folder pane displays.

On the Choose Install Folder pane

* Specify the folder for the location of the OpenWorks® home
directory.

* Click Next. The Choose Install Set pane displays.

On the Choose Install Set pane:

* Select either a basic or full installation.
The Basic install is a scaled-down version of the OpenWorks®
software that focuses on the data management utilities and

does not require MKS or Exceed to run successfully. A Basic
installation does not include Project Administration, and does

5000.8.1.0
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not install the GeoDatalLoad™ software (the data import and
export utilities).

The Full install includes the Basic components plus the project
administration and data management tools of the OpenWorks®

software, and the GeoDatalLoad™ software.

The GeoDatal.oad™ software requires a license purchased
separately from the license for the OpenWorks® software.

Click Next. the OpenWorks® Flat File Setup pane displays.

13. In the OpenWorks® Flat File Setup pane:

Enter the system directory and the project directory for the
storage of OpenWorks® system and project files external to the
database (flat files).

When you enter the directory names, the system creates the
OW_SYS_DATA and OW_PROJ_DATA variables that point
to the location of the files.

Changing flat file storage location

Should you need to change where flat files are stored in the future, you
can edit the variables. See “Manage the Location of OpenWorks®
System Files” on page 36 and “Manage the Location of OpenWorks®
Project Files” on page 37 in the Windows Post-OpenWorks®-Installation
Tasks section.

Click Next. the Get Oracle 64-bit Information pane displays.

14. In the Get Oracle 64-bit Information pane:

Specify the directory where Oracle was installed by either
accepting the default, if it is correct, or entering the correct
directory.

Enter the appropriate Oracle alias. The Oracle alias is the
Oracle system identifier (SID). If a domain was specified for
database instance, add the domain to the alias. The alias name
is recorded in:

OracleHome \NETWORK\ADMIN\ tnsnames.ora

Click Next. The District.dat Configuration pane displays.
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15. In the District.dat Configuration pane:

Select Create A District.dat From TNSNAMES.ORA. The
installation program will create a district for each SID entry in
tnsnames.ora. Choosing this option is strongly recommended
for a new installation of the OpenWorks® software.

See “Understand and Configure Districts” on page 35 in the
Windows Post-Installation Procedures section for information
about configuring districts and about the district configuration
options.

Click Next.

MKS Installation panes or Pre-Installation pane

If MKS has not been installed, the Choose A Folder and
Redistributable Package panes appear as described in the following
steps.

If MKS has been installed, these steps will not appear.

16. In the Choose A Folder pane:

Choose the location for the installation of MKS.
Click Install.

In the License Info pane, click Next.

17. In the Pre-Installation Summary pane:

Verify that all settings are correct. If necessary, click Previous
and correct settings.

Click Install. The License pane displays, reminding you to
contact Landmark Customer Support if you do not have a
license for the software.

http://css.lgc.com/CustomerSupport/CustomerSupportHome.jsp
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18. In the License pane, click Next. If the Microsoft Visual C++ 2005
package is not installed, the Microsoft Visual C++ 2005 SP1
Redistributable Package dialog box displays.

19. In the Redistributable Package dialog:

* Click Yes to install the Microsoft Visual C++ Redistributable
Package.

* Click Yes again to install another version of Microsoft Visual
C++ Redistributable Package. The Microsoft Visual C++ 2008

Redistributable Setup dialog displays. In the dialog, do the
following:

—  Click Next.

— Check the I Have Read And Accept The License Terms
box.

— Click Install.
— Click Finish. Another setup dialog displays.
— Click Next.

— Check the I Have Read And Accept The License Terms
box.

— Click Install.
— Click Finish.

* Click Next. The Install complete pane displays in the dialog of
the OpenWorks installation program.

20. In the Install Complete pane:
* Click Yes, restart my system.

* Click Done.

License configuration

To use the software after it is installed, certain licensing steps must be
taken. See “Configure the OpenWorks® License” on page 33 in the
Windows Post-OpenWorkse-Installation Tasks section.
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Windows Post-OpenWorkse-Installation Tasks

This section contains tasks to be performed after installing Oracle and
the OpenWorks® software on the server and client machines. Certain of
the tasks are required and others are optional

See the OpenWorks® Project Administration manual and the online help
for more detailed information on OpenWorks® configuration topics.

The following tasks are required:

*  Set up the Oracle wallet for multiple users (if users are internally
identified users)

*  Configure the MKS toolkit (if not already configured)

»  Configure the OpenWorks® license

»  Grant database access to the OpenWorks® user

*  Understand and configure districts

These tasks are optional:

*  Manage the location of the OpenWorks® system files

*  Manage the location of the OpenWorks® project files

*  Manage the location of seismic data files using the dir.dat
configuration file

*  Turn off Oracle’s AutoExtend feature

Post-installation: Resolving out of memory notification, if necessary

Once you are using the GeoDatal.oad™ applications, if the data set is very large
and the job runs out of memory, you will receive a message explaining how to
allocate more memory. For a Windows operating system, increase the memory to
4 GB by setting an environment variable in the lgcenv.cf file in

the $OWHOMES%\conf directory. For 4 GB of memory, the environment
variable should read:

OW_GDL_WIZARD_MEMORY_LIMIT 4096m

Use the setenv command in a Command Prompt window or as a system
environment variable using the graphical user interface.

Set up the Oracle Wallet for Multiple Users

The OpenWorks® software uses the Open Oracle Secure Enterprise
Password Store (Oracle wallet) to store passwords to the database and
to handle the security of the passwords.
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To properly configure the Oracle wallet set up, each user who will run the
OpenWorks® software must have an OW_HOME_DIR user environment
variable set to a unique directory for their Oracle wallet on the client on
which they will access the OpenWorks® software.

Under the users directory, create a directory for each user that will be
using the OpenWorks® software on this machine.

To configure an Oracle wallet for your user account

1. Log on using your typical user account.

2. Open the System Properties window.
From the Control Panel, select System. For non-XP and non-
Windows Server 2003 systems, select System, then Advanced
system settings.

3. Inthe Advanced tab, click Environment Variables.

4. In the Environment Variables window, click New in the user
variables pane.

5. Inthe New User Variable window
* Type OW_HOME_DIR in the Variable name text box.
* In the variable value text box, type the path where the users

unique home directory was created, for example,
C:\users\userl.

* Click OK.
6. In the Environment Variables window, click OK.
7. Inthe System Properties window, click OK.
8. Close the Control Panel.
The first time you access an OpenWorks® project, you will be prompted

for your password. The wallet information will be automatically created
after you input your password.
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Configure the MKS Toolkit and Open Text Exceed

1. On the Control Panel, select Configure MKS Toolkit.

2. Inthe Configure MKS Toolkit window, Runtime Settings tab,
choose XWindow System Settings, then click OK.

3. From the X Server Settings, choose Registered.

4. Click Open Text Exceed. A green check mark appears to the left.
5. Ensure that the Use Network Connection box is checked

6. Click OK.

7. Restart the system.

Configure the OpenWorks® License

For complete information about the Landmark® Application Manager
(LAM), see the LAM documentation.

The server of the Landmark® Application Manager (LAM) must be
running with a license for the software, and the LM_LICENSE FILE
system environment variable must be set on the computer where the
OpenWorks® software is installed and running.

The LM_LICENSE FILE variable should be set to
TCP_PortNum@MachineName

where TCP_PortNum is a TCP port number (2013 is the default), and

the MachineName is the IP address or host name of the machine where

the LAM server is running.

For example, the environment variable may be set to a value like the
following:

2013@lamhost.company.com

Grant Database Access to the OpenWorks® User

Because the OpenWorks® 5000.x.x.x software uses the Oracle wallet, a
user is associated with both an operating system (OS) user and an
Oracle internally identified user. The Oracle user will have the same
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name as the OS user, but will now be required to provide a user name
and a password to access the OpenWorks® database. Users can now
change their Oracle password from the Command Menu. For detailed
information and procedures to manage project databases and access,
refer to the OpenWorks® Online Help

$OWHOMES® \docs\onlinehelp.htm).

For the purposes of installation however, the steps to grant database
access to the OpenWorks® user are provided here.

Modify Database Users utility

The Modify Database Users utility in this procedure replaces the
orauser utility from previous releases of the OpenWorkse software.

1. Log on as an OpenWorks® user.
2. Launch the Modify Database Users utility:

From the Start menu, select All Programs > Landmark >
OpenWorks >Project Administration > Modify Database
Users.

3. If prompted, select a district to get to the correct SID.
4. Inthe DBA Logon window

* In User Name, enter the name of a database administrator
(DBA) who has sufficient privileges to allow users to access
the OpenWorks® database. For example, the SYSTEM user
(one of the internal Oracle database administrators) with
SYSDBA privileges is such a user.

* In Password, enter the DBA's password.
* Click Login.

If the correct credentials are entered, the Database Users window
opens. If the Database Users window does not display, the Login

Failed dialog displays asking you to try to log in again. Click OK
to reassert the DBA Logon dialog. The login process allows three
login attempts. After three attempts, you must repeat step 2 to try
to log in again.

5. In the Database Users window
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* Enter the OpenWorks® user name and password in the User
Details area.

*  Check OW_ADMIN if the user will be allowed to create and
delete projects and create, change, or delete tables in a project
or the OWSYS schema. The default state of the box is checked.

*  Check only OWSYS ADMIN if the user will be allowed to
alter the OWSYS schema in the OpenWorks® database. The
default state of the box is unchecked.

Additional information

For more information about OW_ADMIN and

OWSYS ADMIN, see Project Management > Project
Administration > OpenWorks Security in the
OpenWorkse Online Help (OpenWorksHome /docs /
onlinehelp.htm).

6. Click Add.

7.  Close the Database Users dialog.

Understand and Configure Districts

Districts allow a company to break up large lists of projects, and allow
the company to separate data by business unit for better data security or
disk ownership.

Support for districts has become a part of the framework of the
OpenWorks® software. In an installation of the OpenWorks® software,
a company can decide whether it will implement districts or not.

To implement districts, the district.dat configuration file must be
configured with the name of each district. The district.dat file also
contains the directory name for configuration files that define storage
locations for data not stored in the database. These configuration files
are dir.dat and owdir.dat, for seismic data files and other OpenWorks®
files, respectively. The default location for these configuration files

is $OWHOMES%\conf.

Utilities, such as Project Administration and Project Status Tool,
support districts in their interfaces. For example, when a user of the
OpenWorks® software creates a new project in Project Administration,
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part of the project configuration includes selecting the district to which
it will belong.

In a new OpenWorks® installation, when the district option “Create a
district.dat from TNSNAMES.ora” was selected, a valid district was
created for each SID. The file, district.dat, will have a default directory
defined for each of the SIDs that are defined in tnsnames.ora. You will
need to update these directories before running an application of the
OpenWorks® software.

The OpenWorks® installation option “Create empty district.dat”
requires that you configure district.dat before you can run the
OpenWorks® software. The default location of the district.dat file

is $OWHOMES%\conf. You can change the default location by adding
the environment variable OW_CONF_DIR. The default location of
OW_CONF_DIR is %$OWHOME%\conf.

The names of the OpenWorks® SIDs must be in all capital letters in
district.dat. See Project Management > Districts in the OpenWorks®
Online Help (OpenWorksHome /docs/onlinehelp.htm) for
detailed procedures to perform district configuration tasks.

Manage the Location of OpenWorks® System Files

System files are files containing well and lithologic symbols and files
describing file formats for importing or exporting data.

System files are independent of projects and of districts. The location
of the following system directories do not change when changing a
district: OW_SYS DATA, owioformats, and owsymbols.

You can change the location of each of the directories by setting an
environment variable. The OW_SYS_DATA directory is located by the
value in the OW_SYSDATA_DIR environment variable. As a default,
this variable is set in Igcenv.cf located in $OWHOME$% \ conf;
however, the variable can be set in a user’s initialization script or set
separately in the user’s environment. The environment variables for the
location of the format files (OWIOFORMATS environment variable)
and the well and lithologic symbols (OWSYMBOLDIR environment
variable) can be set in a user’s environment, too.
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Manage the Location of OpenWorks® Project Files

OpenWorks® project files are external files (not in the database) that
are project specific. These may be files created by certain OpenWorks®
applications or applications that use the OpenWorks® and seismic
development kits.

Should you need to change where these files are stored in the future,
you can edit the owdir.dat file. The location of owdir.dat is determined
by the district.dat configuration file. A district must have an owdir.dat,
and each district in an OpenWorks® instance can have a unique version
of owdir.dat. Before editing, make sure you locate the correct owdir.dat
that is associated with the district where your project is located.

Manage the Location of Seismic Data Files (dir.dat Configuration File)

The dir.dat configuration file is an ACSII text file that lists the file
systems searched for seismic data stored as files. This file also
describes where applications create, or from where applications
retrieve, seismic data stored in files.

Applications look for dir.dat based on the district.dat configuration file.
By default, district.dat is in $OWHOMES%\conf but the location can
be changed by setting the OW_CONF_DIR environment variable.

For Release 5000.x, the format of the dir.dat file has changed from
previous versions. If dir.dat has not been updated for Release 5000.x,
the software will recognize this and create a converted version of the
file in the program’s memory. However, it is recommended that you
update R2003 dir.dat files to the new format.

The dir.dat file is composed of one or more lines. The lines have the
format

RootFileSystemPath filetypel filetype2 . . .filetypen

Where

* RootFileSystemPath is a file system where seismic data files
are stored

* filetypel.. filetypen are one of the following zero or more
extensions of seismic data files or the attribute
“OTHER_FILES”
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— Zero extensions: OpenWorks® applications will not create
files in a file system with no attributes; however, an
application can read or modify files in the file system,
depending on the permissions of the user running the
application.

— Extensions: If the attribute is a seismic data file extension
(i.e., .3dv, .3dh, etc.), files with that extension can be
created in the file system. If the same extension is applied
to more than one file system, then new files with that
extension are created in the file system with the most
space.

— OTHER_FILES: designates a file system where all types
of files, except those not explicitly enumerated as

attributes for another file system, can be created, read, and
modified.

OTHER_FILES attribute required to write data

At least one file system in dir.dat must have the OTHER FILES
attribute for data not explicitly assigned to another file system to
be written.

You can also define variables within dir.dat, where each variable
represents a group of extensions.

An example dir.dat is shown below. On the left, extensions attributes
are explicitly stated for each file system. On the right, variables have
been defined for groups of file systems. Both dir.dat entries indicate
identical storage locations for the seismic data files.
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Example dir.dat with explicit extension attributes Example dir.dat with variables defined (# denotes
the variable definition)

D:\ua\ 3dv 3dh cd bri cmp OTHER FILES | # define 3d seismic 3dv 3dh cd bri cmp

D:\ub\ hzd hts #define 3d horizons hzd hts
D:\uc\ 3dv 3dh cd bri cmp D:\ua\ 3d seismic OTHER_FILES
D:\ud\ 3dv 3dh cd bri cmp hzd hts D:\ub\ 3d horizons

D:\uc\ 3d seismic

D:\ud\ 3d seismic 3d horizons

The dir.dat files above indicate storage of 3d seismic data files in
directories \ua, \uc, and \ud. File systems for horizon data files are \ub,
and \ud. Storage for any other files is in file system \ua.

Refer to the dir.dat topic in the OpenWorks® online help for a complete
discussion of the dir.dat configuration file.

Turn Off AutoExtend

Oracle’s AutoExtend feature is turned on by default to extend system
and project tables spaces. If you would like to disable the AutoExtend
feature for the OpenWorks® project tablespaces, edit the setting for the
OW_AUTOEXTEND_FLAG variable in 30WHOME%\ lgcenv.cf

or $OW_CONF_DIR%\1lgcenv.cf .

By default the setting is:
OW_AUTOEXTEND_FLAG  YES
To turn off AutoExtend, set the variable as:

OW_AUTOEXTEND_FLAG NO
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Linux Procedures

Scope

This section includes the procedures for installing Oracle 11g 64-bit,
the OpenWorks® database, and the OpenWorks® and GeoDataLoad™
software on server and client systems running Linux 4.x or 5.x, 64-bit.

For the installations of the OpenWorks schemas on other supported
versions of the Oracle software, see the OpenWorks® Software
Installation Procedures manual for version 5000.8.0.0

(OW_5000.8 installprocedures.pdf, which is available on Landmark
Software Manager). After the installation of the OpenWorks schemas,
return to “Install the OpenWorks® Software” on page 72 in this chapter
to install the OpenWorks software.

Do Not Mix Oracle Versions

When the OpenWorks® server uses the Oracle 11g database server, only
Oracle 11g clients should access the database server.

Likewise, when the OpenWorks® server uses the Oracle 10g database server, only
Oracle 10g clients should access the database server.

The procedures in this section are:
*  Server installation tasks

—  Completing the prerequisites for installing Oracle on the
server

—  Completing pre-installation tasks, including running the Pre-
Oracle utility

— Installing the Oracle software on the server as well as the
OpenWorks® database and schemas

—  Performing post-Oracle-installation tasks

— Installing the OpenWorks® software on the server
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*  C(Client installation tasks

—  Completing the prerequisites for installing Oracle on the
client

— Installing the Oracle client software on the client
— Installing the OpenWorks® software

—  Performing post-OpenWorks®-installation tasks
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Assumptions

The procedures in this chapter assume the following:

1. You are installing OpenWorks® software on systems that do not
have prior installations of the OpenWorks® software.

Warning: Do not use the installation program for the database
instance (schemas) on an existing OpenWorkse database
instance

Do not attempt to upgrade an existing OpenWorks® database instance with
a new release of an OpenWorks® database installation program. Such an
action will destroy vital information in the OpenWorks® database.

When you upgrade the OpenWorks® software, and then upgrade the
projects in the database (as described in “Upgrade the OpenWorks®
Software” on page 95), you are doing all that needs to be done to upgrade
the OpenWorks® database instance.

2. You are installing the Oracle 11g database software with a new
OpenWorks® database instance, the OpenWorks® software, and
the GeoDatal.oad™ software.

3. You are installing the Oracle 11g client software on a machine
designated as a client.

4. If you are installing on a remote system, you set the display
variable before installing the software. For example:

setenv DISPLAY HostName:0.0

For other types of installations, refer to the appropriate section in this
manual:

*  “Windows Procedures” on page 11

*  “Upgrade the OpenWorks® Software” on page 95

*  “OpenWorks® Schemas on an Existing Oracle Database” on
page 87
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Linux Server Installation Tasks

Linux server installation tasks are:

*  Completing prerequisites

*  Running the pre-Oracle utility

*  Modifying the Linux release file (RHEL 5 only)

» Installing Oracle server, and the OpenWorks® database instance
and schemas on the server

*  Performing post-Oracle-installation tasks

* Installing the OpenWorks® software on the server

Prerequisites

Prerequisites for installing Oracle and the OpenWorks® database and
software on servers running the RHEL operating systems are:

*  Checking software packages (RPMs)
*  Checking swap space
»  Setting shell limits for the Oracle user

*  Configuring the kernel parameters (not necessary if you plan to
run the pre-Oracle utility before installing Oracle)

»  Creating the Oracle user (not necessary if you plan to run the pre-
Oracle utility before installing Oracle)

Recommendation: Run pre-Oracle utility

The pre-Oracle utility is a Landmarke utility that simplifies Oracle setup for
OpenWorks® applications. Running the pre-Oracle utility is recommended.

Check Software Packages (RPMs)

For RHEL 5, the required package versions are listed in

*  Oracle Database Release Notes 11g Release 2 (11.2) for Linux
x86-64
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Verify the RPMs using the procedure below.

1. Verify that you are running the x86 64 kernel on an x86_64
platform:

# uname -mi

The result should be:
x86_64 x86_64
2.  Run the command to list RPMs.

rpm -g --gf '${NAME}-%{VERSION}-%{RELEASE} (%{ARCH})\n' binutils compat-db
compat-1libf2c-34 elfutils-libelf elfutils-libelf-devel compat-libstdc++-33-
3.2.3 control-center gcc gcc-c++ glibce glibc-common glibc-devel glibc-
headers ksh libaio libaio-devel libgcc libstdc++ libstdc++-devel make
numactl-devel sysstat libaio unixODBC unixODBC-devel

It is important to have these 64-bit RPMs installed. The above
command will list the architecture of each binary package. You

will see that some RPMs are installed twice when you run this
command (32-bit and 64-bit).

The command should result in the list of required packages
shown below.

RHEL 4 x86_64 RHEL 5 x86_64 (64-bit)

binutils-2.15.92.0.2 binutils-2.17.50.0.6

compat-libstdc++-33-3.2.3 compat-1ibf2¢c-34-3.4.6-4 (RHEL version 5.6)
compat-libstdc++-33-3.2.3 (32 bit) | compat-libf2c-34-3.4.6-4.1.i1386 (RHEL version 5.7)
elfutils-libelf-0.97 compat-libstdc++-33-3.2.3

elfutils-libelf-devel-0.97 compat-libstdc++-33-3.2.3 (32-bit)

expat-1.95.7 elfutils-libelf-0.125

gce-3.4.6 elfutils-libelf-devel-0.125

gee-c++-3.4.6 elfutils-libelf-devel-0.137 (RHEL version 5.6 or 5.7)
glibc-2.3.4-2.41 gee-4.1.2

glibc-2.3.4-2.41 (32 bit) gee-c++-4.1.2

glibc-common-2.3.4 glibc-2.5-24

glibc-devel-2.3.4 glibc-2.5-24 (32-bit)

glibc-headers-2.3.4 glibc-common-2.5

libaio-0.3.105 glibc-devel-2.5

libaio-0.3.105 (32 bit) glibc-devel-2.5 (32-bit)
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RHEL 4 x86_64

RHEL 5 x86_64 (64-bit)

libaio-devel-0.3.105
libaio-devel-0.3.105 (32 bit)
libgce-3.4.6

libgcc-3.4.6 (32-bit)
libstdc++-3.4.6
libstdc++-3.4.6 (32 bit)
libstdc++-devel 3.4.6
make-3.80
numactl-0.6.4.x86_64
pdksh-5.2.14

sysstat-5.0.5
unixODBC-2.2.11
unixODBC-2.2.11 (32 bit)
unixODBC-devel-2.2.11
unixODBC-devel-2.2.11 (32 bit)

glibc-headers-2.5
ksh-20060214
libaio-0.3.106

libaio-0.3.106 (32-bit)
libaio-devel-0.3.106
libaio-devel-0.3.106 (32-bit)
libgce-4.1.2

libgcc-4.1.2 (32-bit)
libstdc++-4.1.2
libstdc++-4.1.2 (32-bit)
libstdc++-devel 4.1.2
make-3.81
numactl-devel-0.9.8.x86 64
sysstat-7.0.2
unixODBC-2.2.11
unixODBC-2.2.11 (32-bit)
unixODBC-devel-2.2.11
unixODBC-devel-2.2.11 (32-bit)

Check Swap Space on the Server

Check the swap space using the following command:

# grep SwapTotal /proc/meminfo

Ensure that you have enough swap for your host configuration based on

the following table.

RAM

Swap Space

Between 1 GB and 2 GB

1.5 times the size of RAM

Between 2 GB and 16 GB

Equal to the size of RAM

More than 16 GB

16 GB

During installation, the Oracle software uses the guidelines in the table
to determine if you have adequate swap space. For a host with 2 GB of
RAM, for example, Oracle suggests 3 GB of swap. If your system has
more memory, the Oracle installation program may recommend more

swap.
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If you need to add swap space, use the procedure in the following
example of adding 1 GB of swap space on the system. Based on your
configuration, calculate how much swap space you need to add.

To add a 1 GB swap file:

1.

Determine the size of the new swap file and multiple by 1024 to
determine the block size. For example, the block size of a
1024 MB swap file is 1048576.

At a shell prompt as root, type the following command with
count being equal to the desired block size:

dd if=/dev/zero of=/swapfile bs=1024 count=1048576
Set up the swap file with the command:
/sbin/mkswap /swapfile

* To enable the swap file immediately but not automatically at
boot time:

/sbin/swapon /swapfile

* To enable the swap file at boot time, edit /etc/fstab to
include:

/swapfile swap swap defaults 00

The next time the system boots, it will enable the new swap
file.

After adding the new swap file, make sure it is enabled by viewing
the output of the commands

cat /proc/swaps

or

free

Set Shell Limits for the Oracle User

To improve the performance of the software on Linux systems, you
must increase the shell limits for the Oracle user for the number of open
file descriptors and for the number of processes available to a single
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user. Shell limits are setin /etc/security/limits.conf
Shell limits should be set as shown below.

Shell Limit Item in limits.conf | Hard Limit
Maximum number of open file descriptors nofile 65536
Maximum number of processes available to a single user | nproc 16384
Maximum size of the stack segment of the process stack 10240

To increase the shell limits:

1. Add the following lines to /etc/security/limits.conf:

OracleUserName soft nproc 2047
OracleUserName hard nproc 16384
OracleUserName soft nofile 1024
OracleUserName hard nofile 65536
OracleUserName hard stack 10240

Soft limits are the number of file handles or processes the user will
have on login. If these are not sufficient, the limits can be extended
up to the hard limit with the ulimit command.

2. Add or edit the following line in /etc/pam.d/login, ifit
does not already exist:

session required /1ib64/security/pam_limits.so

3. Depending on the Oracle user’s default shell, make the following
changes to the default shell start-up file:

For C shell (csh or tcsh), add the following lines to /etc/
csh.login:

if ( SUSER == "OracleUserName" ) then
limit maxproc 16384
limit descriptors 65536

endif
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Configure Kernel Parameters

This section describes how to configure kernel parameters manually.

Recommendation: Use the pre-Oracle utility to configure kernel
parameters

You have the option to run the pre-Oracle utility before installing the database on
the server (see below). Running the pre-Oracle utility is recommended. Running
the pre-Oracle utility creates the Oracle user and sets the kernel parameters so you
do not need to do them manually.

Verify that the kernel parameters shown in the following table are set to
values greater than or equal to the recommended value shown. The
procedure following the table describes how to verify and set the
values. If the current value for any parameter is higher than the value
listed in the table, do not change the value of that parameter.

Parameter Value File
semmsl semmns semopm | 250 32000 100 128 /proc/sys/kernel/sem
semmni
shmall 2097152 /proc/sys/kernel/shmall
shmmax Half the size of /proc/sys/kernel/shmmax
physical memory (in
bytes)
shmmni 4096 /proc/sys/kernel/shmmni
file-max 6815744 /proc/sys/fs/file-max
ip_local port range 1024 65000 /proc/sys/net/ipv4/ip local port range

To view the current value specified for these kernel parameters, and to
change them if necessary, follow these steps:

1. Enter the commands shown below to view the current values of the
kernel parameters.

Record the values returned from the commands

Make a note of the current values and identify any values that you must
change.
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Parameter Command

semmsl, semmns, semopm, | # /sbin/sysctl -a | grep sem
and semmni
This command displays the value of the semaphore parameters in
the order listed.

shmall, shmmax, and # /sbin/sysctl -a | grep shm

shmmni

file-max # /sbin/sysctl -a | grep file-max

ip_local port range # /sbin/sysctl -a | grep ip local port range

This command displays a range of port numbers.

2. Ifthe value of any kernel parameter is different and lower than the
recommended value, complete the following steps (do not change
a value if it is higher than the recommended value):

» Using a text editor, create or edit /etc/sysctl.conf, and
add or edit lines similar to the following:

Include only parameter values that will be changed

Include lines only for the kernel parameter values that you want to
change. For the semaphore parameters (kernel . sem), you must
specify all four values. However, if any of the current values are
larger than the recommended value, specify the larger value.

kernel.shmmax = 2147483648
kernel.shmall = 2097152
kernel.sem = 250 32000 100 128
kernel.shmmni = 4096
fs.file-max = 6815744
fs.aio-max-nr = 1048576
net.ipv4d.ip_local_port_range = 1024 65000
net.core.rmem _default = 4194304
net.core.rmem_max = 4194304
net.core.wmem _default = 1048567
net.core.wmem max = 1048567

By specifying the values in /etc/sysctl.conf, they will
persist when you reboot the system.
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Enter the following command to load the values of the kernel
parameters from /etc/sysctl.conf:

# /sbin/sysctl -p

Review the output from this command to verify that the values
are correct. If the values are incorrect, edit /etc/
sysctl.conf, and then enter the sysctl command
again.

Create the Oracle User

This procedure shows how to manually create an Oracle user.

Recommendation: Use pre-Oracle utility to create Oracle user

You have the option to run the pre-Oracle utility before installing Oracle on the
server (see below). Running the pre-Oracle utility is recommended. The utility
creates the Oracle user and sets the kernel parameters so you do not need to do this
manually.

To create an Oracle user:

1. Create the dba group if it does not exist:

or

Log on as root.
Execute the command:
/usr/sbin/groupadd -g 501 dba

The group ID (501) and the group name (dba) must be
unique.

Add the following line to the file, /etc/group:
dba:x:501:

The group ID (501) and the group name (dba) must be
unique.

Create the new Oracle user

Log on as root.
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* Execute the following command (where orallg is the
example user name of the Oracle user):

/usr/sbin/useradd -d /d0l/orallg -g dba -s /bin/csh -u 7777 -m orallg

where /d01/orallg isthe home directory (and ); dba is
the group name of the user; 7777 isthe UID (user ID) for the
user and is unique; the home directory is created (-m) if it does
not exist and the default (or system) initialization files will be
copied from the skeleton directory (usually /etc/skel)to
the home directory; and orallg is the user name.

3. Change permissions on the Oracle user’s directory by executing
the command

chmod -R 775 /d0l/orallg
4. Edit the new Oracle user’s login script:
* Log on as the Oracle user.

* Add the following lines to the Oracle user’s .login file, if they
do not exist. Use values appropriate to your setup.

Linux 64-bit

setenv ORACLE_SID OpenWorksinstanceldentifier

setenv LM_LICENSE_FILE TCP_Port@HostName

setenv OWDBSETUP_DIR LocationOfOpenWorksDatabaseFiles
setenv OWHOME PathnameOfOpenWorkslInstallDir

setenv ORACLE_OWNER OracleUserName

setenv OW_HOME_DIR S$SHOME

setenv ORACLE_BASE ${HOME}/product

setenv ORACLE_HOME ${ORACLE_BASE}/11.2.0/dbhome_1
setenv FLEXLM NO_CKOUT_INSTALL_LIC 1

umask 022
setenv PATH /usr/bin:${PATH}:${ORACLE_HOME}/bin:${OWHOME} /bin
if ($?LD_LIBRARY_ PATH == ) then
setenv LD_LIBRARY PATH ${ORACLE_HOME}/1ib32:${ORACLE_HOME}/1lib
else

setenv LD_LIBRARY_ PATH ${LD_LIBRARY PATH}:${ORACLE_HOME}/1ib32:${ORACLE_HOME}/1lib
endif
setenv CLASSPATH ${ORACLE_HOME}/JRE/lib:${ORACLE_HOME}/JRE/lib/rt.jar:${ORACLE_HOME}/jlib

5. Ifyou have not correctly set the shell limits for the Oracle user, see
“Set Shell Limits for the Oracle User” on page 47.
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Run the Pre-Oracle Utility (Recommended)

Use the Pre-Oracle utility to set up your environment for Oracle and to
create the Oracle user (the user who will install Oracle and the
OpenWorks® database).

The Pre-Oracle utility also prompts you to modify the kernel
parameters. The changes are important for a machine running the
Oracle server.

1.

2.

Log on as root.

Download the Pre-Oracle utility from the Landmark® Software
Manager (https://esd.halliburton.com/download/download.jsp).

Extract the ZIP file to a directory.

In the directory where the Pre-Oracle program was extracted, run
the bin file in a terminal window. For example:

. /OWPO_ VersionNumLx . bin

The Introduction pane in the OpenWorks Pre-Oracle dialog box
displays.

In the Introduction pane, click Next. The Choose Install Folder
pane displays.

In the Choose Install Folder pane:

* Enter the directory where you want to install its files. For the
installation and configuration, the program will install a Java
runtime environment (JRE) and other files (including uninstall
files). When the program ends, an installation log is also placed
in this folder.

* Click Next. The Pre-Installation Summary pane displays.

In the Pre-Installation Summary pane:

* Verify the install folder location is correct.

» Ifnecessary, click Previous and correct settings, and then
return to this pane.
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* Click Install. The Installing Pre-oracle pane displays with a
progress bar, and then displays the Oracle Setup Installation
banner in a terminal window.

8. In the Oracle Setup Installation terminal window:

* Press Enter to continue the installation.

*  When prompted to create the Oracle user/owner account, enter
V.

» Enter the Oracle user name that you want to create.

* Enter the path for the home directory of OpenWorks. For
example, the default is:

/Landmark/OpenWorks
The path will be saved to the OWHOME environment variable

for the Oracle user. If the path is not known at this time, it can
be set later in the initialization files of the Oracle user.

Required for the Database Administration Tool

The Oracle user must have the OWHOME environment variable set
in order to use the Database Administration tool.

* Enter the connection information (the TCP port and host name)
of the Landmark® Application Manager (LAM) for the
LM _LICENSE_FILE environment variable. If the
connection information is not known at this time, it can be set
later in the initialization files of the Oracle user.

Required for the Database Administration Tool

The Oracle user must have a valid license to the OpenWorks®
software in order to use the Database Administration tool.

LAM is the license server for all software from Landmark, and
the server should have a license file that contains a current
license for the software you will use, in this case, the
OpenWorks® software.
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The LM_LICENSE_FILE variable should be set to a value
with the following form:

TCP_PortNum@MachineName

where TCP_PortNum is a TCP port number (2013 is the
default), and the MachineName is the IP address or full host
name of the machine where the LAM server is running.

For example, the environment variable may be set to a value
like the following:

2013@lamhost.company.com
or
2013@123.123.123.123

Enter the home directory for the Oracle user. If the directory
does not exist, the program will create it.

Enter the user 1D.

The number in brackets is the next available user ID. You can
accept this number by just pressing the Enter key, or enter your
own number. The number must be unique on the system.

Enter the name of the group for the database administrator.

The characters in brackets (dba) is the default group name.
You can accept this name by just pressing the Enter key, or
enter your own.

Enter the group ID number by accepting the default (555).

When prompted about whether system files can be modified,
answer Y.

The original passwd and group files are copied to another file
with the file name of the original file and a numerical suffix
(for example, passwd.12345).

Enter the system identifier (SID) for the database instance. The
identifier should contain a maximum of eight alphanumeric
characters and the alphabetical characters should be all capital
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10.

I1.

letters. The first character should be alphabetical. Do not use
any special characters.

A summary appears giving the SID, owner, and home
directory.

Press Enter.

The Linux Configuration Utility banner displays in the
terminal window.

In the Linux Configuration Utility terminal window:

Press Enter.

Enter 1 to update the kernel configuration.
The script updates the kernel.

Press Enter.

Enter 3 to quit the configuration utility.

The Install Complete pane displays in the OpenWorks Pre-
oracle dialog box.

In the dialog box, click Done.

In a terminal window, change the permissions on the home
directory of the Oracle user to have 775 permissions. For example,
if the home directory of the Oracle useris orallg;

Change directories to the parent directory of the home
directory of the Oracle user.

Execute the chmod command to change the permissions of the
home directory.

chmod 775 orallg
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Install Oracle Database Software and OpenWorks Database Instance

1. Log on as the Oracle user.

Root User Needed for Post-installation Tasks

After the database instance is installed, two scripts must be run by the root
user.

2.  Download the software appropriate for the operating system from the
Landmark® Software Manager (https://esd.halliburton.com/
download/download.jsp) to a directory on the system.

OWDBSetup_linux_with_Oracle.zip

The ZIP file is around 2.5 GB, and when it is expanded it takes
about another 2.5 GB.

3. Extract the ZIP file into a directory.

4. In the directory where the file was extracted, run the installer
command:

./OWDB_5000_8_1.bin

The Introduction pane of the OpenWorks Database dialog box
displays.

5. Click Next. The Select Type Of Install pane displays in the dialog.
6. In the Select Type Of Install pane:

» Select Install Oracle media and build new OpenWorks
database instance.

* Click Next. The Choose Install Folder pane displays.
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7. In the Choose Install Folder pane:

Enter the directory where you want to install the files of the
OpenWorks® database instance.

Click Next. The Get Oracle Information pane displays.
Additional Checks: The limits.conf file and the files of the

system (versions of RPMs) are checked. If the check fail,
additional panes will display.

8. In the Get Oracle Information pane:

In Oracle Base, enter a path for the Oracle base directory. This
path is set in relation to the Oracle home path set in the Pre-
Oracle installation. For example:

/oracle/product

If you change the default path in the text box, you may need to
change the setting of the ORACLE_BASE environment
variable in the .login initialization file of the Oracle user. For
example:

setenv ORACLE_BASE ${HOME} /product

In Oracle Home, enter the path for Oracle software. For
example:

/oracle/product/11.2.0/dbhome_1

If you change the default path in the text box, you may need to
change the setting of the ORACLE_HOME environment
variable in the .login initialization file of the Oracle user. For
example:

setenv ORACLE_HOME ${ORACLE_BASE}/11.2.0/dbhome_1

In Oracle SID, accept the machine name as the Oracle system
identifier, or enter another identifier. The identifier, or database
instance name, should contain a maximum of eight
alphanumeric characters and the alphabetical characters should
be all capital letters. The first character must be alphabetical.
Do not use any special characters.

If you change the default value in the text box, you may need
to change the setting of the ORACLE_SID environment
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variable in the .login initialization file of the Oracle user. For
example:

setenv ORACLE_SID OpenWorksInstanceldentifier
* Click Next. The Get Database Domain pane displays.

9. Optional. In Database Domain, enter the domain name if the
database has one, or leave it blank. The default is blank. The
domain name specifies the logical location of the database within a
network, and if one is entered, you must include the domain name
when referring to the database instance.

Domain name and Oracle SID

If you enter a domain name here, you must always specify the domain
name, along with the SID, when referencing the database instance.

The domain name can be uppercase letters (A-Z), numbers (0-9), and
the dash character, separated by periods. For example, to put a database
instance in a domain, such as 1gc.com, enter LGC.COM in the field.

The combination of Oracle SID and database domain cannot be more
than 40 characters.

10. Click Next. The First Set Of Datafiles pane displays.
11. In the First Set Of Datafiles pane:

* Specify the directory where you want to install the first set of
database files.

This directory must be empty. If not, the installation will fail.

* Accept the default amounts for the block size (16 KB), system
tablespace (1024 MB), and SysAux tablespace (256 MB).

The data block size is the default logical block size used in the
database. The size should be a multiple of the physical block
size of the storage device where the database is stored.
* Click Next. The Second Set Of Datafiles pane displays.
12. In the Second Set Of Datafiles pane:

» Specify the directory where you want to install the second set
of database files.

5000.8.1.0 Linux Server Installation Tasks 59



OpenWorkse Software Installation Procedures Linux Procedures

This directory must be empty. If not, the installation will fail.

* Accept the sizes for the Undo tablespace (1024 MB) and the
Redo Logs (150 MB).

Redo Logs size and Oracle tuning

The Redo Logs size is one of the parameters that can be adjusted if
necessary to improve database performance. See “Appendix: Oracle
Tuning Parameters” on page 173 for additional information.

* Click Next. The Third Set Of Datafiles pane displays.
13. In the Third Set Of Datafiles pane:

* Specify the directory where you want to install the third set of
database files.

This directory must be empty. If not, the installation will fail.

* Accept the default sizes for the Temp tablespace (1024 MB)
and the Users tablespace size (5 MB).

* Click Next. The Approximate Database Size pane displays.
14. In the Approximate Database Size pane:
» Enter the possible size of the database instance. The default
and the minimum is 30 GB. This value is used in calculations
for backup and recovery.

* Click Next. The ArchiveLog Mode pane displays.

15. In the ArchiveLog Mode pane:

ArchiveLog Mode or No ArchiveLog Mode

Depending on what you select in this pane, you have three possible paths
before they converge again with the configuration of the SGA (System
Global Area) Allocation: ArchiveLog Mode; No ArchiveLog Mode but
without automatic backups; and No ArchiveLog Mode and with automatic
backups.

* Select ArchiveLog Mode (the default) to archive redo logs
before they are overwritten. This mode allows the database to
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be backed up while the database is in an inconsistent state (or
while the database is being accessed by users).

— Click Next. The Schedule Backup Time pane displays.

— In the Schedule Backup Time pane:

* Type the number of days a backup file will be
retained. The minimum is one day. The default is
two days. After this time a file (such as a full or level
zero incremental backup) will be considered
obsolete and deleted.

* Enter the hour and minute when a backup is
performed.

* Click Next. The Recovery Destination pane
displays.

— In the Recovery Destination pane:

— Specify the location for recovery files (control files,

redo logs, archived redo logs, flashback logs, and
RMAN backups). The location can be a system
directory or network location.

Specify the maximum size (or disk quota) of the
recovery file area in units of gigabytes.

The amount of space can vary depending on the
amount of data in the database instance, the size of
data blocks, the number of changes to the data, the
number of days in the retention policy, and other
configurations of the database.

Ideally, the area should be able to contain all data files
in the database and all current backup files.

— Click Next. The SGA (System Global Area)

Allocation pane displays.
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* Select NoArchiveLog Mode to allow redo logs for the
database instance to be overwritten without archiving the old
redo logs.

In NoArchiveLog Mode, Backups Require Database
Shutdown

With NoArchiveLog Mode selected in the ArchiveLog Mode
pane, a backup can only be performed when the database is in
a consistent state.

For an Oracle database to be in a consistent state, it must be
shutdown with the normal, immediate, or transactional
parameter, and the restarted database must be backed up in a
mode (such as the Mount mode), where the database is closed
to access, except for certain database administrator (DBA)
activities.

— Click Next. The Configure Autobackups pane displays.

— Select Off (the default and is recommended) in order to
perform manual backups. Clicking Next displays the SGA
(System Global Area) Allocation pane.

— Select On to allow the database to perform automatic
backups. Since NoArchiveLog Mode was chosen, the
database must be closed, and then be restarted in a mode
where only DBA activities can be performed while the
backup occurs.

— Click Next. The Schedule Backup Time pane displays.

— In the Schedule Backup Time pane:

* Type the number of days a backup file will be
retained. The minimum is one day. The default is
two days. After this time a file (such as a full or level
zero incremental backup) will be considered
obsolete and deleted.

* Enter the hour and minute when a backup is
performed.

* Click Next. The Recovery Destination pane
displays.
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— In the Recovery Destination pane:

* Specify the location for recovery files (control files,

redo logs, archived redo logs, flashback logs, and
RMAN backups). The location can be a system
directory or network location.

Specify the maximum size (or disk quota) of the
recovery file area in units of gigabytes.

The amount of space can vary depending on the
amount of data in the database instance, the size of
data blocks, the number of changes to the data, the
number of days in the retention policy, and other
configurations of the database.

Ideally, the area should be able to contain all data
files in the database and all current backup files.

* Click Next. The SGA (System Global Area)

Allocation pane displays.

16. Inthe SGA (System Global Area) Allocation pane:

Specify the amount of memory as a percentage that the system
global area (SGA) will use.

As a guideline, use the following percentages for SGA:
— Large (typically: a dedicated database server): 85%
— Medium (typically: a workstation): 30%

— Small (typically: a laptop): 10%

Click Next. The Schemas Directory pane displays.

17. Inthe Schemas Directory pane:

Specify the directory where you want to create OpenWorks®
schema database files.

Click Next. The Projects Directories pane displays.
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18. In the Projects Directories pane:

» Specify the directory where you want to create project files.
You must have at least one project directory. You can create
additional directories in order to distribute the files over a
number of file systems.

» If desired, enter additional directories for project files.
* Click Next. The DB Admin Info pane displays.
19. In the DB Admin Info pane:

Pre-Oracle might have configured these values for the Oracle user
in the account’s initialization file (.login). This configuration
allows the Oracle user to run the Database Administration tool in
the OpenWorks® software.

* Enter path for the home of the OpenWorks® software. For
example, a typical path might be:

/d01/Landmark/OpenWorks

* Enter the connection information (the TCP port and host name)
of the Landmark® Application Manager (LAM) for the
LM_LICENSE_FILE environment variable. If the
connection information is not known at this time, it can be set
later in the initialization files of the Oracle user.

LAM is the license server for all software from Landmark, and
the server should have a license file that contains a current
license for the software you will use, in this case, the
OpenWorks® software.

This configuration sets the LM_LICENSE_FILE
environment variable with a value with the following form:

TCP_PortNum@MachineName

where TCP_PortNum is a TCP port number (2013 is the
default), and the MachineName is the IP address or full host
name of the machine where the LAM server is running.
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For example, the value may be set like the following:

2013@lamhost.company.com

2013@123.123.123.123

Settings for Other Environment Variables

The settings of the following environment variables are also necessary
in the user’s environment. They are set by the Pre-Oracle installation
program.

OWDBSETUP_DIR: The variable must be set with the directory
location of the OpenWorks database setup files (specifically,
owdbsetup.sh). Typically, the default location is:

OracleUserHome/Landmark/OpenWorksDatabase

OW_HOME_DIR: The variable must be set to the home directory of
the user. For example:

setenv OW_HOME_DIR S$SHOME

PATH: The PATH environment variable should contain the path to
the bin directory of the OpenWorks installation
(OpenWorksHome /bin) and the Oracle installation (OracleHome /
bin).

Click Next. The Pre-installation Summary pane displays.

20. In the Pre-installation Summary pane

Verify that all settings are correct. If necessary, click Previous
and correct settings.

Click Install if all settings are correct. The Oracle wallet and a
number of other settings are configured during installation.

After the database instance is installed, the Post Install Actions
pane displays.

21. Follow the instructions in the Post Install Actions pane to execute
the two scripts, root.sh and orainstRoot.sh.

Open a terminal window on the same machine.

Log on as root.
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22.

23.

24.

25.

* Execute the root.sh and orainstRoot.sh scripts. Their locations
are indicated in the Post Install Actions pane. The default path
names are:

OracleHome /root . sh
OracleUsersHome /oraInventory/orainstRoot.sh

The log for root.sh is stored in the OracleHome/install
directory.

* Click Next in the Post Install Actions pane only after
successfully executing the root.sh and orainstRoot.sh scripts.

After clicking Next, the Schemas pane displays. This pane
displays the messages created as the OpenWorks schemas were
created.

Click Next in the Schemas pane.

The file, sqlnet.ora, is modified to include configurations for the
Oracle wallet. A backup is made of the file and saved in the same
directory. The Modified SqlNet.ora dialog displays.

Click OK in the dialog. The Restart SID And Listener pane
displays.

In the Restart SID And Listener pane:

* Accept the default Yes to shutdown and startup the instance
and listener.

* Click Next. The Listener Output pane displays
In the Listener Output pane:
* Verify that the commands completed successfully.

* Click Next. The Modify .login pane displays. A new
initialization file is created with a name like .login_mod
or .bash_profile_mod. This file contains the settings for
various environment variables. These variables must be set in
the Oracle user’s initialization file in order for the user to be
able to run the Database Administration tool of the
OpenWorks® software.
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26. In the Modify .login pane, click Next. The Install Complete pane
displays.

A log (Landmark OpenWorks Database InstallLog.log) for the
installation is stored in the same directory as the location selected
for the database in the Choose Install Folder pane.

27. Click Done.

If there are any errors, additional windows will appear describing
the errors.

Acceptable Oracle error messages

Some Oracle errors are acceptable; e.g., errors that occur because of the
drop user statements and IMP_FULL DATABASE,
EXP FULL DATABASE role conflicts.

Server Post-Oracle-Installation Tasks

After you install the Oracle software on the server, perform the
following post-installation tasks:

Execute the following command as the Oracle user:

chmod -R 775 $ORACLE_HOME
Error messages display that it is not possible to alter the permissions on
certain files in the Oracle home directory. These errors can be ignored.

The ownership of these files was changed to root when root ran the
root.sh configuration script earlier in the installation procedure.
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Linux Client Procedures

Prerequisites

Prerequisites for installing Oracle on the client running the RHEL
operating systems are:

*  Checking software packages (RPMs)

Check Software Packages (RPMs)
For RHEL 5, the required package versions are listed in

*  Oracle Database Installation Guide 11g Release 2 (11.2) for Linux
x86-64

Verify the RPMs using the procedure below.

1. Verify that you are running the x86 64 kernel on an x86 64
platform:

# uname -mi

The result should be: “x86 64 x86 64

2.  Run the command to list RPMs.

rpm -g --gf '${NAME}-%{VERSION}-%{RELEASE} (%{ARCH})\n' binutils compat-db
compat-1ibf2c-34 elfutils-libelf elfutils-libelf-devel compat-libstdc++-33-
3.2.3 control-center gcc gcc-c++ glibe glibc-common glibc-devel glibc-
headers ksh libaio libaio-devel libgcc libstdc++ libstdc++-devel make
numactl-devel sysstat libaio unixODBC unixODBC-devel

It is important to have these 64-bit RPMs installed. The above
command will list the architecture of each binary package. You
will see that some RPMs are installed twice when you run this
command (32-bit and 64-bit).

The command should result in the following list of required packages.

RHEL 4 x86_64 RHEL 5 x86_64 (64-bit)
binutils-2.15.92.0.2 binutils-2.17.50.0.6
compat-libstdc++-33-3.2.3 compat-libf2c-34-3.4.6-4 (RHEL version 5.6)
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RHEL 4 x86_64

RHEL 5 x86_64 (64-bit)

compat-libstdc++-33-3.2.3 (32 bit)
elfutils-libelf-0.97
elfutils-libelf-devel-0.97
expat-1.95.7

gce-3.4.6

gce-ct++-3.4.6
glibc-2.3.4-2.41
glibc-2.3.4-2.41 (32 bit)
glibc-common-2.3.4
glibc-devel-2.3.4
glibc-headers-2.3.4
libaio-0.3.105

libaio-0.3.105 (32 bit)
libaio-devel-0.3.105
libaio-devel-0.3.105 (32 bit)
libgce-3.4.6

libgcc-3.4.6 (32-bit)
libstdc++-3.4.6
libstdc++-3.4.6 (32 bit)
libstdc++-devel 3.4.6
make-3.80
numactl-0.6.4.x86_64
pdksh-5.2.14

sysstat-5.0.5
unixODBC-2.2.11
unixODBC-2.2.11 (32 bit)
unixODBC-devel-2.2.11
unixODBC-devel-2.2.11 (32 bit)

compat-libf2c-34-3.4.6-4.1.i1386 (RHEL version 5.7)
compat-libstdct++-33-3.2.3
compat-libstde++-33-3.2.3 (32-bit)
elfutils-libelf-0.125
elfutils-libelf-devel-0.125
elfutils-libelf-devel-0.137 (RHEL version 5.6 or 5.7)
gee-4.1.2

gee-c++-4.1.2

glibc-2.5-24

glibc-2.5-24 (32-bit)
glibc-common-2.5
glibc-devel-2.5

glibc-devel-2.5 (32-bit)
glibc-headers-2.5

ksh-20060214

libaio-0.3.106

libaio-0.3.106 (32-bit)
libaio-devel-0.3.106
libaio-devel-0.3.106 (32-bit)
libgce-4.1.2

libgcc-4.1.2 (32-bit)
libstdc++-4.1.2

libstdc++-4.1.2 (32-bit)
libstdc++-devel 4.1.2

make-3.81
numactl-devel-0.9.8.x86 64
sysstat-7.0.2

unixODBC-2.2.11
unixODBC-2.2.11 (32-bit)
unixODBC-devel-2.2.11
unixODBC-devel-2.2.11 (32-bit)

Install Oracle on the Client

Use this procedure to install the Oracle software on the client.

1. Ifnotlogged in as root, log in as root.
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2.

10.

Download the appropriate Oracle software from the Landmark®
Software Manager (https://esd.halliburton.com/download/
download.jsp) to a temporary directory.

Operating System Oracle software

64-bit Oracle 112020 Linux64 Client.zip

In the directory where the file resides, extract files from the ZIP
file. For example:

unzip ./Oracle_112020_Linux64_Client.zip
Log on as a local or network user.

In the directory to where the files were extracted, run the installer
command:

./database/runInstaller
In the Select Installation Type screen
* Select Administrator.
* Click Next.

Enter the path for Oracle home (the path in the ORACLE_HOME
environment variable).

In the Specify Inventory directory and credentials screen:

* Enter the inventory directory and group name or accept the
defaults.

* Click Next.

Enter the path for the ORACLE_BASE environment variable.

In the Product-Specific Prerequisite Checks screen:

» Verify that the overall result of the check is Passed.

+ If any of the tests fail, exit the installation, set the
recommended value of the parameter mentioned for the

system, and run the installation program again.

* C(Click Next.
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I1.

12.

13.

14.

15.

In the Summary screen:
* Verify that all settings are correct.
* Click Install.

Follow the instructions in the Execute Configuration scripts
window to execute the two scripts, orainstRoot.sh and root.sh.

* Open a terminal window on the same system.
* Log on as root.
* Execute the orainstRoot.sh and root.sh scripts.

Click OK in the Execute Configuration scripts window only after
successfully executing orainstRoot.sh and root.sh scripts.

In the End of Installation screen, click Exit.

In the Exit window, click Yes. The installation program closes.

Client Post-Oracle-Installation Tasks

Fix Directory Permission Problem

Execute the following command as the Oracle user:

chmod -R 775 $ORACLE_HOME

Error messages display that it is not possible to alter the permissions on
certain files in the Oracle home directory. These errors can be ignored.
The ownership of these files was changed to root when root ran the
root.sh configuration script earlier in the installation procedure.
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Install the OpenWorkse Software

Install the OpenWorks® software on both the server and the client. The
procedure for installing the OpenWorks® software on the client is the
same as for installing the software on the server.

To install the OpenWorks® software:

1.

2.

Log on as a user with administrator privileges.

Create an installation directory for the OpenWorks home
directory.

/LocalStorage /Landmark/OpenWorks
Download the OpenWorks® software from the Landmark®
Software Manager (https://esd.halliburton.com/download/
download.jsp).
Extract the ZIP file to a directory.

From the directory to which the file was extracted, launch the
installation program.

./0W_5000_8_1_OLx.bin

The Introduction pane displays in the Landmark OpenWorks
dialog box.

The installation program steps you through the installation and
tracks the progress of the installation in a checklist on the left side

of the window.

Click Next in the Introduction pane. The License Agreement pane
displays.

In the License Agreement pane:
* Accept the agreement to continue the installation.

* Click Next. The Choose Install Folder pane displays.
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8. In the Choose Install Folder pane:

* Specify the folder for the location of the OpenWorks® home
directory.

* Click Next. The OpenWorks Flat File Setup pane displays.
9. In the OpenWorks® Flat File Setup Pane:

* Enter the system directory and the project directory for the
storage of OpenWorks® system and project files. The files are
data files external to a project in the OpenWorks database
instance.

When you enter the directory names, the system creates the
OW_SYS_DATA and OW_PROJ_DATA variables that point
to the location of the directories.

Changing flat file storage location

Should you need to change where the system or project files are stored in
the future, you can edit environment variables. See “Manage the
Location of OpenWorks® System Files” on page 81 and “Manage the
Location of OpenWorks® Project Files” on page 81 in the Linux Post-
OpenWorks®-Installation Tasks section.

* Click Next. The Get Oracle 64-bit Information pane displays.
10. In the Get Oracle 64-bit Information pane:

* Specify the Oracle home directory, where Oracle was installed.

* Enter the appropriate Oracle alias. The Oracle alias is the
Oracle system identifier (SID). If a domain was specified for
database instance, add the domain to the alias. The alias name
is recorded in:
OracleHome /network/admin/tnsnames.ora

* Enter the user name of the owner of the Oracle installation.

* Click Next. The District.dat Configuration pane displays.
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11. In the District.dat Configuration pane:

Choose a method for configuring district.dat. For a new
installation, it is recommended to select Create a district.dat
from TNSNAMES.ORA. This will create a district for each
SID entry in the tnsnames.ora file.

See “Understand and Configure Districts” on page 80 in the
Linux Post-Installation Procedures section for information
about configuring districts and about the district configuration
options.

Click Next. The Pre-Installation Summary pane displays.

12. In the Pre-Installation Summary pane:

Verify that all settings are correct. If necessary, click Previous
and correct settings.

Click Install. The Installing Landmark OpenWorks pane and
then the License pane display.

The License pane reminds you that to run any of the
applications in the OpenWorks software, you must have a valid
license from Landmark Graphics Corporation.

http://css.lgc.com/psp/crmp/CUSTOMER/CRM/c/
X LGC _CSS.X _LICENSE SS RPT.GBL

13. In the License screen, click Next.

14. In the Linux Specific pane:

Make note of any scripts that need to be executed.

For example, if SELINUX is enabled, a shell script, root.sh,
located in SOWHOME /bin must be run before the software in
the OpenWorks software can be used. To check whether
SELINUX is enabled, as root execute the sestatus command in
a terminal window.

Click Next. The Install Complete pane displays.
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15. In the Install Complete pane, click Done.

A log of the installation is stored in the OpenWorks home
directory.
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Linux Post-OpenWorkse-Installation Tasks

This section contains tasks to be performed after installing Oracle and
the OpenWorks® software on the server and client machines. Certain of
the post-installation tasks are required and others are optional.

See the OpenWorks® Project Administration manual and the online help
for more detailed information on OpenWorks® configuration topics.

The following tasks are required:

*  Change the security context for SELinux (if SELinux is used)
»  Update Linux LAM server information in .Igclogin

*  Create local users (if user does not exist)

»  Update users

»  Grant database access to the OpenWorks® user

*  Understand and configure districts

These tasks are optional:

*  Manage the location of OpenWorks® system files

*  Manage the location of the OpenWorks® project files

*  Manage the location of seismic data files using the dir.dat
configuration file

*  Run the owsetup script on the Linux server

*  Set Oracle to run database at boot time

*  Set AutoExtend

Post-installation: Resolving out of memory notification, if necessary

Once you are using the GeoDatalL.oad™ applications, if the data set is very large
and the job runs out of memory, you will receive a message explaining how to
allocate more memory. For a Linux operating system, increase the memory to

4 GB by setting an environment variable in Igcenv.cf in the SOWHOME/conf
directory. Set the variable with the following command:

export OW_GDL_WIZARD_MEMORY_ LIMIT 4096m

Change the Security Context for SELinux (64-bit RHEL 5 Servers)

Perform this procedure if instructed to do so via a Red Hat 5 specific
screen at the end of the OpenWorks® installation. It is specific to
RHEL 5 servers that have security-enhanced Linux (SELinux) enabled
for controlling access to system resources. (To check whether

76 Linux Post-OpenWorks®-Installation Tasks 5000.8.1.0



Linux Procedures OpenWorkse Software Installation Procedures

SELINUX is enabled, as root execute the sestatus command in a
terminal window.)

1. Asroot, set the SOWHOME environment variable to the location
of the home directory of the OpenWorks® installation.

2. Run the root.sh script:

sh $OWHOME/bin/root.sh

Update Linux LAM Server Information in .Igclogin

To ensure the license server information is updated for all users in
succeeding steps, edit the .lgclogin file located in $OWHOME /
templates.
Open .lgclogin in a text editor and change the line:

# setenv LM _LICENSE FILE _ LM LICENSE FILE_ Is_Not_Set_
to, for example:

setenv LM_LICENSE_FILE 2014@lamhost.company.com
substituting appropriate values for the TCP port number (2014 in the
example above) and the machine name (lamhost.company.com in the

example above) for the port number used by the LAM server on the
host where the server is running.

Create Local Users

Skip this section if you do not need to create a local user.

1. Asroot, launch SOWHOME/bin/lgcuser.

2. Press Return.

3. Select Create User (#2) and follow the instructions on the screen.

Repeat the steps for each local user.
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Update Users

Perform the following procedure if the local user exists or you need to
update a network user.

1. Asroot, launch SOWHOME/bin/lgcuser.

2. Select Update User (#4) and follow the instructions on the screen.

Grant Database Access to the OpenWorks® User

The OpenWorks® software now uses the Oracle Secure Enterprise
Password Store (Oracle wallet) to store passwords to the database and
to handle the security of the passwords.

A user of Release 5000.x.x.x of the OpenWorks® software is now
associated with both an operating system (OS) user and an Oracle
internally identified user. The Oracle user will have the same name as
the OS user, but will now be required to provide a user name and a
password to access the OpenWorks® database. Users can now change
their Oracle password from the Command Menu. For detailed
information and procedures to manage project databases and access,
refer to the OpenWorks® Online Help (SOWHOME /docs/
onlinehelp.htm).

For the purposes of installation however, the steps to grant database
access to the OpenWorks® user are provided here.

Modify Database Users utility

The Modify Database Users utility in this procedure replaces the orauser utility
from previous releases of the OpenWorks® software.

1. Login as an OpenWorks® user.
2. Launch the Modify Database Users utility:
* Launch the OpenWorks® Command Menu:
$OWHOME/bin/startow -i $$
+ Select Project > Modify Database Users.

3. If prompted, select a district to get to the correct SID.
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4. Inthe DBA Logon window

* In User Name, enter the name of a database administrator
(DBA) who has sufficient privileges to allow users to access
the OpenWorks® database. For example, the SYSTEM user
(one of the internal Oracle database administrators) with
SYSDBA privileges is such a user.

* In Password, enter the DBA's password.
* Click Login.

If the correct credentials are entered, the Database Users window
opens. If the Database Users window does not display, the Login
Failed dialog displays asking you to try to log in again. Click OK
to reassert the DBA Logon dialog. The login process allows three
login attempts. After three attempts, you must repeat step 2 to try
to log in again.

5. In the Database Users window

* Enter the OpenWorks® user name and password in the User
Details area.

*  Check OW_ADMIN if the user will be allowed to create and
delete projects and create, change, or delete tables in a project
or the OWSYS schema. The default state of the box is checked.

*  Check only OWSYS_ ADMIN if the user will be allowed to alter
only the OWSYS schema in the OpenWorks® database. The
default state of the box is unchecked.

Additional information

For more information about OW_ADMIN and OWSYS ADMIN, see
Project Management > Project Administration > OpenWorks
Security in the OpenWorks® Online Help (OpenWorksHome /docs /
onlinehelp.htm).

+ Click Add.

6. Close the Database Users dialog.
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Understand and Configure Districts

Districts allow a company to break up large lists of projects, and allow
the company to separate data by business unit for better data security or
disk ownership.

Support for districts has become a part of the framework of the
OpenWorks® software. In an installation of the OpenWorks® software,
a company can decide whether it will implement districts or not.

To implement districts, the district.dat configuration file must be
configured with the name of each district. The district.dat file also
contains the directory name for configuration files that define storage
locations for data not stored in the database. These configuration files
are dir.dat and owdir.dat, for seismic data files and other OpenWorks®
files, respectively. The default location for these configuration files is
SOWHOME/ conf.

Utilities, such as Project Administration and Project Status Tool,
support districts in their interfaces. For example, when a user of the
OpenWorks® software creates a new project in Project Administration,
part of the project configuration includes selecting the district to which
it will belong.

In a new OpenWorks® installation, when the district option “Create a
district.dat from TNSNAMES.ora” was selected, a valid district was
created for each SID. The file, district.dat, will have a default directory
defined for each of the SIDs that are defined in tnsnames.ora. You will
need to update these directories before running an application of the
OpenWorks® software.

The OpenWorks® installation option “Create empty district.dat”
requires that you configure district.dat before you can run the
OpenWorks® software. The default location of the district.dat file is
SOWHOME /conf. You can change the default location by adding the
environment variable OW_CONF_DIR to the .lgclogin file. The
default location of OW_CONF_DIR is SOWHOME/conf.

The names of the OpenWorks® SIDs must be in all capital letters in
district.dat. See Project Management > Districts in the OpenWorks®
Online Help (OpenWorksHome /docs/onlinehelp.htm) for
detailed procedures to perform district configuration tasks.
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Manage the Location of OpenWorks® System Files

System files are files containing well and lithologic symbols and files
describing file formats for importing or exporting data.

System files are independent of projects and of districts. The location
of the following system directories do not change when changing a
district: OW_SYS DATA, owioformats, and owsymbols.

You can change the location of each of the directories by setting an
environment variable. The OW_SYS DATA directory is now located
by the value in the OW_SYSDATA DIR environment variable. As a
default, this variable is set in lgcenv.cf located in OpenWorksHome/
conf; however, the variable can be set in a user’s initialization script or
set separately in the user’s environment. The environment variables for
the location of the format files (OWIOFORMATS environment
variable) and the well and lithologic symbols (OWSYMBOLDIR
environment variable) can be set in a user’s environment too.

Manage the Location of OpenWorks® Project Files

OpenWorks® project files are external files (not in the database) that
are project specific. These may be files created by certain OpenWorks®
applications or applications that use the OpenWorks® and seismic
development kits.

Should you need to change where these files are stored in the future,
you can edit the owdir.dat file. The location of owdir.dat is determined
by the district.dat configuration file. A district must have an owdir.dat,
and each district in an OpenWorks® instance can have a unique version
of owdir.dat. Before editing, make sure you locate the correct owdir.dat
that is associated with the district where your project is located.

Manage the Location of Seismic Data Files (dir.dat Configuration File)

The dir.dat configuration file is an ACSII text file that lists the file
systems searched for seismic data stored as files. This file also
describes where applications create or from where applications retrieve
seismic data stored in files.

Applications look for dir.dat based on the district.dat configuration file.
By default, district.dat is in OpenWorksHome/conf, but the location
can be changed by setting the OW_CONF_DIR environment variable.
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For Release 5000.x, the format of the dir.dat file has changed from
previous versions. If dir.dat has not been updated for Release 5000.x,
the software will recognize this and create a converted version of the
file in the program’s memory. However, it is recommended that you
update R2003 dir.dat files to the new format.

The dir.dat file is composed of one or more lines. The lines have the
format

RootFileSystemPath filetypel filetype2. . .filetypen

Where

* RootFileSystemPath is a file system where seismic data files
are stored

* filetypel.. filetypen are one of the following zero or more
extensions of seismic data files or the attribute
“OTHER_FILES”

— Zero extensions: OpenWorks® applications will not create
files in a file system with no attributes; however, an
application can read or modify files in the file system,
depending on the permissions of the user running the
application.

— Extensions: If the attribute is a seismic data file extension
(i.e., .3dv, 3dh, etc.), files with that extension can be
created in the file system. If the same extension is applied
to more than one file system, then new files with that
extension are created in the file system with the most
space.

— OTHER_FILES: designates a file system where all types
of files, except those not explicitly enumerated as

attributes for another file system, can be created, read, and
modified.

OTHER_FILES attribute required to write data

At least one file system in dir.dat must have the OTHER FILES
attribute for data not explicitly assigned to another file system to
be written.

You can also define variables within dir.dat, where each variable
represents a group of extensions.
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An example dir.dat is shown below. On the left, extensions attributes
are explicitly stated for each file system. On the right, variables have
been defined for groups of file systems. Both dir.dat indicate identical
storage locations for the seismic data files.

Example dir.dat with explicit extension attributes | Example dir.dat with variables defined (# denotes

the variable definition)

/ub hzd hts

/ua 3dv 3dh cd bri cmp OTHER FILES # define 3d seismic 3dv 3dh cd bri cmp

/uc 3dv 3dh cd bri cmp /ua 3d_seismic OTHER FILES

/ud 3dv 3dh cd bri cmp hzd hts /ub 3d horizons

#define 3d horizons hzd hts

/uc 3d_seismic

/ud 3d_seismic 3d_horizons

The dir.dat files above indicate storage of 3d seismic data files in file
systems /ua, /uc, and /ud. File systems for horizon data files are /ub,
and /ud. Storage for any other files is in file system /ua.

Refer to the dir.dat topic in the OpenWorks® online help for a complete
discussion of the dir.dat configuration file.

Run the owsetup Script on Linux Server

The owsetup script performs a number of configuration steps such as
setting permissions and adding startup commands so that OpenWorks®
will run properly.

1. Asroot, launch:

SOWHOME/install/owsetup -o $SOWHOME

2. When the OpenWorks® Set Up utility opens, select option 3.

Set Oracle to Start Database at Boot Time

To have the Oracle database start at boot time, set the entry in the /etc/
oratab parameter file that is used by the dbstart utility to start the Oracle
database. The entry looks like:

SID:0ORACLE_HOME_AUTO
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Where AUTO is the setting for starting the Oracle database at boot
time. In the example below:

SID: owR5000/oracle/OraHomel :N

changing the AUTO setting from N to Y and saving the file will
result in the database starting at boot time.

Turn Off AutoExtend

Oracle’s AutoExtend feature is turned on by default to extend system and
project tables spaces. If you would like to disable the AutoExtend
feature for the OpenWorks® project tablespaces, edit the setting for the
OW_AUTOEXTEND_FLAG variable in

SOWHOME/lgcenv.cf or $SOW_CONF_DIR/lgcenv.cf .

By default the setting is:
OW_AUTOEXTEND_FLAG  YES
To turn off AutoExtend, set the variable as:

OW_AUTOEXTEND_FLAG NO
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Starting OpenWorks=

The startow command allows you to start the OpenWorks® Command
Menu. To use the OpenWorks® applications, you must have a current
license and access to the OpenWorks® database instance.

To start the OpenWorks® Command Menu, open a terminal window
and enter:

SOWHOME /bin/startow

Creates an OpenWorks session with an instance ID with the
default ID.

or
SOWHOME /bin/startow -i $$

Creates an OpenWorks session with an instance ID equal to the
shell process ID.

or
SOWHOME/bin/startow -1 NumValue

Where NumValue is a positive number with no more than nine
digits, and creates a with an instance ID of NumValue.
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OpenWorks. Schemas on an Existing

Scope

Oracle Database

The procedures in this section cover installing the OpenWorks®
schemas on a server with an existing Oracle database. The procedure
applies to all operating systems.

This procedure assumes no prior installation of the OpenWorks®
schemas on this server.

Prerequisite: For OpenWorks Schemas on an
Oracle 11g Database

In order for the OpenWorks database instance to function correctly on
an Oracle 11g database, the COMPATIBLE initialization parameter of
the database must have beensetto 11.1.0.0.0 before installing
the OpenWorks schemas.

WARNING: If your 11g database has a value otherthan 11.1.0.0.0
for the COMPATIBLE initialization parameter, some projects may not
restore properly.
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Install OpenWorkse Schemas on an Existing Oracle
Database

1. Log on as the Oracle user.

2. Create a directory for the OW HOME DIR environment variable.
The directory needs to be unique for the local user because the
Oracle database software will store the Oracle wallet credentials in
this location.

3. Setthe OW HOME DIR environment variable to the path of the
directory of this user.

For Windows, this environment variable is a system environment
variable. In Windows, do the following:

* From the Control Panel, select System And Security >
System, and then Advanced System Settings. (For
Windows XP or Windows Server 2003 operating systems,
select System.) The System Properties dialog displays.

* Inthe Advanced tab of the System Properties dialog, click the
Environment Variables button. Use the System Variables
(lower) pane of the dialog box to set the system variable and
then close the dialogs.

4. Download the OpenWorks® Database installation file from the
Landmark® Software Manager (https://esd.halliburton.com/
download/download.jsp).

5. Extract the ZIP file to a local directory.

These files have names of a form similar to the following:
OWDBVersionInfo . exe or OWDBVersionInfo.bin. For example:

OWDB_5000_8_1.bin

6. On Linux 64-bit, verify that Oracle lib32 is in the
LD LIBRARY PATH:

echo LD_LIBRARY_PATH ${ORACLE_HOME}/
1ib32:${LD_LIBRARY_PATH}
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7. Make sure the Oracle Listener is running. For example:
SORACLE_HOME/bin/lsnrctl status
8. Run the installation program.

9. In the Introduction pane, click Next. The Select Type Of Install
pane displays.

10. In the Select Type Of Install pane, select Create Additional
OpenWorks Instance on Existing Oracle Install.

11. Click Next. The Choose Install Folder pane displays.

12. In the Choose Install Folder pane, enter the directory where you
want to install the OpenWorks® database files.

Single Versus Multiple Locations for the Files of
OpenWorkse Database Instances

If you have multiple OpenWorks database instances on an Oracle
database, all OpenWorks database instances can use the same
location for the database files.

If the OpenWorks database instances have different locations:

« Differences can arise between the versions of the scripts in
the various directories for the OpenWorks database
instances.

e Ifthe same Oracle user administers each database instance,
the OWDBSETUP_DIR environment variable must be
changed to the location for that database instance, when the
Oracle user administers the database instance. The Database
Administration tool of the OpenWorks software uses the
path in the environment variable to find its SQL scripts.

13. Click Next. The Installation Options pane displays.

14. In the Installation Options pane, select OpenWorks® Schemas.
15. Click Next. The Get Oracle Information pane displays.

16. In the Get Oracle Information pane:

* Verify that the default Oracle Home directory is where you
installed Oracle.
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* In Oracle SID, accept the machine name as the Oracle system
identifier, or enter another identifier. The identifier must be
unique on the Oracle database. The identifier, or database
instance name, should contain a maximum of eight
alphanumeric characters and the alphabetical characters should
be all capital letters. The first character must be alphabetical.
Do not use any special characters.

* In Oracle SID Alias, accept the default, which is usually the

same as the Oracle SID name. This value is the net service
name, and it can be different from the SID name.

* Click Next. The Schemas Directory pane displays.
17. 1In the Schemas Directory pane:

* Select the directory where you want to create OpenWorks®
schemas. The directory should be different from the location for
the schemas of any other database instance.

* Click Next. The Projects Directories pane displays

18. In the Projects Directories pane:

» Specify the directory where you want to create project files.
You must have at least one project directory. You can create
additional directories in order to distribute the files over a
number of file systems.

» Ifdesired, enter additional directories for project database files.

* Click Next. The DB Admin Info pane displays.

19. In the DB Admin Info pane:

Pre-Oracle might have configured these values for the Oracle user

in the account’s initialization file (.login). This configuration

allows the Oracle user to run the Database Administration tool in

the OpenWorks® software.

* In OpenWorks Home, enter path for the home of the
OpenWorks® software. For example, a typical path might be:

/d01/Landmark/OpenWorks
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* In License Server, enter the connection information (the TCP
port and host name) of the Landmark® Application Manager
(LAM) for the LM_LICENSE_FILE environment variable.
If the connection information is not known at this time, it can
be set later in the initialization files of the Oracle user.

LAM is the license server for all software from Landmark, and
the server should have a license file that contains a current

license for the software you will use, in this case, the
OpenWorks® software.

This configuration sets the LM_LICENSE_FILE
environment variable with a value with the following form:

TCP_PortNum@MachineName
where TCP_PortNum is a TCP port number (2013 is the
default), and the MachineName is the IP address or full host
name of the machine where the LAM server is running.
For example, the value may be set like the following:
2013@lamhost.company.com
or
2013@123.123.123.123
* Click Next. The Pre-installation Summary pane displays.
20. In the Pre-Installation Summary pane:
» Verify that all settings are correct.
» If necessary, click Previous and correct settings.
» If all settings are correct, click Install.
21. In the OpenWorks® Schemas Creation Output pane:
*  Check for Oracle error messages in the log file.
Some Oracle errors are acceptable, for example, errors that
occur because of drop user statements and

IMP_FULL DATABASE, EXP FULL DATABASE role
conflicts.
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22.

23.

24.

25.

* C(Click Next.

* (Click Next. The Database Initialization Parameters Check
dialog displays.

In the Database Initialization Parameters Check dialog:

* Follow the instructions to check the initialization parameters
recyclebin (should be off)and
sec_case_sensitive_logon (shouldbe FALSE), and
if need be, to set them for init.ora.

* Click OK. The Modify .login pane displays.

In the Modify .login pane, click Next. The Install Complete pane
displays.

A new initialization file is created with a name like .login _mod
or .bash profile mod. This file contains the settings for various
environment variables. These variables must be set int the Oracle
user’s initialization file in order for the user to be able to run the
Database Administration tool of the OpenWorks® software.

A log (Landmark OpenWorks Database InstallLog.log) for the
installation is stored in the same directory as the location selected
for the database in the Choose Install Folder pane.

In the Install Complete screen, click Done.

Check the initialization parameter with a script in the Database
Administration tool in the OpenWorks® software.

* For example, the following commands to check the parameter:

show parameters recyclebin
show parameters sec_case_sensitive_logon

» For example, if necessary, the following commands set the
following initialization parameter to off:

alter system set recyclebin=off scope=spfile;

alter system set sec_case_sensitive_logon=false
scope=gspfile;
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After installing the OpenWorks® database and schemas, you can install
the OpenWorks® software on the server and the clients. See:

*  Windows Procedures: “Install the OpenWorks® Software” on
page 26.

*  Linux Procedures: “Install the OpenWorks® Software” on
page 72.
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Upgrade the OpenWorks. Software

This chapter contains information about upgrading an installation of
the OpenWorks® software Release 5000.x.x.x to the current version of
the OpenWorks® software.

You can use the procedures in this section to upgrade the following

versions:

* 5000.0.2.5
* 5000.0.3.0
* 5000.0.3.5
* 5000.8.0.0
* 5000.8.0.1

For releases before 5000.0.2.5, you will need to upgrade to a 5000.0.2.x
version before upgrading to this version, or perform a new installation
for this version and then transfer your data to the new installation.

The installation process has the following parts:

*  “Install the New Version of the OpenWorks® Software” on
page 96

*  “Upgrade the Oracle Software” on page 98
*  “Remove the Oracle Wallet Directory and its Files” on page 100
*  “Upgrade the Projects in the OpenWorks® Database” on page 101
»  Perform Post-installation Steps
* “Linux Post-installation Steps” on page 103

*  “Windows: Post-installation Steps” on page 104

5000.8.1.0 95



OpenWorkse Software Installation Procedures Upgrade the OpenWorks® Software

Install the New Version of the OpenWorkse Software

If you are installing an update over an existing 5000.x.x.x installation,
the installation program will not prompt you for district.dat, the
OpenWorks® project directories for files external to the OpenWorks®
instance, and the ORACLE HOME configurations. These
configurations will be saved during the update process.

WARNING: Do Not Use the Database Installation Program on an Existing OpenWorkse
Database Instance

Do not attempt to upgrade an existing OpenWorkse database instance with a new release of an
OpenWorks® database installation program. Such an action will destroy vital information in the
OpenWorks® database.

In the Landmarke Software Manager, a release database installation program has a title of the form:

OpenWorks Database VersionNum OS Name
OpenWorks Database VersionNum Update OS Name

And its file name has a form similar to the following:

OWDB VersionNum . Ext
OWDB VersionNumUpdate . Ext

When you upgrade the OpenWorks® software, and then upgrade the projects in the database (as described
in this section), the database instance will be upgraded.

To patch an existing installation of the OpenWorks® and
GeoDatal.oad™ software, do the following:

1. Backup all of your OpenWorks® projects.
This is recommended since the project upgrade script will be run.
2. Make sure all OpenWorks® sessions and launchers are closed.
If you do not close out all of the running OpenWorks® processes,
you may receive “file busy” messages in the installation log file.
This will indicate that the file was not overwritten, and you will

need to stop the process that is running and install again.

3. Log in as user with system administrator privileges.
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4.

For Linux, stop NetD as follows. In a terminal window, type:
ps -ef | grep NetD
This determines the owner. Run the command below as the owner.
SOWHOME/bin/stop_netd
Download the OpenWorks® software from the Landmark®
Software Manager (https://esd.halliburton.com/download/
download.jsp).

Extract the ZIP file to a local directory.

Set the environment variable (Linux, $OWHOME; Windows,
system-level variable, $OWHOME%).

Install the update for OpenWorks® and GeoDatalLoad™ software
by running the executable (.bin file) in Linux or the installation
program (.exe file) in Windows.

Upgrade existing projects. See the “Upgrade the Projects in the
OpenWorks® Database” on page 101.
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Upgrade the Oracle Software

This version of the OpenWorks® software supports version 10.2.0.5 of
the Oracle server and client, and supports version 11.2.0.2 of the Oracle
server and client.

+  Staying with Oracle 10g: If the version of the Oracle software is
less than version 10.2.0.5, upgrade it to version 10.2.0.5. For
upgrade instructions, see README.htm or README.html
located among the patch installation files from Oracle.

Specifically:

— Linux: See the section, “10.6.2 Manually Upgrading a
Release 10.2 Database.”

—  Windows: See the section, “10.5.2 Manually Upgrading a
Release 10.2 Database.”

This process allows you to upgrade a 10.2.0.x database to version
10.2.0.5.

Manual versus Database Upgrade Assistant

The section, “10.5.1 Upgrading a Release 10.2 Database using Oracle
Database Upgrade Assistant,” or “10.6.1 Upgrading a Release 10.2
Database using Oracle Database Upgrade Assistant”, of README.htm
or README.html discusses upgrading the database using Oracle
Database Upgrade Assistant (DBUA).

DBUA may produce mixed results in this upgrade.

The manual process is recommended.

For more information, see the Oracle documentation, specifically
the Oracle Database Upgrade Guide 10g Release 2 (10.2)
(document B14238-02).
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Upgrading to Oracle 11g (11.2.0.2): If your site currently

uses 10g, and the site will use version 11.2.0.2, see “Upgrade the
Oracle Software: 10g to 11g” on page 105 for upgrading the
Oracle software to 11g.

Do Not Mix Oracle Versions

When the OpenWorks® server uses the Oracle 11g database server, only
Oracle 11g clients should access the database server.

Likewise, when the OpenWorks® server uses the Oracle 10g database server, only
Oracle 10g clients should access the database server.
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Remove the Oracle Wallet Directory and its Files

In version 5000.0.3.0 of the OpenWorks software, changes were made
to the storage of credentials in the Oracle wallet for a user. Some
applications created with libraries from the previous versions of the
OpenWorks software, such as version 5000.0.2.x, may have trouble
accessing the information in the Oracle wallet.

If you are upgrading from version 5000.0.2.x of the software, the
Oracle wallet for a user must be deleted. After the first access of the
database, when the user provides login credentials, the Oracle wallet
for the user will be recreated, and old and new applications will be able
to access the OpenWorks database instance as before.

Deleting a User’s Wallet

If you are upgrading from 5000.0.2.x, remove the Oracle wallet of a
user of the OpenWorks database instance. The removal of the wallet is
accomplished by deleting the user’s wallet directory and its
contents.

Do the following to delete the wallet:

1. Navigate to the location of the wallet directory for the user.

Linux: the directory is normally contained in the user’s home
directory (pointed to by the SHOME environment variable).

Windows: the directory is in the user directory pointed to by
the $OW_Home_Dir$% user environment variable. For example:

c:\users\UserName

2. Delete the wallet directory.

100

Remove the Oracle Wallet Directory and its Files 5000.8.1.0



Upgrade the OpenWorks® Software OpenWorkse Software Installation Procedures

Upgrade the Projects in the OpenWorkse Database

After installing the new version of the OpenWorks® software, you must
upgrade any 5000.x.x.x projects in the database to the current version.

Upgrading a Project Database Using the Command Line

To upgrade one project database and its interpretation projects, execute
the following script in a terminal window:

SOWHOME /bin/OWRuntimeLauncher.sh
RunPatchSqglScripts OW _SID ProjectDBName
-logdir LogDir

where OW _SID is the system identifier of the OpenWorks® database
where the project database is located.

ProjectDBName is the name of the project database that needs to be
upgraded.

LogDir is the location where the script should store its logs. The
parameters -logdir LogDir are optional.

After the projects have been upgraded, follow the post-installation
steps in the following sections.

Upgrading All Project Databases Using the Command Line

To upgrade all projects in an OpenWorks® database, run the script with
the ProjectDBName argument set to the ALL keyword. For example
(substitute OW5000 with the name of the OpenWorks instance, or SID):

*  Windows: %owhome%\bin\OWRuntimeLauncher .bat
RunPatchSglScripts OWS5000 ALL
-logdir C:\userhome\LOGS

* Linux: SOWHOME /bin/OWRuntimeLauncher.sh
RunPatchSglScripts OW5000 ALL
-logdir /d0l1/userhome/logs

After the projects have been upgraded, follow the post-installation
steps in the following sections.
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Upgrading Projects With Project Administration

Project Administration allows you to upgrade project databases of
version 5000.0.3.5 or older. After the OpenWorks® software has been
updated, you need to update all the projects already in the database.

To upgrade multiple project databases:

1.

Right-click the name of a project database that should be upgraded
to the current version of the OpenWorks® software. The pop-up
menu displays

Select the Upgrade option in the menu. The Project Upgrade
dialog displays.

In the list of project databases, use Ctrl+Click to select a
discontiguous set of project databases, or Shift+Click to select a
contiguous set of project databases, or check the Select All box to
select all project databases in the list.

Click Start.

After the projects have been upgraded, follow the post-installation
steps in the following sections.
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Linux Post-installation Steps

Updating Users

After upgrading the OpenWorks® software, you should update the user
profile of the users of the database instance. This can be done by using
the lgcuser utility.

Perform the following procedure if a local user of the database instance
should be updated (whether a local or network user).

1. Asroot, launch SOWHOME/bin/lgcuser.
2. Press Return.

3. Select Update User (#4) and follow the instructions on the
screen.

The user can now run the OpenWorks® software with the new
profile.
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Windows: Post-installation Steps

On Windows, if services from GeoGraphix® software are running on
the machine, you may need to restart them. The services you may need
to restart are:

*  GGX Database Service
*  GGX List Service
e GGX Network Access Service

For example, open the Services control panel (Start >Control Panel >
Administrative Tools > Services), select the name of a service in the
right pane, and click the Restart Service ( m» ) toolbar button.
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Upgrade the Oracle Software: 10g to 11g

This chapter contains information about upgrading an installation of
the Oracle software from version 10g (10.2.0.5) to 11g (11.2.0.2). This
procedure uses the Database Administration tool in the OpenWorks
software.

*  “Assumptions for the Database Upgrade Procedure” on page 106
*  “Linux: Oracle Database Upgrade” on page 107

*  “Linux: Upgrade Oracle Client” on page 119

*  “Windows: Oracle Database Upgrade” on page 125

*  “Windows: Upgrade Oracle Client” on page 133

Some older Landmark applications may have problems using the
Oracle 11g software. For more information about configurations that
enable those applications to use the upgraded OpenWorks software and

database instance, see:

“Oracle 11g Compatibility with Some Applications” on page 136

Do Not Mix Oracle Versions

If you upgrade the server software, upgrade the client software.

When the OpenWorks® server uses the Oracle 11g database server, only
Oracle 11g clients should access the database server.

Likewise, when the OpenWorks® server uses the Oracle 10g database server, only
Oracle 10g clients should access the database server.
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Assumptions for the Database Upgrade Procedure

These upgrade procedures are based upon the following assumptions:
*  Version 5000.8.1.0 of the OpenWorks® software is installed.
*  The user performing the upgrade must be the Oracle user.

*  The same Oracle user must manage both the old Oracle installation
and the new installation.

*  Since the Database Administration tool is a part of the OpenWorks
software, the environment of the Oracle user must have the
following environment variables set:

e PATH: the PATH environment variable should have
SOWHOME /bin added to it in Linux, or $owhome%\bin
in Windows.

*  OpenWorks Home: the OWHOME environment variable must
be set in the environment of the user (Oracle user) performing
the upgrade.

* License For the OpenWorks Software: the
LM _LICENSE_FILE environment variable must be set in the
environment of the user (Oracle user) performing the upgrade.

* Directory of the OpenWorks Database Setup Files: the
OWDBSETUP_DIR environment variable must be set with the
directory location where the owdbsetup.sh file resides.
Typically, the default location:

OracleUserHome /LLandmark /OpenWorksDatabase
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Linux: Oracle Database Upgrade

This procedure upgrades an existing Oracle 10g (10.2.0.5) database to
Oracle 11g (11.2.0.2).

To upgrade an existing Oracle 10g database to Oracle 11g, do the
following:

*  “Check Prerequisites” on page 107
*  “Install Oracle 11g in Linux” on page 111
*  “Run the Database Administration Tool in Linux” on page 115

+  “Update Oracle User Environment” on page 118

Check Prerequisites

Do the following before upgrading the Oracle software.
1. Create a cold backup of the Oracle 10g database.

1. Check the following lines in /etc/security/
limits.conf:

OracleUserName soft nproc 2047
OracleUserName hard nproc 16384
OracleUserName soft nofile 1024
OracleUserName hard nofile 65536
OracleUserName hard stack 10240

2. Check the kernel parameters.
more /etc/sysctl.conf
They should be the following:

kernel.shmmax = 2147483648
The shnmax parameter should be a value in bytes equal to 4 GB - 1 byte or
equal to half the size of physical memory, whichever is lower
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kernel.shmall = 2097152
kernel.sem = 250 32000 100 128

kernel.shmmni = 4096
fs.file-max = 6815744
fs.aio-max-nr = 1048576

The aio-max-mr parameter limits concurrent outstanding requests and
should be set to avoid I/0 subsystem failures.

net.ipv4d.ip_local_port_range = 1024 65500
net.core.rmem _default = 4194304
net.core.rmem_max = 4194304

net.core.wmem _default = 1048567
net.core.wmem max = 1048576

3. To correct a kernel parameter, do the following:
* Logon as root.
+ Edit sysctl.conf located in the /etc directory. For example:
vi /etc/sysctl.conf

* Modify the values for the parameter. For most parameters the
values given above are minimal values.

* Save the file.
* To load the new parameters, run following command:
sysctl -p /etc/sysctl.conf

* To check that the correct, new parameters are loaded, run the
following command:

/sbin/sysctl -a
* Logout as root.

4. In limits.conf located in the /etc/security directory,
increase the limits of the maximum open file descriptors for the
Oracle owner. Add the following line to the file as root:

@dba - nofile 65536

5.  Run the command to list RPMs.

rpm -g --gf '${NAME}-%{VERSION}-%{RELEASE} (%${ARCH})\n' binutils compat-db
compat-1ibf2c-34 elfutils-libelf elfutils-libelf-devel compat-libstdc++-33-
3.2.3 control-center gcc gcc-c++ glibc glibc-common glibc-devel glibc-
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headers ksh libaio libaio-devel libgcc libstdc++ libstdc++-devel make
numactl-devel sysstat libaio unixODBC unixODBC-devel

It is important to have these 64-bit RPMs installed. The above
command will list the architecture of each binary package. You

will see that some RPMs are installed twice when you run this
command (32-bit and 64-bit).

The command should result in the list of required packages shown
below. For Oracle 11g (11.2.0.2), make sure the following
packages are installed. The version of the package should be the
version given below or later.

RHEL 4 x86_64 RHEL 5 x86_64 (64-bit)
binutils-2.15.92.0.2 binutils-2.17.50.0.6
compat-libstdc++-33-3.2.3 compat-1ibf2¢c-34-3.4.6-4 (RHEL version 5.6)
compat-libstdc++-33-3.2.3 (32 bit) | compat-libf2c-34-3.4.6-4.1.i1386 (RHEL version 5.7)
elfutils-libelf-0.97 compat-libstdc++-33-3.2.3
elfutils-libelf-devel-0.97 compat-libstdc++-33-3.2.3 (32-bit)
expat-1.95.7 elfutils-libelf-0.125

gce-3.4.6 elfutils-libelf-devel-0.125

gee-c++-3.4.6 elfutils-libelf-devel-0.137 (RHEL version 5.6 or 5.7)
glibc-2.3.4-2.41 gce-4.1.2

glibc-2.3.4-2.41 (32 bit) gee-c++-4.1.2

glibc-common-2.3.4 glibc-2.5-24

glibc-devel-2.3.4 glibc-2.5-24 (32-bit)

glibc-headers-2.3.4 glibc-common-2.5

libaio-0.3.105 glibc-devel-2.5

libaio-0.3.105 (32 bit) glibc-devel-2.5 (32-bit)

libaio-devel-0.3.105 glibc-headers-2.5

libaio-devel-0.3.105 (32 bit) ksh-20060214

libgcc-3.4.6 libaio-0.3.106

libgec-3.4.6 (32-bit) libaio-0.3.106 (32-bit)

libstdc++-3.4.6 libaio-devel-0.3.106

libstdc++-3.4.6 (32 bit) libaio-devel-0.3.106 (32-bit)

libstdc++-devel 3.4.6 libgec-4.1.2

make-3.80 libgcc-4.1.2 (32-bit)

numactl-0.6.4.x86_64 libstdc++-4.1.2

pdksh-5.2.14 libstdc++-4.1.2 (32-bit)

sysstat-5.0.5 libstdc++-devel 4.1.2
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RHEL 4 x86_64

RHEL 5 x86_64 (64-bit)

unixODBC-2.2.11
unixODBC-2.2.11 (32 bit)
unixODBC-devel-2.2.11
unixODBC-devel-2.2.11 (32 bit)

make-3.81
numactl-devel-0.9.8.x86 64
sysstat-7.0.2

unixODBC-2.2.11
unixODBC-2.2.11 (32-bit)
unixODBC-devel-2.2.11
unixODBC-devel-2.2.11 (32-bit)

6. Ifnot set in the environment, set the OWHOME (OpenWorks
home) and the LM_LICENSE_FILE environment variables in
the initialization file (for example, .login) for the Oracle user.

For the OWHOME variable, for example, if the OpenWorks
software were installed in the /Landmark/OpenWorks
directory, the file would have a setting like the following:

setenv OWHOME /Landmark/OpenWorks

Forthe LM _LICENSE_FILE environment variable, the form is

the following:

setenv LM _LICENSE_FILE TCP_PortNum@MachineName

where TCP_PortNum is a TCP port number (2013 is the
default), and the MachineName is the IP address or full host
name of the machine where the LAM server is running.

For example, the environment variable may be set to a value
like the following:

2013@lamhost.company.com

or

2013@123.123.123.123

7. Start Oracle 10.2.0.5 database instance.

8. Start the Oracle 10.2.0.5 listener.
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Install Oracle 11g in Linux

To install the Oracle 11g software, do the following:

Logon as Oracle owner.

Oracle 10g and 11g Must Have the Same Oracle Owner

The Oracle owner must be the same in both installation, 10g and 11g.
If the installations have different owners, you will not be able to
upgrade your OpenWorks database instance from 10g to 11g.

If you are logged in as a temporary or substitute user (for example,
used the su command), set the DISPLAY variable. For
example:

setenv DISPLAY HostName:0.0
Download OpenWorks database instance installation program (for
example, OWDBSetup linux_with_Oracle.zip) for the operating
system from the Landmark® Software Manager (https://
esd.halliburton.com/download/download.jsp) to a directory on the

system.

Note: The ZIP file is around 2.5 GB, and when it is expanded it
takes about another 2.5 GB.

Extract the ZIP file into a directory.

In the directory where the file was extracted, run the installer
command:

./OWDB_5000_8_1.bin

The Introduction pane of the OpenWorks Database dialog box
displays.

Click Next. The Select Type Of Install pane displays in the dialog.
In the Select Type Of Install pane:

» Select Install Oracle media only to support recovery or
upgrade.

* Click Next. The Choose Install Folder pane displays.

5000.8.1.0

Linux: Oracle Database Upgrade 111


https://esd.halliburton.com/download/download.jsp
https://esd.halliburton.com/download/download.jsp

OpenWorkse Software Installation Procedures

Upgrade the Oracle Software: 10g to 11g

8. In the Choose Install Folder pane:

Enter the directory where you want to install the files of the
OpenWorks® database instance.

Click Next. The Get Oracle Information pane displays.

9. In the Get Oracle Information pane:

In Oracle Base, enter a path for the Oracle base directory. For
example:

/oracle/product

If you change the default path in the text box, you may need to
change the setting of the ORACLE_BASE environment
variable in the .login initialization file of the Oracle user. For
example:

setenv ORACLE_BASE ${HOME}/product

In Oracle Home, enter the path for Oracle software. For
example:

/oracle/product/11.2.0/dbhome_1

If you change the default path in the text box, you may need to
change the setting of the ORACLE_HOME environment
variable in the .login initialization file of the Oracle user. For
example:

setenv ORACLE_HOME ${ORACLE_BASE}/11.2.0/dbhome_1

Click Next. The DB Admin Info pane displays.

10. In the DB Admin Info pane:

Pre-Oracle might have configured these values for the Oracle user
in the account’s initialization file (.login). This configuration
allows the Oracle user to run the Database Administration tool in
the OpenWorks® software.

Enter path for the home of the OpenWorks® software. For
example, a typical path might be:

/d01/Landmark/OpenWorks
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* Enter the connection information (the TCP port and host name)
of the Landmark® Application Manager (LAM) for the
LM _LICENSE_FILE environment variable. If the
connection information is not known at this time, it can be set
later in the initialization files of the Oracle user.

LAM is the license server for all software from Landmark, and
the server should have a license file that contains a current
license for the software you will use, in this case, the
OpenWorks® software.

This configuration sets the LM_LICENSE_FILE
environment variable with a value with the following form:

TCP_PortNum@MachineName
where TCP_PortNum is a TCP port number (2013 is the
default), and the MachineName is the IP address or full host
name of the machine where the LAM server is running.
For example, the value may be set like the following:
2013@lamhost.company.com
or
2013@123.123.123.123
* Click Next. The Pre-installation Summary pane displays.

11. In the Pre-installation Summary pane:

» Verify that all settings are correct. If necessary, click Previous
and correct settings.

* Click Install if all settings are correct. The Installing landmark
OpenWorks Database pane displays.

After the database is installed, the Post Install Actions pane
displays.

12. Follow the instructions in the Post Install Actions pane to execute
the any scripts mentioned, such as root.sh or orainstRoot.sh.

* Open a terminal window on the same machine.

5000.8.1.0 Linux: Oracle Database Upgrade 113



OpenWorkse Software Installation Procedures Upgrade the Oracle Software: 10g to 11g

* Logon as root.

* Execute the root.sh and orainstRoot.sh scripts. Their locations
are indicated in the Post Install Actions pane. The default path
names are:

OracleHome /root . sh

The log for root.sh is stored in the OracleHome/install
directory.

* Click Next in the Post Install Actions pane only after
successfully executing the root.sh and orainstRoot.sh scripts.

After clicking Next, The SQLNET.ORA dialog box
displays.The file, sqlnet.ora, is modified to include
configurations for the Oracle wallet. A backup is made of the
file and saved in the same directory. The file is located in:

OracleHome /network/admin/sglnet.ora

* Click OK in the SQLNET.ORA dialog. The Modify .login
pane displays.

A new initialization file is created with a name like .login_mod
or .bash_profile_mod. This file contains the settings for
various environment variables, such as the
OWDBSETUP_DIR environment variable. These variables
must be set in the Oracle user’s initialization file in order for
the user to be able to run the Database Administration tool of
the OpenWorks® software.

13. In the Modify .login pane, click Next. The Install Complete pane
displays.

A log (Landmark OpenWorks Database InstallLog.log) for the
installation is stored in the same directory as the location selected
for the database in the Choose Install Folder pane.
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14. Click Done.

If there are any errors, additional windows will appear describing
the errors.

Acceptable Oracle error messages

Some Oracle errors are acceptable; e.g., errors that occur because of the
drop user statements and IMP_FULL DATABASE,
EXP_FULL _DATABASE role conflicts.

Run the Database Administration Tool in Linux

This procedure uses the Database Administration tool of the
OpenWorks software to upgrade the database instance from Oracle 10g
to 11g.

Do the following to upgrade the database instance:

1.

2.

Open a terminal window.
Start Database Administration by executing the
OWRuntimeLauncher.sh script with the DbAdmin parameter.
For example:
SOWHOME /bin/OWRuntimeLauncher.sh DbAdmin
The Database Administration window displays.
Select Database > Upgrade. The Upgrade Wizard dialog opens.
The default log directory is the user’s home directory.
Click Next. The Options pane displays.
In the Options pane, do the following:
* In Oracle Instance, specify the name of the system identifier
(SID) of the OpenWorks database instance. This value is filled

in with the setting of the ORACLE_HOME environment
variable in environment of the Oracle user.
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In Oracle 10 Home, specify the path for Oracle home. For
example:

/d01/oral0g/OraHomel

In Oracle 11 Home, specify the path for Oracle home. for
example:

/d01/orallg/product/11.2.0/dbhome_1

In Log Directory, if you want the log files in a location other
than the default (the home directory of the Oracle user),
specify a path.

Click Next. The Move Files pane displays.

The Move Files pane contains a table with a column for paths
to data files in the Oracle 10g database, and with a column
listing a set of file names of the data files in a directory. A
directory can have one or more data files.

In the Move Files pane, do the following:

Select one or more locations of data files. During the selection,
hold down the Shift key to select contiguous locations, or hold
down the Ctrl key to select discontiguous locations.

Click Change New Directory Locations. An Open dialog
displays, allowing you to select a destination location for the
files in the Oracle 11g environment.

Select the directory for the data files.

Click Open.

Repeat the steps on this pane until you have selected a new
destination for all the data files in the Oracle 10g environment.

After all the Oracle 10g data files have a destination in the
Oracle 11g environment, click Next. The Parameters pane
displays.

In the Parameters pane, use the following guidelines:

Database Mode: ArchiveLLog mode archives redo logs before
they are overwritten. This mode allows the database to be

116

Linux: Oracle Database Upgrade 5000.8.1.0



Upgrade the Oracle Software: 10g to 11g OpenWorkse Software Installation Procedures

backed up while the database is in an inconsistent state (or
while the database is being accessed by users). NoArchiveLog
mode allows redo logs for the database instance to be
overwritten without archiving the old redo logs.

NoArchiveLog Mode: Backups Require Database
Shutdown

With NoArchiveLog mode, a backup can only be performed when
the database is in a consistent state.

For an Oracle database to be in a consistent state, it must be
shutdown with the normal, immediate, or transactional parameter,
and the restarted database must be backed up in a mode (such as the
Mount mode), where the database is closed to access, except for
certain database administrator (DBA) activities.

Schedule Database Backup: If ArchiveLog is selected, the
database will perform an automatic backup. If NoArchiveLog
is selected, select Yes to allow the database to make automatic
backups, or select No otherwise.

WARNING:As described for NoArchiveLog in Database Mode,
the database must shutdown before the backup begins. Any
connections to the database at the time of the shutdown will be
disconnected.

Backup Time (= ): Click the Backup Time button to display
the Select Backup Time dialog and to set the time for
automatic backups.

Number Of Days To Keep Backups: Specify the number of
days to keep database backups. The default is two.

Recovery Area Directory (7 ): Specify the location for
recovery files (control files, redo logs, archived redo logs,
flashback logs, and RMAN backups). The location can be a
system directory or network location.

Recovery Area Maximum Size: Specify the maximum size
(or disk quota) of the recovery file area in units of gigabytes.

The amount of space can vary depending on the amount of data
in the database instance, the size of data blocks, the number of
changes to the data, the number of days in the retention policy
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for backups and archive logs, and other configurations of the
database.

Ideally, the area should be able to contain all data files in the
database and all current backup files.

Memory Target: Specify a minimum amount of memory in
units of megabytes for the database instance to use. This value
helps determine how much memory the instance will use and
enables automatic memory management by the database. The
database can increase it up to the maximum memory target.
The amount should be more than 1024 MB (or 1 GB), but
equal to or less than the maximum memory target.

Maximum Memory Target: Specify the maximum amount in
units of megabytes that the database instance can use on the
system. The amount should be more than 1024 MB (or 1 GB).

8. Click Finish. The Upgrade Wizard window closes, and the
upgrade messages are displayed in the Upgrade Databaselnstance
tab in the Database Administration window.

The upgrade may take a long time, depending on the amount of
data in the database instance. When finished, the wizard displays:

The upgrade is successfully completed.

Update Oracle User Environment

After the installation of Oracle 11g and upgrading the existing
database, the environment variables of the Oracle owner account must
be updated to refer to the new Oracle installation. To update these
parameters, do the following:

1. Modify the ORACLE_BASE and ORACLE_HOME variables
in .login of Oracle owner to reflect the location of the Oracle 11g
database.

2. Log out, and then login again as the Oracle owner.

3. Inthe 11g installation, add (or modify) the
ADR_BASE_LISTENER parameter in listener.ora. It should refer
to the new home of the 11g installation. For example:

ADR_BASE_LISTENER

= /d01/orallg/product/11.2.0/dbhome_1
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Linux: Upgrade Oracle Client

For client installations of the OpenWorks® software, you must also
install version 11g of the Oracle client in a new directory from the
installation directory for the 10g client, and then set the
ORACLE_HOME environment variable to the directory of the 11g
client.

Prerequisites

The prerequisite for installing Oracle on the client running the RHEL
operating systems is checking software packages (RPMs).

For RHEL 5, the required package versions are listed in

*  Oracle Database Installation Guide 11g Release 2 (11.2) for Linux
x86 (for 32-bit versions)

*  Oracle Database Installation Guide 11g Release 2 (11.2) for Linux
x86-64 (for 64-bit versions)

Verify the RPMs using the procedure below.

1. For the 64-bit operating system only, verify that you are running
the x86 64 kernel on an x86 64 platform:

# uname -mi

The result should be: “x86 64 x86 64~
2. Run the command to list RPMs.
* For the 32-bit operating system:

rpm -g binutils compat-db elfutils-libelf compat-libstdc++-33-3.2.3 control-
center gcc gcc-c++ glibce glibc-common glibc-devel glibc-headers ksh libaio
libaio-devel libgcc libstdc++ libstdc++-devel make numactl-devel sysstat
libaio unixODBC unixODBC-devel

* For the 64-bit operating system:

rpm -g --gf '${NAME}-%{VERSION}-%{RELEASE} (%{ARCH})\n' binutils compat-db
compat-1ibf2c-34 elfutils-libelf elfutils-libelf-devel compat-libstdc++-33-
3.2.3 control-center gcc gcc-c++ glibce glibc-common glibc-devel glibc-
headers ksh libaio libaio-devel libgcc libstdc++ libstdc++-devel make
numactl-devel sysstat libaio unixODBC unixODBC-devel
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It is important to have these 64-bit RPMs installed. The above
command will list the architecture of each binary package. You

will see that some RPMs are installed twice when you run this
command (32-bit and 64-bit).

The command should result in the following list of required packages.

Red Hat Enterprise Linux 4

RHEL 4 x86 (32-bit)

RHEL 4 x86_64 (64-bit)

binutils-2.15.92.0.2
compat-libstdc++-33-3.2.3
elfutils-libelf-0.97
elfutils-libelf-devel-0.97
gce-3.4.6

gce-ct++-3.4.6
glibc-2.3.4-2.41
glibc-common-2.3.4
glibc-devel-2.3.4
glibc-headers-2.3.4
libaio-devel-0.3.105
libaio-0.3.105
libgcc-3.4.6
libstdc++-3.4.6
libstdc++-devel-3.4.6
make-3.80
numactl-0.6.4.1386
pdksh-5.2.14
sysstat-5.0.5
unixODBC-2.2.11
unixODBC-devel-2.2.11

binutils-2.15.92.0.2
compat-libstdc++-33-3.2.3
compat-libstdc++-33-3.2.3 (32 bit)
elfutils-libelf-0.97
elfutils-libelf-devel-0.97
expat-1.95.7

gce-3.4.6

gce-c++-3.4.6
glibc-2.3.4-2.41
glibc-2.3.4-2.41 (32 bit)
glibc-common-2.3.4
glibc-devel-2.3.4
glibc-headers-2.3.4
libaio-0.3.105
libaio-0.3.105 (32 bit)
libaio-devel-0.3.105
libaio-devel-0.3.105 (32 bit)
libgcc-3.4.6

libgcc-3.4.6 (32-bit)
libstdc++-3.4.6
libstde++-3.4.6 (32 bit)
libstdc++-devel 3.4.6
make-3.80
numactl-0.6.4.x86_64
pdksh-5.2.14

sysstat-5.0.5
unixODBC-2.2.11
unixODBC-2.2.11 (32 bit)
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RHEL 4 x86 (32-bit)

RHEL 4 x86_64 (64-bit)

unixODBC-devel-2.2.11
unixODBC-devel-2.2.11 (32 bit)

Red Hat Enterprise Linux 5.

RHEL 5 x86 (32-bit)

RHEL 5 x86_64 (64-bit)

binutils-2.17.50.0.6
compat-libstdc++-33-3.2.3
elfutils-libelf-0.125
elfutils-libelf-devel-0.125
elfutils-libelf-devel-static-0.125
gee-4.1.2

gee-ct+-4.1.2
glibc-2.5-24
glibc-common-2.5
glibc-devel-2.5
glibc-headers-2.5
kernel-headers-2.6.18
ksh-20060214
libaio-0.3.106
libaio-devel-0.3.106
libgce-4.1.2
libgomp-4.1.2
libstdc++-4.1.2
libstdc++-devel-4.1.2
make-3.81
numactl-devel-0.9.8.i1386
sysstat-7.0.2
unixODBC-2.2.11
unixODBC-devel-2.2.11

binutils-2.17.50.0.6

compat-libf2c-34-3.4.6-4 (RHEL version
5.6)

compat-libf2¢-34-3.4.6-4.1.i386 (RHEL
version 5.7)

compat-libstdc++-33-3.2.3
compat-libstdc++-33-3.2.3 (32-bit)
elfutils-libelf-0.125
elfutils-libelf-devel-0.125

elfutils-libelf-devel-0.137 (RHEL version
5.6 0r5.7)

gee-4.1.2

gee-ct+-4.1.2

glibc-2.5-24

glibc-2.5-24 (32-bit)
glibc-common-2.5
glibc-devel-2.5
glibc-devel-2.5 (32-bit)
glibc-headers-2.5
ksh-20060214
libaio-0.3.106
libaio-0.3.106 (32-bit)
libaio-devel-0.3.106
libaio-devel-0.3.106 (32-bit)
libgee-4.1.2

libgcc-4.1.2 (32-bit)
libstdc++-4.1.2
libstde++-4.1.2 (32-bit)
libstdc++-devel 4.1.2
make-3.81
numactl-devel-0.9.8.x86 64
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RHEL 5 x86 (32-bit) RHEL 5 x86_64 (64-bit)

sysstat-7.0.2

unixODBC-2.2.11
unixODBC-2.2.11 (32-bit)
unixODBC-devel-2.2.11
unixODBC-devel-2.2.11 (32-bit)

Install Oracle on the Client

Use this procedure to install the Oracle software on the client.

1. Log on as a local or network user.

Root User

Later in this procedure, the root user is required to run one or more scripts.

2.  Download the Oracle software from the Landmark® Software
Manager (https://esd.halliburton.com/download/download.jsp) to
a directory on the system where there is sufficient space for the Zip
file. The file will be one of the following:

Operating System Oracle software
32-bit Oracle 112020 Linux32_Client.zip
64-bit Oracle 112020 Linux64 Client.zip

3. Inthe location where the file was downloaded, extract the contents
of the file to a directory.

Sufficient Space for the Files and Installer

Be sure to extract the file on a drive with plenty of space. Without
sufficient space the installation will fail. The Zip file itself is large (over
580 MB), and the unzipped files are larger still.

* For the Linux 32-bit file:

unzip ./Oracle_112020_Linux32_Client.zip
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* For the Linux x86 64-bit file:

unzip ./Oracle_112020_Linux64_Client.zip
4. Run the installer command:

./database/runInstaller
5. Inthe Select Installation Type screen
+ Select Administrator.
* Click Next.
6. Enter the path for the ORACLE_HOME environment variable.
7. In the Specify Inventory directory and credentials screen

* Enter the inventory directory and group name or accept the
defaults.

* Click Next.

8.  Enter the path for the ORACLE_BASE environment variable.
9. In the Product-Specific Prerequisite Checks screen

* Verify that the overall result of the check is Passed.

» Ifany of the tests fail, exit the installation, set the
recommended value of the parameter mentioned on the host,
and run the installation program again.

* Click Next.

10. In the Summary screen
* Verify that all settings are correct.

*  Click Install.

11. Follow the instructions in the Execute Configuration scripts
window to execute the two scripts, orainstRoot.sh and root.sh.

* Open a terminal window on the same host machine.
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* Logon as root.
» Execute the orainstRoot.sh and root.sh scripts.

12. Click OK in the Execute Configuration scripts window only after
successfully executing orainstRoot.sh and root.sh scripts.

13. In the End of Installation screen click Exit.

14. In the Exit window, click Yes. The installation program closes.

Fix Directory Permission Problem

Execute the following command as the Oracle user:
chmod -R 775 $ORACLE_HOME

You will get error messages that it is not possible to alter the
permissions on certain files in SORACLE HOME. These errors can be
ignored. The ownership of these files was changed to root when you
ran the root.sh configuration script earlier in the installation procedure.
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Windows: Oracle Database Upgrade

This procedure upgrades an existing Oracle 10g (10.2.0.5) database to
Oracle 11g (11.2.0.2).

To upgrade an existing Oracle 10g database to Oracle 11g, do the
following:

*  “Perform Prerequisites” on page 125
*  “Install Oracle 11g in Windows” on page 125
*  “Run the Database Administration Tool in Windows” on page 127

*  “Update Oracle Environment” on page 131

Perform Prerequisites
Do the following before upgrading the Oracle software.
1. Create a cold backup of the database.
2. Start Oracle 10.2.0.5 database instance.

3. Start the Oracle 10.2.0.5 listener.

Install Oracle 11g in Windows

1. Log on as the user created for the Oracle installation. Even though
the Oracle user must have administrator privileges, do not install
as Administrator or using your personal account.

2. Download the software appropriate for your operating system
from the Landmark® Software Manager (https://
esd.halliburton.com/download/download.jsp).

OWDBSetup Win_with_Oracle.zip
3. Extract the ZIP file.

4. Run the installation executable (OWDB_5000_8_1.exe). The
OpenWorks Database 5000.8.1.0 dialog displays.
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5.

Click Next. The Select The Type Of Install pane displays in the
dialog.

In the Select Type Of Install pane:

+ Select Install Oracle media only to support recovery or
upgrade.

* Click Next. The Memory Check For Oracle pane displays.

In Windows, the amount of virtual memory should be twice the
amount of physical memory (RAM) in the computer.

In the Memory Check For Oracle pane:

» If the amount of virtual memory is incorrect.
— Click Cancel to end the installation.
— Adjust the amount of virtual memory.
— Restart this installation procedure.

+ If the amount of virtual memory is correct, click Next. The
Choose Install Folder pane displays.

In the Choose Install Folder pane:

* Enter the directory where you want to install the files of the
OpenWorks® database instance.

* Click Next. The Get Oracle Information pane displays.
In the Get Oracle Information pane:

* In Oracle Base, enter a path for the Oracle base directory. For
example:

c:\oracle\product

* In Oracle Home, enter the path for Oracle software. For
example:

c:\oracle\product\1l1l.2.0\dbhome_1

* Click Next. The Pre-Installation Summary pane displays.
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10. In the Pre-installation Summary pane:

» Verify that all settings are correct. If necessary, click Previous
and correct settings.

* Click Install if all settings are correct. The Installing landmark
OpenWorks Database pane displays.

After the database is installed, the SQLNET.ORA dialog box
displays.The file, sqlnet.ora, is modified to include
configurations for the Oracle wallet. A backup is made of the
file and saved in the same directory. The file is located in:

OracleHome\network\admin\sglnet.ora

* Click OK in the SQLNET.ORA dialog. The Install Complete
pane displays.

A log (Landmark OpenWorks Database InstallLog.log) for the
installation is stored in the same directory as the location selected
for the database in the Choose Install Folder pane.

11. Click Done.

If there are any errors, additional windows will appear describing
the errors.

Acceptable Oracle error messages

Some Oracle errors are acceptable; e.g., errors that occur because of the
drop user statements and IMP_FULL DATABASE,
EXP_FULL _DATABASE role conflicts.

Run the Database Administration Tool in Windows

This procedure uses the Database Administration tool of the
OpenWorks software to upgrade the database instance from Oracle 10g
to 11g.

Do the following to upgrade the database instance:

1.  Open a Command Prompt window as Administrator.

* In the Start Menu, right-click the Command Prompt icon
(cmd.exe) to display a shortcut menu.
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* Select Run As Administrator. An Administrator: Command
Prompt window displays.

2. Start Database Administration by executing the
OWRuntimeLauncher.sh script with the DbAdmin parameter.
For example:
SOWHOME% \bin\OWRuntimeLauncher.bat DbAdmin
The Database Administration window displays.
3. Select Database > Upgrade. The Upgrade Wizard dialog opens.
The default log directory is the user’s home directory.
4. Click Next. The Options pane displays.
5. In the Options pane, do the following:
* In Oracle Instance, specify the name of the system identifier
(SID) of the OpenWorks database instance. This value is filled
in with the setting of the ORACLE_HOME environment

variable in environment of the Oracle user.

* In Oracle 10 Home, specify the path for Oracle home. for
example:

c:\oracle\OraHomel

* In Oracle 11 Home, specify the path for Oracle home. for
example:

c:\oracle\product\1l1l.2.0\dbhome_1

* In Log Directory, if you want the log files in a location other
than the default (the home directory of the Oracle user),
specify a path.

* Click Next. The Move Files pane displays.

The Move Files pane contains a table with a column for paths
to data files in the Oracle 10g database, and with a column
listing a set of file names of the data files in a directory. A
directory can have one or more data files.
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6. Inthe Move Files pane, do the following:

Select one or more locations of data files. During the selection,
hold down the Shift key to select contiguous locations, or hold
down the Ctrl key to select discontiguous locations.

Click Change New Directory Locations. An Open dialog
displays, allowing you to select a destination location for the
files in the Oracle 11g environment.

Select the directory for the data files.
Click Open.

Repeat the steps on this pane until you have selected a new
destination for all the data files in the Oracle 10g environment.

After all the Oracle 10g data files have a destination in the
Oracle 11g environment, click Next. The Parameters pane
displays.

7. In the Parameters pane, use the following guidelines:

Database Mode: ArchiveLog mode archives redo logs before
they are overwritten. This mode allows the database to be
backed up while the database is in an inconsistent state (or
while the database is being accessed by users). NoArchiveLog
mode allows redo logs for the database instance to be
overwritten without archiving the old redo logs.

NoArchiveLog Mode: Backups Require Database
Shutdown

With NoArchiveLog mode, a backup can only be performed when
the database is in a consistent state.

For an Oracle database to be in a consistent state, it must be
shutdown with the normal, immediate, or transactional parameter,
and the restarted database must be backed up in a mode (such as the
Mount mode), where the database is closed to access, except for
certain database administrator (DBA) activities.

Schedule Database Backup: If ArchiveLog is selected, the
database will perform an automatic backup. If NoArchiveLog
1s selected, select Yes to allow the database to make automatic
backups, or select No otherwise.
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WARNING:As described for NoArchiveLog in Database Mode,
the database must shutdown before the backup begins. Any
connections to the database at the time of the shutdown will be
disconnected.

* Backup Time (= ): Click the Backup Time button to display
the Select Backup Time dialog and to set the time for
automatic backups.

*  Number Of Days To Keep Backups: Specify the number of
days to keep database backups. The default is two.

* Recovery Area Directory( = ): Specify the location for
recovery files (control files, redo logs, archived redo logs,
flashback logs, and RMAN backups). The location can be a
system directory or network location.

* Recovery Area Maximum Size: Specify the maximum size
(or disk quota) of the recovery file area in units of gigabytes.

The amount of space can vary depending on the amount of data
in the database instance, the size of data blocks, the number of
changes to the data, the number of days in the retention policy
for backups and archive logs, and other configurations of the
database.

Ideally, the area should be able to contain all data files in the
database and all current backup files.

*  Memory Target: Specify a minimum amount of memory in
units of megabytes for the database instance to use. This value
helps determine how much memory the instance will use and
enables automatic memory management by the database. The
database can increase it up to the maximum memory target.
The amount should be more than 1024 MB (or 1 GB), but
equal to or less than the maximum memory target.

*  Maximum Memory Target: Specify the maximum amount in
units of megabytes that the database instance can use on the
system. The amount should be more than 1024 MB (or 1 GB).

8.  Click Finish. The Upgrade Wizard window closes, and the
upgrade messages are displayed in the Upgrade Databaselnstance
tab in the Database Administration window.
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The upgrade may take a long time, depending on the amount of
data in the database instance. When finished, the wizard displays:

The upgrade is successfully completed.

Update Oracle Environment

After the installation of Oracle 11g and upgrading the existing
database, you must update OwW_LMSYS_DB_DIR. To update it, do the
following:

1. Reboot the machine.

2. Make sure the database and listener comes up correctly and are
accessible.

To check, open the Computer Management control panel, and in
the Services pane, the following should be true:

* Oracle 10 Listener Startup Type: Manual
* Oracle 11 Listener Status: Automatic

*  PATH Environment Variable: Verify that the bin directory
for Oracle 11g is before Oracle 10g.

* OracleServiceSIDName Status: Automatic

If the Oracle service does not automatically start when Windows is
restarted, do the following:

*  Open a Command Prompt window with Administrator
privileges. For example:

— In Windows 7, enter cmd in the Search box in the Start
Menu, and then instead of pressing Enter, press Ctrl +
Shift + Enter.

— In Windows XP, right-click the Command Prompt item in
the Start Menu to display a shortcut menu, and then select
the Run As item in the shortcut menu.
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Use the Oradim tool from Oracle to delete the service. For
example:

oradim -delete -sid SIDName
Make sure the service does not exist. For example:

— Right-click Computer to display a shortcut menu, and
select Manage to display the Computer Management
window.

— In Services And Applications > Services, the name,
OracleServiceSIDName, should not be in the list on
the right.

Create a new service configured with the automatic start mode.
For example

oradim -new -sid SIDName -startmode auto

In the Computer Management window, the service,
OracleServiceSIDName, should be listed, and its startup
type should be Automatic, not Manual or Disabled.
The service should restart automatically when the system
restarts.

Reboot the machine to make sure the service (the database)
restarts.
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Windows: Upgrade Oracle Client

For client installations of the OpenWorks® software, you must also
install version 11g of the Oracle Client in a new directory from the
installation directory for the 10g client.

Install Oracle Software on the Client Machine

1. Log on to the client machine as a user with administrator
privileges. Do not install as Administrator.

2. Download the Oracle software appropriate for your operating
system from the Landmark® Software Manager (https://
esd.halliburton.com/download/download.jsp). Refer to the table

below.
Operating System Oracle Client Software
11.2.0.2.0
Windows XP 32-bit Oracle 112020 Win32 Client.zip
Windows Server 2003 32-bit
Windows XP 64-bit Oracle 112020 Win64 Client.zip

Windows Server 2003 64-bit
Windows Vista 64-bit
Windows Server 2008 64-bit
Windows 7 64-bit

3. Extract the ZIP file to a local directory.

4. Run the installation program by starting setup.exe from the
directory to which you extracted the Oracle software. The Oracle
Client Installer dialog displays with the Select Installation Type
pane.

5. Inthe Select Installation Type pane

* Ifyou plan on installing the OpenWorks® Full software on the
server, select Administrator.

* Ifyou plan on installing the OpenWorks® Basic software,
choose either Administrator or Runtime, depending on
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10.

whether you will use the Discovery™ software from
GeoGraphix® (see below).

Installation type and OpenWorks® Basic

For the OpenWorkse Basic software, the Oracle client can be installed
with the Runtime or Administrator installation type. If the OpenWorks®
software will be used with the Discovery™ software from GeoGraphixe,
the Oracle client can be installed with Administrator or Custom installation
type. If the Custom installation type is chosen, you must select the
following components among other components you may choose: Oracle
Database Utilities, Oracle JDBC/Thin Interfaces, Oracle New, and
SQL*Plus

The file sqlnet.ora should contain the following lines:

WALLET_LOCATION=
(SOURCE=
(METHOD=FILE)
(METHOD_DATA=
(DIRECTORY=%0W_HOME_DIR%\wallet)
)
)
SQLNET.WALLET_OVERRIDE= TRUE
If you are installing with the Custom option, consult a certified Oracle
Database Administrator for more information about other Oracle
components your installation may require.

Click Next. The Download Software Updates pane displays.
Select Skip Software Updates.

Click Next. The Select Product Languages pane displays.
The default selected language should be English.

Click Next. The Specify Installation Location pane displays.
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11. In Oracle Base, enter a path for the Oracle base directory. For
example:

c:\oracle\product

12. In Software Location, enter the path for Oracle 11g installation.
For example:

c:\oracle\product\1l1l.2.0\client_1

13. Click Next. The Prerequisite Checks pane displays and then the
Summary pane if all the prerequisites are correct.

» If the check did not pass, correct the problems and restart the
installation program.

14. In the Summary pane
» Verify that all settings are correct.
* Click Install.

15. In the Finish pane, click OK.

16. Update tnsnames.ora with the information for the databases you
will use.

If the TNS_ADMIN variable is not set in the environment, the default
location of the file is % ORACLE HOME%\network\admin.

17. If needed, update sqlnet.ora as described in the note for the step
about the Select Installation Type pane.
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Oracle 11g Compatibility with Some Applications

Some older Landmark applications are built specifically for Oracle 10g
(for example, the GeoProbew® software), and when the OpenWorks
software and database are upgraded to version 11g of the Oracle
software, these applications may not run. To enable those applications
to run with the newer version of the database software, a couple of
configuration changes of their environment must be made.

e Setthe OW_ORACLE_VERSION Variable

* Link to Oracle 11g Libraries

Set the ow _ORACLE VERSION Variable

The OW_ORACLE_VERSION variable must be set in Igcenv.cf to the
value of 11g. The file is located in the OpenWorksHome /conf
directory. This variable must be set in Linux and Windows, whereever
the OpenWorks software is installed.

When the OpenWorks software is installed, and if during the
installation, the current version of the database software is 11g, the
installation program will configure lgcenv.cf correctly. However, if for
example, the OpenWorks software was upgraded to version 5000.8.1.0,
but the database software was upgraded to version 11g after the
upgrade of the OpenWorks software, this variable would not have been
changed, and it must be manually changed.

The variable has the following context in lgcenv.cf.

Use the following parameter to use the correct jdbc
jar file for OpenWorks
three vValid Values:
11lg -- Use jdbc from Oracle 1llg
10g -- Use jdbc from Oracle 10g
___OW_ORACLE_VERSION_ Is_Not_Set_Yet  -- defaults
to jdbc from Oracle 10g

HH H FH H H H H H HF

OW_ORACLE_VERSION __ OW_ORACLE_VERSION_Is_Not_Set_Yet_
#
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To set the variable manually, so that the OpenWorks software and other
Landmark software uses Oracle 11g, the file should be edited so that
the variable is set to the value of 11g. For example:

OW_ORACLE_VERSION 1llg

If the variable is set to any other value, version 10g of the Oracle
software is assumed to be the installed version.

Link to Oracle 11g Libraries

In Linux, symbolic links need to be made in the library directories of
the Oracle client. The links should have the name of 1ibnnz10.so,
and they should link to the similar 11g library, 1ibnnz11.so.

When the OpenWorks software is installed, and if during the
installation, the current version of the database software is 11g, the
installation program will try to configure the links. However,
sometimes because of permissions issues, the installation program may
not be able to make the links. If such issues occur, the installation
program will warn you of the problem and ask you to run a script,
CreateOracleLinks.sh. This script must be run as the root user or as a
user with access to the Oracle 11g database.

Also, if for example, the OpenWorks software was upgraded to
version 5000.8.1.0, but the database software was upgraded to
version 11g after the upgrade of the OpenWorks software, the links

must be created manually.

As the root user, execute the following command to create the links:

sh $SOWHOME/bin/CreateOracleLinks.sh
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Upgrade OpenWorks-. R2003.12
Database

This section describes how to upgrade an OpenWorks® database
(R2003.12) residing in an Oracle version 8.1.7.4 or Oracle 9.2.0.4
instance to an OpenWorks® database (Release 5000.x.x.x) in an
Oracle 10g 10.2.0.5 instance.

After you upgrade the database, you need to install the new version of
OpenWorks® in a different location from the existing version. There is
no OpenWorks® software upgrade from R2003 to version 5000.x.x.x.

This section also outlines changes to the OpenWorks® environment

(password changes, district configurations, and the location of system,
project, and data files external to the database) with version 5000.x.x.x

Database Differences and Assumptions

This section provides some basic information you should know before
you begin upgrading and migrating your data to a new OpenWorks®
database instance of Release 5000.x.x.x.

Differences in the Oracle Databases

The major differences in the Oracle databases between the
OpenWorks® software R2003 and Release 5000.x.x.x are:

*  The OpenWorks® software R2003.12 uses Oracle 8.1.7.4 or
Oracle 9.2.0.4. The OpenWorks® software version 5000.x.x.x uses
Oracle 10g Release 2 (10.2.0.5) or Oracle 11g
Release 2 (11.2.0.2).

*  The projects in the OpenWorks® software R2003.12 use
dictionary-managed tablespaces. Starting with the OpenWorks®
software version 5000.0, projects use locally managed tablespaces.
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The OpenWorks® software R2003.12 uses externally identified
Oracle users. The OpenWorks® software version 5000.x.x.x uses
internally identified Oracle users.

Assumptions for Upgrading

Verify that the following conditions are met:

1.

The installed software and database instance of the OpenWorks®
software R2003.12 exist.

The installed software of the OpenWorks® software version
5000.0.0.2, or above, exists.

The OWSYSSID (for example, ow2003) of the R2003.12 instance
has been added to tnsnames.ora (located in SORACLE HOME/
network/admin) on the machine where the installed software of the
OpenWorks® software version 5000.0.0.2, or above, is installed.

A database connection to the OWSYSSID of the R2003.12
instance can be made from the installed software of the
OpenWorks® software version 5000.0.0.2, or above, using
SQL*Plus.

The Oracle server, where version 5000.x.x.x of the OpenWorks®
database is located, is on the same machine as the installation of
version 5000.x.x.x of the OpenWorks® software.
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Pre-Migration Steps

Before performing an upgrade:

Perform a full backup of the data in the R2003.12 OpenWorks®
database. This step is a safety measure.

Install a database server for the OpenWorks® software version
5000.x.x.x. For more information, see either the procedure for
Windows (in the ““Windows Server Installation Tasks” on
page 13” section) or the procedure for Linux (in the ““Linux
Server Installation Tasks” on page 44” section).

In tnsnames.ora of the Oracle installation for the OpenWorks®
software version 5000.x.x.x, include the connection information
for the OpenWorks® database (OWSYSSID) of R2003.12.

Using SQL*Plus on the system where version 5000.x.x.x, test the
connect to the R2003.12 database.
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Upgrading to Version 5000.x.x.x

Because the OpenWorks® database in R2003.12.x.x used Oracle 8i or
9i as its data management system an existing R2003.12.x.x cannot be
upgraded in place. In it most basic terms, the data in a database for
R2003.12.x.x must be exported from that database and imported into an
OpenWorks® database of version 5000.0.0.2, or above. The procedures
below delineate that procedure.

Preparing the R2003.12 Database for Export

To prepare the data for exporting from an R2003 database, you must
remove any remote projects and generate a database schema
configuration files for the R2003.12 database. The steps below will
help you in those tasks.

These steps should be performed in the environment of version
5000.0.0.2, or above, of the OpenWorks® software.

1. Check for remote projects.

*  Run the check remote projects.sql script (located in $OWHOME /
dat/project5000.0) as the database user (for example,
system) of the R2003.12 database to determine if there are any
remote projects on the database.

cd SOWHOME/dat/project5000.0
sqglplus system/Password@OW DB _SID
SQL>@check_remote_projects.sqgl "OW DB SID"

»  If'there are no remote projects on the ow2003 instance, go to step
2. Otherwise, perform the following step to handle the remote
projects before proceeding to step 2.

» If there are remote projects, the result will look similar to the
following. Perform the steps shown in the results.

Project FLOUNDER is a remote project on sid LATEST

Project GOM is a remote project on sid
OWSID.COMPANY.COM

In R5000, the remote project functionality is no
longer supported.
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Please go back to the R2003.12 instance and use
Project Admin to backup the remote projects, delete
them from ow2003 instance and restore them in the
R5000 instance.

If you have further questions, please contact
Landmark Customer Support.

2. Generate a schema definition file for the existing OpenWorks®
R2003.12 database.

Run the SOWHOME/dat/project5000.0/
process_ow2003_tablespaces.sqgl scriptasthe
database user (e.g., system) against the R2003.12 OWSYSSID
ow?2003 to generate an OpenWorks® R2003.12 schema definition
(tablespaces and users) SQL file called ow2003 _tablespace.sql.

cd SOWHOME/dat/ project5000.0
sglplus system/Password@ow2003
SQL>@ process_ow2003_tablespaces.sqgl /DirPath/ow2003_tablespaces.sqgl

The result will look similar to the following:

create tablespace FLOUNDER datafile '/d0l/ora9i/OraHomel/owprojects/
FLOUNDER02090191891A.dbs' size 200M autoextend on extent management local;

create user FLOUNDER identified by values 'DDC631FBD8763204' default tablespace
FLOUNDER temporary tablespace TEMP;

grant create session, connect to FLOUNDER;

3. Runthe $SOWHOME/dat/project5000.0/
process_ow2003_users.sqgl script as the database user
(e.g., system) against the R2003.12 OWSYSSID ow2003 to grant
roles to the OpenWorks® project users. The script generates an
SQL file called ow2003 users.sql.

For example, continuing the SQL session in Step 2:
SQL>@process_ow2003_users.sqgl /DirPath/ow2003_users.sqgl
-or-
Starting a new SQL session:

cd SOWHOME/dat/project5000.0
sglplus system/Password@ow2003
SQL>@process_ow2003_users.sqgl /DirPath/ow2003_users.sqgl
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alter
alter
grant
grant
grant

The result will look similar to the following:

user owjune identified by owjune;

user owtest identified by owtest;

MANAGE_EMPTY to OWJUNE;

L_INTERP_FLOUNDER to OWJUNE;

OW_ADMINISTRATOR to OWJUNE;

insert into owsys.ow_sys_user (user_id) values ('OWJUNE') ;
insert into owsys.ow_sys_user (user_id) values ('OWTEST') ;

commit;

4,

Copy SOWHOME/dat/project5000.0/
fullexport.cntl from the OpenWorks® 5000.0.0
installation to the R2003.12 image.

Exporting the Database from OpenWorks® R2003.12

Perform the following steps as an Oracle database user (such as the
SYSTEM user) in the environment of Release 2003.12 of the
OpenWorks® 2003.12 software.

1.

Run a full Oracle database export as the database user (e.g.,
system) against the R2003.12 OWSYSSID ow2003. Modify the
settings of the following variables in the fullexport.cntl
configuration file that was copied in the preceding procedure.

BUFFER=2000000
USERID="system/PasswordeOW DB _SID"
FILE=/FullPath/FileNameOfExportFile . dmp
FULL=Y

LOG=/FullPath/ FileNameOfLogFile . Log

Where:

Password is the password of the system user.

OW _DB_SID is the OWSYSSID of the database.

FullPath is the full path to the location of the dmp and log files.

FileNameOfExportFile is the name of the export file. This file
must have a dmp extension (or file suftix).

FileNameOfLogFile is the name of the log file. This file name
must have a log extension (or file suffix).
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2. Execute the export command.

Match Oracle export utility to Oracle server version

It is very important to use the matching Oracle export utility to the correct
version of Oracle server. You must use an Oracle 8 export utility for an
Oracle 8 server and use an Oracle 9 export utility for an Oracle 9 server.

* For an Oracle 8 server:

su - oracle8
SORACLE_HOME/bin/exp parfile = fullexport.cntl

Ensure this is the Oracle § ORACLE _HOME.
* For an Oracle 9 server:

su - oracle9
SORACLE_HOME/bin/exp parfile = fullexport.cntl

Ensure this is the Oracle 9 ORACLE _HOME.

3. Copy the export file from the R2003.12 installation to the
installation of the OpenWorks® version 5000.x.x.x software.

Procedures in the OpenWorks® 5000.x.x.x Installation

Run the following steps in the OpenWorks® 5000.x.x.x installation.
1. Create the directory structure for the new data files.

The tablespace data file structure will be kept the same as your
OpenWorks® R2003.12 instance, make sure you pre-create these
data file directories in your ow5000 installation with oracle as the
directories' owner. If you want to change the data file structure,
edit the ow2003_tablespace.sql file and create the directories as
the Oracle user (e.g. oral0g), the directories' owner.
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2.

Rename sqlnet.ora if wallet is configured in the file.

If you have sqlnet.ora file similar to the following example in
$ORACLE_HOME/network/admin, rename it to sqlnet.ora_orig,
otherwise, skip this step.

NAMES.DIRECTORY_PATH= (TNSNAMES, EZCONNECT)
WALLET_LOCATION=
(SOURCE=
(METHOD=FILE)
(METHOD_DATA=
(DIRECTORY=% {OW_HOME_DIR} /wallet)
)

)
SQLNET .WALLET_ OVERRIDE= TRUE

Run the ow2003 _tablespace.sql script to create the tablespaces and
OpenWorks® project users in the OpenWorks® 5000.x.x.x instance
(ow5000).

sglplus system/Password@ow5000
SQL>@/DirPath/ow2003_tablespace.sql

For a list of possible errors, see “Possible Errors During the
Import” on page 152.

Run a full Oracle database import as the database user (e.g.,
system) using the ow2003.dmp file (created in Step 5.b.) in the
ow5000 instance. Modify the parameter values in the file based on
your configuration.

Note: The Oracle import process will change the system password
to match the password in the OW2003 database.

Assumption: You already copied ow2003.dmp from the
OpenWorks® R2003.12 installation to an OpenWorks® 5000.x.x.x

installation.

* su-oralOg
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* Modify SOWHOME/dat/project5000.0/
fullimport.cntl as follows:

BUFFER=2000000
USERID="system/Password@ow5000"
FILE=/DirPath/ow2003 .dmp
FULL=Y

IGNORE=Y
LOG=/DirPath/ow5000.1log

* Execute the following command:

imp parfile = fullimport.cntl
See “Possible Errors During the Import™ on page 152.
Rename sqlnet.ora orig back to sqlnet.ora.

If you do not have sqlnet.ora_orig in SORACLE HOME/network/
admin, create a sqlnet.ora file like this as Oracle user in the
$ORACLE_HOME/network/admin directory:

NAMES.DIRECTORY_PATH= (TNSNAMES, EZCONNECT)
WALLET_LOCATION=
(SOURCE=
(METHOD=FILE)
(METHOD_DATA=
(DIRECTORY=S$ {OW_HOME_DIR} /wallet)
)
)
SQLNET .WALLET_ OVERRIDE= TRUE

Upgrade the OpenWorks® schemas owsys and ow _admin_utils.

This step assumes that both the OpenWorks® database and the
OpenWorks® software are installed on the same machine.

* As the database user (e.g., system), create an internal account
for the Oracle user (e.g., oral0g) in the ow5000 database.

sglplus system/OW2003Password@ow5000
SQL> create user orallOg identified by oralOg;
SQL> grant connect, create session to orallg;

* As the Oracle user (e.g., oral0g), set the ORACLE_SID
environment variable. For example:

su - oralOg
setenv ORACLE_SID ow5000
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* Set the OWSYSSID variable (OpenWorks® database SID
name); in this example, ow5000:

setenv OWSYSSID ow5000.company.com

Here ow5000.company.com is the alias name in
$ORACLE HOME/network/admin/tnsnames.ora.

setenv OW_USER oralOg

setenv OW_PASSWORD oralOg

setenv OWHOME /dO0l/ow_nc

setenv ORACLE_HOME /dO0l/oralOg/OraHomel
setenv PATH ${OWHOME} /bin:${ORACLE_HOME}/
bin:${PATH}

setenv LM_LICENSE_FILE 2014@owlich

* Setthe LD LIBRARY PATH environment variable based on
the Oracle server:

For 32-bit Oracle:

setenv LD_LIBRARY_PATH ${ORACLE_HOME}/
1lib:${OWHOME}/1lib:${LD_LIBRARY_PATH}

For 64-bit Oracle:

setenv LD_LIBRARY_PATH ${ORACLE_HOME}/
1ib32:${OWHOME}/1lib:${LD_LIBRARY_PATH}

* Make sure an entry is made in SOWHOME /conf/
district.dat forthe SID (ow5000 in this example);
otherwise, you will receive a message: ERROR: No entry
found for SID_Name.

Oow5000 /d0l/owhome/conf "Ow5000" Ow5000

* Set the encrypted passwords for the OpenWorks® schemas
Imsys and ow_admin_utils.

Linux

In a terminal window, execute:
SOWHOME/bin/chglms DbaUserName DBAPassword TNS_ServiceNameForSID

Example

SOWHOME /bin/chglms system SystemPassword owlsid.company.com
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Windows

In a Command Prompt window, execute:
$OWHOME% \bin\chglms DbaUserName DbaPassword TNS_ServiceNameForSID
Example

$OWHOME% \bin\chglms system Password owwsid.company.com

* Run the following upgrade command as the Oracle owner
(oralOg):

SOWHOME /bin/owsysUpgradeR5000 OW_SID_Name DirForLogFile
For example:

SOWHOME /bin/owsysUpgradeR5000 ow5000 /d0l1/owjune/

7. If the tablespace data file structure in the ow2003 _tablespace.sql
file is NOT modified, skip this step and go to Step 8. Otherwise,
remove the invalid entries from the
LMSYS.OW_LMSYS DB DIR table as follows.

sglplus system/OW2003Password@ow5000

SQL> select dir_path from lmsys.OW_LMSYS_DB_DIR;
DIR_PATH

/d01/ora9i/OraHomel /owprojects/

Asssume the database data file is modified from
/d01/ora9i/OraHomel /owprojects to
/d01/oral0g/OraHomel/owprojects in ow2003_tablespace.sql.

SQL> delete from lmsys.OW_LMSYS_DB_DIR where dir_path='/d01/ora9i/OraHomel/
owprojects';

If the entry “/d01/oral0g/OraHomel/owprojects/” already
exists in the LMSYS.OW_LMSYS DB DIR table go to Step

8.
SQL>insert into lmsys.OW_LMSYS_DB_DIR values ('DATA', '/d0l/oralOg/OraHomel/
owprojects') ;
SQL>commit;

Use the SOWHOME/bin/dboradir script to maintain the
Oracle database locations.
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8. Runthe ow2003 users.sql script to create the OpenWorks® project
users and populate the project privileges for each OpenWorks®
project user.

SQL>@Dir/ow2003_users.sqgl

The result of ow2003_users.sql will look similar to the following:

create user owjune identified by owjune;
create user owtest identified by owtest;
grant MANAGE_EMPTY to OWJUNE;

grant L_TINTERP_FLOUNDER to OWJUNE;
grant OW_ADMINISTRATOR to OWJUNE;

insert into owsys.ow_sys_user (user_id) values ('OWJUNE') ;
insert into owsys.ow_sys_user (user_id) values ('OWTEST') ;
commit;

Optionally, to change the password for OpenWorks® project user
“owjune,” do the following:

sglplus system/OW2003Password@ow5000
SQL>alter user owjune identified by XXXXXX;

where "xxxxxx" is the new password for OpenWorks® user
“owjune.”

Exit SQL*Plus.

9.  As the Oracle owner (oral0g), run the owchglms.sql script to set
the default passwords for the Imsys and ow admin_utils users in
version 5000.x.x.x of the OpenWorks® database instance. For
example:

su - oralOg
salplus system/SystemPassword@ow5000
SQL>@S$ {ORACLE_BASE} /Landmark/OpenWorksDatabase/owdbsetup/owchglms.sqgl

10. Upgrade each OpenWorks® project using the OpenWorks®
ProjectAdmin or the command line.

You must have an Igcuser and an Oracle internal user first and the
usernames of lgcuser and the Oracle internal user must match.

* Create/update a user of the OpenWorks® database in the
Release 5000 environment that matches the owner of your
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projects in the 2003 environment that was created during the
ow2003 users.sql process, in this case OWJUNE.

— Ifyou already have an OpenWorks® R2003 Igcuser, do the
following:
su - root
OWHOME=0penWorksHomeDirectory
export OWHOME
cd ${OWHOME} /bin
./lgcuser
Select option 4 to update an existing user's profile
Select option 7 to quit

— To create a new lgcuser, do the following:
su - root
OWHOME=OpenWorksHomeDirectory
export OWHOME
cd ${OWHOME}/bin
./lgcuser
Select option 2 to create a new user account
Select option 7 to quit

*  Assign the OW_ADMINISTRATOR role to the Oracle internal
user:

— Login as lgcuser.

— Launch the OpenWorks® Command Menu:
S{OWHOME} /bin/startow.

—  From the OpenWorks® Command Menu, select Project >
Modify Database Users.

—  When prompted, enter the dba user and password; for
example, system and SystemPassword.

— Select the OW_ADMINISTRATOR option.
»  If the Oracle internal user does not have MANAGE role of the

project which will be upgraded, assign MANAGE_ Project Name
access to the Oracle internal user.

—  From the OpenWorks® Command Menu, select Project >
Project Admin.

— From the Project Administration dialog menu, select
ProjectAdmin > User > Project Access.
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— Select all the projects you wish to upgrade and click
Manage.

*  Upgrade the project from the GUI:

— From the OpenWorks® Command Menu, select Project >
Project Admin.

— In the Project Administration dialog, select the project you
want to upgrade to version 5000.x.x.x of the OpenWorks®
software.

— From the Project Administration dialog menu, select
Project > Project Database.

— Click Upgrade.
Or,

Upgrade the project in batch mode. Before upgrading an
OpenWorks® project in batch mode, set the OW_USER and
OW_PASSWORD environment variables.

» If there is no seismic project to upgrade, do the following:
SOWHOME /bin/projectUpgradeR5000 ProjectName OW_SysSID UserSpecifiedLogDir CreateDirFlag
» Ifthere is a seismic project to upgrade, do the following:

SOWHOME /bin/OWRuntimeLauncher.sh OwBatchUpgrade ALL

Possible Errors During the Import

1. Inthe Oracle 10g database, the UNDO tablespace will replace the
old Oracle 8.1.7 RBS tablespace, and a locally managed TEMP
tablespace will replace the old dictionary-managed tablespace
TEMP. If you encounter an error in this step like the examples
below, it can be safely ignored.

IMP-00017: following statement failed with ORACLE error 12913:
"CREATE TABLESPACE "RBS" DATAFILE '/pa/oracle/dbs_2/database/datafiles/fla"

"nders/rbsflanders.dbf' SIZE 209715200 DEFAULT STORAGE (INITIAL 2097152"
" NEXT 2097152 MINEXTENTS 10 MAXEXTENTS 505 PCTINCREASE 50) ONLINE PERMANENT"
"ORARY "

IMP-00003: ORACLE error 12913 encountered
ORA-12913: Cannot create dictionary managed tablespace
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IMP-00017: following statement failed with ORACLE error 12913:
"CREATE TABLESPACE "TEMP" DATAFILE '/pa/oracle/dbs_3/database/datafiles/fla"

"nders/tempflanders.dbf' SIZE 104857600 DEFAULT STORAGE (INITIAL 26214"
"4 NEXT 262144 MINEXTENTS 1 MAXEXTENTS 2147483645 PCTINCREASE 0) ONLINE TEMP"
"ORARY "

IMP-00003: ORACLE error 12913 encountered
ORA-12913: Cannot create dictionary managed tablespace

2. The GLOBAL NAME in R2003 does not match the
GLOBAL NAME in version 5000.x.x.x of the OpenWorks®
software. The following error can be safely ignored. For more
information on this Oracle error, contact Landmark® Support and
reference Solution Document 140760.

IMP-00017: following statement failed with ORACLE error 23327:
"BEGIN SYS.DBMS_DEFER_IMPORT_INTERNAL.QUEUE_IMPORT_CHECK('OW1l214P', 'SVR4-b"
"e-8.1.0'); END;"

IMP-00003: ORACLE error 23327 encountered

ORA-23327: imported deferred rpc data does not match GLOBAL NAME and platform
of importing db

ORA-06512: at "SYS.DBMS_SYS_ERROR", line 86

ORA-06512: at "SYS.DBMS_DEFER_IMPORT_INTERNAL", line 30

ORA-06512: at line 1

3. The following error can be safely ignored. For more information
on this Oracle error, contact Landmark® Support and reference
Solution Document 140676.

IMP-00019: row rejected due to ORACLE error 1

IMP-00003: ORACLE error 1 encountered

ORA-00001: unigque constraint (SYSTEM.HELP_TOPIC_SEQ) violated
Column 1 @

Column 2 1

Column 3

4. The following errors can be safely ignored. For more information
on this Oracle error, please contact Landmark® Support and
reference Solution Document 140677.

IMP-00017: following statement failed with ORACLE error 2264:
"ALTER TABLE "REPCATS_PRIORITY_GROUP" ADD CONSTRAINT
"REPCATS_PRIORITY_GROUP"
"_Cl" CHECK (data_type_id in (1, 2, 3, 4, 5, 6, 7)) ENABLE NOVALIDATE"
IMP-00003: ORACLE error 2264 encountered
ORA-02264: name already used by an existing constraint
IMP-00019: row rejected due to ORACLE error 1
IMP-00003: ORACLE error 1 encountered
ORA-00001: unigue constraint (SYSTEM.REPCATS_RESOL_METHOD_PK) violated
Column 1 1
Column 2 MINIMUM
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5. The following errors can be safely ignored. For more information
on this Oracle error, contact Landmark® Support and reference
Solution Document 140758.

IMP-00017: following statement failed with ORACLE error 2270:
"ALTER TABLE "DEFS$_CALLDEST" ADD CONSTRAINT "DEFS$_CALL_DESTINATION" FOREIGN
"KEY ("DBLINK") REFERENCES "DEFS$_ DESTINATION" ("DBLINK") ENABLE NOVALIDATE"
IMP-00003: ORACLE error 2270 encountered
ORA-02270: no matching unique or primary key for this column-list
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Password Changes and the Oracle Wallet

Prior to Release 5000, the OpenWorks® software stored passwords in
an encrypted file in the user’s home directory. The OpenWorks®
software now uses an Oracle utility called Oracle Secure Password
Store (Oracle wallet) for this purpose. The primary advantage of this
scheme is that the Oracle wallet is tightly integrated with Oracle itself.
Once a wallet is configured you can connect to any Oracle utility or
from any client program with a blank user name. The first time you run
an OpenWorks® program against an Oracle instance you will be
prompted for a password. The password will be stored in the wallet and
you will not be prompted again. There is also a Change Password
option on the Project Menu where users can change their own
password. This will store the new password in the wallet. This change
improves the security of the overall system.

On servers, the OpenWorks® Database Installation process configures
everything necessary for Oracle wallet. On clients, the OpenWorks®
Installation process configures everything necessary for Oracle wallet.

However, in non-standard installs or development environments, you
must be aware of the requirements of the Oracle wallet system.

Environment Changes

The OpenWorks® user must set the OW_HOME DIR environment
variable; for example:

OW_HOME DIR=C:\Landmark\OpenWorks\users\User_Name. This
is typically set to your home directory and it controls the location of the
wallet file. In a standard install it will be set in .1gclogin or by the
installation program on Windows. Make sure that the
OW_HOME DIR exists and does not contain any spaces in it.

Make sure the SORACLE HOME/network/admin/sqlnet.ora file
contains the text shown below. This new environment variable is
necessary because Oracle wallet will not work if there are spaces in the
directory path. If there are spaces in your home directory path choose
another location.

On Windows
WALLET_ LOCATION=

(SOURCE=
(METHOD=FILE)
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(METHOD_DATA=
(DIRECTORY=%0W_HOME_DIR%\wallet)
)

)
SQOLNET .WALLET_OVERRIDE= TRUE

On Linux

WALLET_LOCATION=
(SOURCE=
(METHOD=FILE)
(METHOD_DATA=
(DIRECTORY=S {OW_HOME_DIR} /wallet)
)

)
SQOLNET .WALLET_OVERRIDE= TRUE

Notes

*  The OW_USER and OW_PASSWORD environment settings are
obsolete.

*  Once cached in the wallet password will not expire. Password
prompts will not occur in batch applications. Once the password is
set it will not expire unless the underlying Oracle password
changes. However, to ensure that no GUI is set, then set the
environment variable OW_NO PASSWORD DIALOG=TRUE.

*  The cached password in encrypted format in a file created by the
OpenWorks® software on a client machine is obsolete.

»  Users are able to connect as “sqlplus /@sidname” Note: The
forward slash ( / ) means check that correct credential exists in
wallet) as well as “sqlplus usename/password@sidname”.

OpenWorks® Database Installation Program Configures Oracle Wallet

OW_HOME DIR must be set before running the OpenWorks®
database installation program. [f OW_HOME DIR is not set, the
following error dialog will open:
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Oracle Wallet Directory

@ OW_HOME_DIR environment variable is not defined

Setthe OW_HOME_DIR environment wariable to an existing
writeable directony (MUST MOT contain space in it) by the HBLZ72S
uzer.

Farexample: Create the cALandmaddOpeniodesuserssHBLITZ2S
directony. And, set the OW_HOME_DIR to
chlLandmamOpeniodshusarssHBLITZ2S in the System environment.

The OpenWorks® database installation program uses
OW_HOME DIR when creating an Oracle wallet for the Oracle owner
account. The installation program will also automatically configure
sqlnet.ora as described above. To enable Oracle wallet support, the
Oracle owner must have a wallet.

OpenWorks® Installation and sqlnet.ora on Client Machines

The OpenWorks® installation configures the wallet entry in the
sqlnet.ora file on client machines. If you change the location pointed to
by the TNSADMIN variable after the install you must ensure that a
valid sqlnet.ora is in the new location.

If you create a default district.dat during the install, the directory will
be _ Directory Is Not_Set_Yet  instead of $OWHOME/
conf (Windows: $OWHOME%\conf). This simplifies diagnosing a
problem with the district.dat.

If you leave the directory as SOWHOME/conf (Windows:
$OWHOMES \ conf), while it is a valid directory, it typically is not the
correct location for the dir.dat for seismic data. The default owdir.dat is
still created in SOWHOME/conf (Windows: $OWHOME$\conf).
This means that the flat file access of the OpenWorks® software will
not function correctly. Even if you are not using the Landmark®
seismic interpretation software, you must edit district.dat and set the
directories to the location of owdir.dat.

5000.8.1.0

Password Changes and the Oracle Wallet 157



OpenWorkse Software Installation Procedures Upgrade OpenWorks® R2003.12 Database

District Configuration

Districts allow a company to break up large lists of projects, and allow
the company to separate data by business unit for better data security or
disk ownership.

Support for districts has become a part of the framework of the
OpenWorks® software. In an installation of the OpenWorks® software,
a company can decide whether it will implement districts or not.

To implement districts, the district.dat configuration file must be
configured with the name of each district. The district.dat file also
contains the directory name for configuration files that define storage
locations for data not stored in the database. These configuration files
are dir.dat and owdir.dat, for seismic data files and other OpenWorks®
files, respectively. The default location for these configuration files is
SOWHOME/conf (Windows: $OWHOMES\conf).

Utilities, such as Project Administration and Project Status Tool,
support districts in their interfaces. For example, when a user of the
OpenWorks® software creates a new project in Project Administration,
part of the project configuration includes selecting the district to which
it will belong.

In a new OpenWorks® installation, when the district option “Create a
district.dat from TNSNAMES.ora” was selected, a valid district was
created for each SID. The file, district.dat, will have a default directory
defined for each of the SIDs that are defined in tnsnames.ora. You will
need to update these directories before running an application of the
OpenWorks® software.

If the OpenWorks® installation option “Create empty district.dat” was
selected, you must configure district.dat before you can run the
OpenWorks® software. The default location of district.dat is $SOWHOME /
conf (Windows: $OWHOMES%\conf). You can change the default
location by adding the environment variable OW_CONF_DIR to the
Jgclogin file. The default location of OW_CONF_DIR is SOWHOME/
conf (Windows: $OWHOMES%\conf).

SID Names in district.dat. Names of the OpenWorks® SIDs must be in all
capital letters in district.dat. See Project Management > Districts in the
OpenWorks® Online Help (OpenWorksHome /docs/
onlinehelp.htm) for detailed procedures to perform district
configuration tasks. If you are restoring an OpenWorks® project and its
SeisWorks® data from a version before Release 5000, it is especially
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important to refer to the topics in Project Management > Districts in the
OpenWorks® Online Help (OpenWorksHome /docs/
onlinehelp.htm) before proceeding.
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System, Project, and File Locations

OpenWorkse System File Locations

System files are files containing well and lithologic symbols and files
describing file formats for importing or exporting data.

System files are independent of projects and of districts. The location
of the following system directories do not change when changing a
district: OW_SYS DATA, owioformats, and owsymbols.

You can change the location of each of the directories by setting an
environment variable. The OW_SYS DATA directory is located by the
value in the OW_SYSDATA DIR environment variable. As a default,
this variable is set in Igcenv.cf located in $OWHOME% \ conf;
however, the variable can be set in a user’s initialization script or set
separately in the user’s environment. The environment variables for the
location of the format files (OWIOFORMATS environment variable)
and the well and lithologic symbols (OWSYMBOLDIR environment
variable) can be set in a user’s environment, too.

OpenWorks® Project File Locations

OpenWorks® project files are external files (not in the database) that
are project specific. These may be files created by certain OpenWorks®
applications or applications that use the OpenWorks® and seismic
development kits.

Should you need to change where these files are stored in the future,
you can edit the owdir.dat file. The location of owdir.dat is determined
by the district.dat configuration file. A district must have an owdir.dat,
and each district in an OpenWorks® instance can have a unique version
of owdir.dat. Before editing, make sure you locate the correct owdir.dat
that is associated with the district where your project is located.

Seismic Data File Locations (dir.dat Configuration File)

The dir.dat configuration file is an ACSII text file that lists the file
systems searched for seismic data stored as files. This file also
describes where applications create, or from where applications
retrieve, seismic data stored in files.
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Applications look for dir.dat based on the district.dat configuration file.
By default, district.dat is in $OWHOMES%\conf but the location can
be changed by setting the OW_CONF_DIR environment variable.

For Release 5000.x, the format of the dir.dat file has changed from
previous versions. If dir.dat has not been updated for Release 5000.x,
the software will recognize this and create a converted version of the
file in the program’s memory. However, it is recommended that you
update R2003 dir.dat files to the new format.

The dir.dat file is composed of one or more lines. The lines have the

format

Where

RootFileSystemPath filetypel filetype2...filetypen

RootFileSystemPath is a file system where seismic data files
are stored

filetypel...filetypen are one of the following zero or more
extensions of seismic data files or the attribute

“OTHER_FILES”

— Zero extensions: OpenWorks® applications will not create

files in a file system with no attributes; however, an
application can read or modify files in the file system,
depending on the permissions of the user running the
application.

Extensions: If the attribute is a seismic data file extension
(i.e., .3dv, .3dh, etc.), files with that extension can be
created in the file system. If the same extension is applied
to more than one file system, then new files with that
extension are created in the file system with the most
space.

OTHER_FILES: designates a file system where all types
of files, except those not explicitly enumerated as
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attributes for another file system, can be created, read, and
modified.

OTHER_FILES attribute required to write data

At least one file system in dir.dat must have the OTHER FILES
attribute for data not explicitly assigned to another filesystem to
be written.

You can also define variables within dir.dat, where each variable
represents a group of extensions.

Refer to the dir.dat topic in the OpenWorks® online help for a complete
discussion of the dir.dat configuration file.

Example dir.dat for Windows

An example dir.dat for Windows is shown below. On the left,
extensions attributes are explicitly stated for each file system. On the
right, variables have been defined for groups of file systems. Both

dir.dat entries indicate identical storage locations for the seismic data
files.

Example dir.dat with explicit extension attributes Example dir.dat with variables defined (# denotes
the variable definition)

D:\ua\ 3dv 3dh cd bri cmp OTHER FILES | # define 3d seismic 3dv 3dh cd bri cmp

D:\ub\ hzd hts #define 3d horizons hzd hts
D:\uc\ 3dv 3dh cd bri cmp D:\ua\ 3d seismic OTHER FILES
D:\ud\ 3dv 3dh cd bri cmp hzd hts D:\ub\ 3d horizons

D:\uc\ 3d seismic

D:\ud\ 3d seismic 3d horizons

The dir.dat files above indicate storage of 3d seismic data files in
directories \ua, \uc, and \ud. File systems for horizon data files are \ub,
and \ud. Storage for any other files is in file system \ua.

Example dir.dat for Linux

An example dir.dat for Linux is shown below. On the left, extensions
attributes are explicitly stated for each file system. On the right,
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variables have been defined for groups of file systems. Both dir.dat
indicate identical storage locations for the seismic data files.

Example dir.dat with explicit extension attributes | Example dir.dat with variables defined (# denotes
the variable definition)

/ua 3dv 3dh cd bri cmp OTHER FILES # define 3d seismic 3dv 3dh cd bri cmp
/ub hzd hts #define 3d horizons hzd hts

/uc 3dv 3dh cd bri cmp /ua 3d seismic OTHER FILES

/ud 3dv 3dh cd bri cmp hzd hts /ub 3d _horizons

/uc 3d seismic

/ud 3d_seismic 3d_horizons

The dir.dat files above indicate storage of 3d seismic data files in file
systems /ua, /uc, and /ud. File systems for horizon data files are /ub,
and /ud. Storage for any other files is in file system /ua.
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Appendix: Troubleshooting

This appendix has the following information:
*  “Adobe Reader and Linux” on page 166

+  “After Upgrading, My Application Stops Working” on page 171
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Adobe Reader and Linux

This section discusses alternate viewers for PDF files that are available
in Linux.

Linux: Other Readers

Red Hat Linux has a number of viewers for PDF files. In the Gnome
desktop, Linux has gv, ggv, and xpdf. In the K Desktop
Environment (KDE), Linux has kghostview. Each viewer is
available from the command line, and xpdf and kghostview are
available from the Gnome panel. For example, to start xpdf:

Main Menu > Programs > Graphics > xpdf
To start kghostview:

Main Menu > Programs > KDE menus > Graphics > PS/PDF
Viewer

These viewers usually display PDF files adequately, but they do not
have all of the features of Adobe Reader and are not recommended
with applications from Landmark® software applications. Among
many differences, these viewers do not have a bookmark pane, or if a
viewer does have a bookmark pane, the viewer does not recognize the
named bookmarks, which allow the bookmark pane to act as a table of
contents to the document.

Linux: Opening PDF Files in the Nautilus File Manager

The Adobe installation program installs the Adobe Reader files so that
you can run Adobe Reader from the command line (for example, /
usr/local/AdobeReader/bin/acroread ). The Gnome
desktop provides more than a terminal window and a command line to
start a program and open a file. A Nautilus window allows you to
double-click on a file and open it.

To be able to double-click a PDF file and open it with Adobe Reader,
do the following:

1. Select Main Menu > Programs > Settings > File Types and
Programs in the Gnome Panel. The File Types And Programs
dialog opens.
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10.

In the list box, select the line with PDF document in the
Description column.

Click Edit List. The Edit Application List dialog opens.

Click Add Application in the Add Application List dialog. The
Edit Application dialog opens.

In the Add Application dialog, do the following:

* In Application Name, enter a name for the application. For
example:

Adobe Reader 7

* In Application Command, enter the path name for
acroread . Assuming a location of Adobe Reader,
/usr/local/AdobeReader ,you would enter:

/usr/local/AdobeReader/bin/acroread

* Check both check boxes: Can Open Multiple Files, and Can
Open From URI.

Click OK in the Add Application and the Edit Application List
dialogs.

In the Default Action group box of the Files Types And Programs
dialog, select the Open With Application radio button.

Also in the Default Action box, click the Arrows button to display
a list of names of applications, and select the name you entered in
the Application Name text box in Step 5.

Click OK in the File Types And Programs dialog.
In Red Hat Enterprise Linux 5.0, set the LANG environment
variable to C in your shell initialization file. For example, in the

Bash shell, you would include the following line in the file:

LANG=C
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Linux: Running Adobe Reader from the Gnome Panel

If you want to run Adobe Reader before attempting to open a PDF file,
you can run acroread from the command line, or you can insert it in the
menu in the Gnome panel.

To insert an Adobe Reader item in the menu of the Gnome panel, do the
following:

1. In aterminal window, log in as Super User

su - (su followed by a dash)

Password:
2. Enter gmenu to open the GNOME Menu Editor window.

3. Inthe tree in the left list box, choose the name of a menu (branch)
from which you want to be able to start Adobe Reader. For
instance, you might choose the menus: Programs (System Menus),
and then the Applications submenu.

4. Select File >New Item. A untitled item (leaf) appears at the
bottom of the list of items for the menu, and default tabs appear on
the right.

5. In the Basic tab, do the following:

* In Name, enter a name for Adobe Reader. For example:
Adobe Reader 7

* In Comment, you may enter information about the item, but a
comment is not required. The comment appears in a pop-up
when the menu is displayed, and your mouse cursor hovers

over the item.

* In Command, enter the full path name for acroread . For
example:

/usr/local/AdobeReader/bin/acroread &

* In Type, select Application.
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» If you want to associate an icon with Adobe Reader, do the
following:

—Click the Icon button to open the Choose An Icon dialog.

—Browse for an icon file. For example, an icon file for Adobe Reader
(acroread.png ) is located in the following directory:

/usr/share/icons/hicolor/32x32/apps
—~Click OK in the Choose An Icon dialog.

* Uncheck Run In Terminal.

6. Click the Save button under the Basic tab.

7. If you want the new item somewhere else in the menu, you can
drag and drop the item to a new location, or you can use the Move
Up and Move Down tool bar buttons to move the selected item to a
new location in the menu.

8. In Red Hat Enterprise Linux 5.0, set the LANG environment
variable to C in your shell initialization file. For example, in the

Bash shell, you would include the following line in the file:

LANG=C
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Possible Syntax Error in Linux

After installing Adobe Reader in Linux, you may see the following
error:

expr: syntax error

expr: syntax error

expr: syntax error

expr: syntax error

expr: syntax error

expr: syntax error

expr: syntax error

expr: syntax error

expr: syntax error

expr: syntax error

[2]+ Killed ./acroread

[root@owhp64 bin]#
It doesn't appear to stop until you use the kill command in another
terminal window.
To fix it, you must edit ReaderHome/bin/acroread. Basically, a line just
needs an asterisk.
Fix Adobe Reader's "expr: syntax error" message
Find acroread (it is a shell script, probably in /usr/local/bin or under
whichever-directory-you-specified-during-installation/bin) and apply
this patch:

--- acroread.old 2007-06-01 18:18:49.000000000 -0500

+++ acroread

2007-06-01 18:20:57.000000000 -0500

@@ -415,7 +415,7 Q@@

fi

return 1

echo Smfile| sed 's/libgtk-x11-\([0-

91*\).0.50.0.\([0-9]\)00.\N([0-9T*\)\ I\ (.*\)/\1\2\3/qg"'

+

echo Smfile| sed 's/libgtk-x11-\([0-

91*\) .0.50.0.\([0-91*\)00.\ ([0-97*\)\ I\ (.*\)/\1\2\3/g"

return O

fi
Alternatively, edit acroread using a text editor such as vi(1) and add an
asterisk after the second [0-9] block in line 418.
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After Upgrading, My Application Stops Working

Some older Landmark applications are built specifically for

Oracle 10g, and depending on your upgrade path and other issues, the
OpenWorks installation program may not have been able to configure
your environment so that the other applications can properly run with
the upgraded OpenWorks and database software.

For more information, see the following section in the “Upgrade the
Oracle Software: 10g to 11g”chapter:

“Oracle 11g Compatibility with Some Applications” on
page 136
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Appendix: Oracle Tuning Parameters

After installing the Oracle database, there are a variety of parameters
that can be altered that may enhance performance of certain database
operations. These can either be actively managed by a database
administrator (DBA) or using Oracle’s automatic tuning options.

This appendix provides general information on how to set up the
OpenWorks® database for automatic tuning. Some of these settings,
such as those that affect shared memory, may depend on hardware
available to the database.
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Example Parameters

This is an example of parameter recommendations for a machine that
has 8 GB of RAM and that will mainly be used for running the Oracle
database.

The parameters sga max_size, sge target, and pgc aggregate target
should be altered if your machine has more or less RAM than the

example.
Parameter ng::‘;\tl;':;:(g Instance Recommendations
statistics_level BASIC TYPICAL
compatible — /0g 10.1.0.2.0 10.2.0.5.0
compatible — //g 11.1.0.0.0 11.1.0.0.0
Db _cache advice OFF ON
sec_case sensitive logon | false false
sga_max_size* 1024 MB 3GB
pga aggregate target*® 24 MB 1 GB
Redo Log Size** 100 MB 150 MB

*These values should be modified depending on expected workload and available
hardware.

**This is not an Oracle parameter, and it can be modified during the OpenWorks®
database installation.
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Setting Tuning Parameters

Tuning parameters that can be set include the following.

compatible: For Oracle 10g, setting this parameter to 10.2.0.5.0
instead of 10.1.0.2.0 allows the Oracle software to use the
10.2.0.5.0 optimizer. For Oracle 11g, this parameter should be set
to 11.1.0.0.0.

sga_max_size, sga_target, and pga_aggregate target: Setting
these parameters allow the Oracle software to automatically tune
the System Global Area (SGA). The SGA is areas of shared
memory dedicated to the database instance. With the SGA tuned,
the Oracle software can also dynamically set the following
parameters as needed: db_cache, java_pool, shared pool, and
streams_pool.

Value of sga_target: The value for this parameter should be
zero. Other values may risk a conflict with other settings.

sga_max_size: This parameter sets the maximum value that the
sga_target can be set to. It is not recommended to increase this
setting to more than 40% of the machine’s available RAM.

pga_aggregate_target, and workarea_size_policy: Setting these
parameters allow the Oracle software to automatically tune the
Program Global Area (PGA). PGA is an area of memory where
data and control information for server process are stored.

statistics_level: Setting this allows the collection of statistics that
are then used for the automatic tuning of both PGA and SGA.

Redo Log Size: Optimizing the size of the redo logs will prevent
bottlenecks that can be caused by some database operations when
dealing with large data sets.

Modifying Redo Log Size

The Redo Log Size parameter can be modified in the OpenWorks®
database installer.

If the size of the redo log needs to be changed after the database has
been created, use the following steps.The resizing of the redo logs can
be done while the database is running.
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1. Use the following command in a script to get an idea of the current
size and location of the redo log files.

SELECT a.group#, a.member, b.bytes FROM vS$Slogfile a,

WHERE a.group# = b.group#;

GROUP# MEMBER

w w NN P

/u03/app/oradata/OW5000/redo gOla.
/u04/app/oradata/OW5000/redo gOlb.
/u03/app/oradata/OW5000/redo g02a.
/u04/app/oradata/OW5000/redo g02b.
/u03/app/oradata/OW5000/redo g03a.
/u04/app/oradata/OW5000/redo g03b.

log
log
log
log
log
log

BYTES

16,777,216
16,777,216
16,777,216
16,777,216
16,777,216
16,777,216

vslog b

The above shows six rows selected, each row with a different redo log file.

2. To perform this task it requires that you make the lasts redo log
CURRENT. This script command shows you first how to query
the status of the log groups and then how to force the log switch.

select group#, status from vs$log;

GROUP# STATUS

1 CURRENT
2 INACTIVE
3 INACTIVE

Followed by these script commands:

alter system switch logfile;
alter system switch logfile.
select group#, status from vs$log;

GROUP# STATUS

1 INACTIVE
2 INACTIVE
3 CURRENT
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3. Drop the first group of logs with the following script command.

alter database drop logfile group 1;

Possible error from dropping log group

Dropping the first group of logs could result in the following error:
ALTER DATABASE DROP LOGFILE GROUP 1
ALTER DATABASE DROP LOGFILE GROUP 1

*

ERROR at line 1:

ORA920 (thread 1)
ORA-00312: online log 1 thread 1: ‘FileName’

You can resolve this error by performing a checkpoint on the database:

ALTER SYSTEM CHECKPOINT GLOBAL:

ORA-01624: log 1 needed for crash recovery of instance

4. Recreate the dropped redo log files with the new size.

alter database add logfile group 1 (
'/u03/app/oradata/Ow5000/redo_g0la.log"',

'/ul04/app/oradata/OW5000/redo_g0lb.log') size 128m reuse;

5. Force another log switch

select group#, status from vs$log;

GROUP# STATUS

1 UNUSED
2 INACTIVE
3 CURRENT

alter system switch logfile;
select group#, status from vs$log;

GROUP# STATUS

1 CURRENT
2 INACTIVE
3 ACTIVE

6. Include script commands for steps 2 through 5 for log groups 2 and

3.

7.  Verify that the log switch was successful by using the query from

step 1 again.
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SELECT a.group#, a.member, b.bytes FROM vS$Slogfile a,

WHERE a.group# = b.group#;

GROUP# MEMBER

w w NN P

/u03/app/oradata/OW5000/redo gOla.
/u04/app/oradata/OW5000/redo gOlb.
/u03/app/oradata/OW5000/redo g02a.
/u04/app/oradata/OW5000/redo g02b.
/u03/app/oradata/OW5000/redo g03a.
/u04/app/oradata/OW5000/redo g03b.

log
log
log
log
log
log

More Performance Tuning Information

BYTES

vslog b

134,217,728
134,217,728
134,217,728
134,217,728
134,217,728
134,217,728

For more information about tuning parameters, see the documentation
from Oracle (such as Oracle Database Performance Tuning Guide).
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Appendix: Removing an Installation

Use the procedures in this appendix to uninstall the Oracle server and
the OpenWorks® database instance, and all recovery files; and to
uninstall the OpenWorks® software.

The procedures in this section are for version 5000.8.1.0 of the
OpenWorks software and database instance, and for the Oracle 11g
server as embedded into the OpenWorks software. For information
about uninstalling the OpenWorks software or the Oracle server from
an earlier release, see the OpenWorks® Software Installation
Procedures manual for that version.

See the following:

*  “Removing the Oracle Server or OpenWorks Instance” on
page 179

*  “Removing OpenWorks® Software” on page 182

Removing the Oracle Server or OpenWorks Instance

Sometimes before installing Oracle you may want to completely
remove all vestiges of a previous installation of Oracle. The steps in
this section will guide you through the process of completely removing
Oracle Server.

This procedure has the following assumptions:

» All data in the database has been backed up in a location other than
the database directories.

*  You have backed up certain other files such as configuration files,
database files, and scripts you have written. These files may be
stored in Oracle’s home directory as well as other places.

*  You want to cleanly uninstall Oracle.

*  You want to delete all Oracle instances and databases.
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Warnings

Some of the steps in this procedure can cause trouble for the operating
system if they are performed incorrectly or incompletely.

*  Aborting the uninstall procedure in the middle of the procedure
may leave the system in an undetermined condition.

*  Some of the steps must be executed as Super User (or root). There
is no undo for these steps.

Deleting Oracle 11g

The uninstall program allows you to delete all of Oracle completely
(the server software, the database, the OpenWorks database instance,
and all recovery files), to delete the OpenWorks database instance and
schemas, or to delete just the OpenWorks schemas.

To delete all of Oracle or to delete just a part, do the following:

1. Ensure the database is running. The database must be running for
this procedure

2. Log in as the Oracle user.
3. Launch the uninstall program:
* In Windows select:

Control Panel > Uninstall Programs >Landmark
OpenWorks Database

or

Control Panel > Add Or Remove Programs > Landmark
OpenWorks Database

* In Linux, in a path similar to the following, execute:

OracleUserHome /LLandmark/OpenWorksDatabase/
Uninstall_Landmark_OpenWorks_Database/
Uninstall_Landmark_OpenWorks_Database

4. Follow the prompts.
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5. Reboot your system to complete the removal of the database
software.
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Removing OpenWorkse Software

The procedure outlined below will delete anything in the OpenWorks®
home directory (as well as other files), including any other applications
or files installed in the OpenWorks® directory.

Move customized files that you want to preserve

Before performing an uninstall, move any files that you created and want to
preserve to a location other than an OpenWorks® directory.

Windows
Use the standard Windows program-removal utilities (Add/Remove
Programs or Programs and Features/Uninstall, in Windows 7) to
remove OpenWorks®. You must reboot to complete the removal of the
software.

Linux

1. Log on as root.

2. Set the OpenWorks® home environment variable, OWHOME. For
example:

OWHOME=/Landmark/programs/OpenWorks
export OWHOME

3. Stop the NetD, PD, and license manager processes. Enter the
following commands in the OpenWorks® home directory:

./bin/stop_pd
./bin/stop_netd
./lam/bin/stoplmgrd

4. Run owremove, located in the install subdirectory in the
OpenWorks® home directory. For example:

/Landmark/programs/OpenWorks/install/owremove
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The following folders are removed in the uninstall process.

app- lib mksnt
defaults

bin lib64 revisions
dat lib64rh5 files
conf* jre install*
docs bitmaps *.log

jar X11

5. After owremove has finished, delete the OpenWorks® home
directory if it still exists.

For example:

rm -rf /Landmark/programs/OpenWorks

5000.8.1.0

Removing OpenWorks® Software

183



OpenWorkse Software Installation Procedures Appendix: Removing an Installation

184 Removing OpenWorks® Software 5000.8.1.0



	OpenWorks® Software Installation Procedures
	Contents
	Introduction
	About the OpenWorks® 5000.8.1.0 Software
	Supported Platforms
	New Installations of the OpenWorks® Software
	Database Software Installation: 64-bit versus 32-bit

	Installing on an Existing Oracle Database
	Upgrading from Oracle 10g to 11g
	Upgrading Projects

	System Requirements
	Platform/Hardware Specifications
	Hard Drive Space
	Server Disk Space
	Client Disk Space

	Graphics Card
	Software Specifications
	All Platforms
	Windows Only


	Licensing
	Third-Party Applications: License Agreements
	OpenWorks® Documentation
	Online Help
	Documents in PDF Format
	Downloading Adobe Reader
	Installing Adobe Reader on Linux
	Installing Adobe Reader on Windows



	Windows Procedures
	Scope
	Assumptions
	Windows Server Installation Tasks
	Create a User Account on the Server
	Install the Oracle Software and OpenWorks Database Instance

	Windows Client Oracle Installation
	Install Oracle Software on the Client Machine

	Install the OpenWorks® Software
	Windows Post-OpenWorks®-Installation Tasks
	Set up the Oracle Wallet for Multiple Users
	Configure the MKS Toolkit and Open Text Exceed
	Configure the OpenWorks® License
	Grant Database Access to the OpenWorks® User
	Understand and Configure Districts
	Manage the Location of OpenWorks® System Files
	Manage the Location of OpenWorks® Project Files
	Manage the Location of Seismic Data Files (dir.dat Configuration File)
	Turn Off AutoExtend


	Linux Procedures
	Scope
	Assumptions
	Linux Server Installation Tasks
	Prerequisites
	Check Software Packages (RPMs)
	Check Swap Space on the Server
	Set Shell Limits for the Oracle User
	Configure Kernel Parameters
	Create the Oracle User

	Run the Pre-Oracle Utility (Recommended)
	Install Oracle Database Software and OpenWorks Database Instance
	Server Post-Oracle-Installation Tasks

	Linux Client Procedures
	Prerequisites
	Check Software Packages (RPMs)

	Install Oracle on the Client
	Client Post-Oracle-Installation Tasks
	Fix Directory Permission Problem


	Install the OpenWorks® Software
	Linux Post-OpenWorks®-Installation Tasks
	Change the Security Context for SELinux (64-bit RHEL 5 Servers)
	Update Linux LAM Server Information in .lgclogin
	Create Local Users
	Update Users
	Grant Database Access to the OpenWorks® User
	Understand and Configure Districts
	Manage the Location of OpenWorks® System Files
	Manage the Location of OpenWorks® Project Files
	Manage the Location of Seismic Data Files (dir.dat Configuration File)
	Run the owsetup Script on Linux Server
	Set Oracle to Start Database at Boot Time
	Turn Off AutoExtend

	Starting OpenWorks®

	OpenWorks® Schemas on an Existing Oracle Database
	Scope
	Prerequisite: For OpenWorks Schemas on an Oracle 11g Database
	Install OpenWorks® Schemas on an Existing Oracle Database

	Upgrade the OpenWorks® Software
	Install the New Version of the OpenWorks® Software
	Upgrade the Oracle Software
	Remove the Oracle Wallet Directory and its Files
	Deleting a User’s Wallet

	Upgrade the Projects in the OpenWorks® Database
	Upgrading a Project Database Using the Command Line
	Upgrading All Project Databases Using the Command Line
	Upgrading Projects With Project Administration

	Linux Post-installation Steps
	Updating Users

	Windows: Post-installation Steps

	Upgrade the Oracle Software: 10g to 11g
	Assumptions for the Database Upgrade Procedure
	Linux: Oracle Database Upgrade
	Check Prerequisites
	Install Oracle 11g in Linux
	Run the Database Administration Tool in Linux
	Update Oracle User Environment

	Linux: Upgrade Oracle Client
	Prerequisites
	Install Oracle on the Client
	Fix Directory Permission Problem


	Windows: Oracle Database Upgrade
	Perform Prerequisites
	Install Oracle 11g in Windows
	Run the Database Administration Tool in Windows
	Update Oracle Environment

	Windows: Upgrade Oracle Client
	Install Oracle Software on the Client Machine

	Oracle 11g Compatibility with Some Applications
	Set the OW_ORACLE_VERSION Variable
	Link to Oracle 11g Libraries


	Upgrade OpenWorks® R2003.12 Database
	Database Differences and Assumptions
	Differences in the Oracle Databases
	Assumptions for Upgrading

	Pre-Migration Steps
	Upgrading to Version 5000.x.x.x
	Preparing the R2003.12 Database for Export
	Exporting the Database from OpenWorks® R2003.12
	Procedures in the OpenWorks® 5000.x.x.x Installation
	Possible Errors During the Import

	Password Changes and the Oracle Wallet
	Environment Changes
	OpenWorks® Database Installation Program Configures Oracle Wallet
	OpenWorks® Installation and sqlnet.ora on Client Machines

	District Configuration
	System, Project, and File Locations
	OpenWorks® System File Locations
	OpenWorks® Project File Locations
	Seismic Data File Locations (dir.dat Configuration File)
	Example dir.dat for Windows
	Example dir.dat for Linux



	Appendix: Troubleshooting
	Adobe Reader and Linux
	Linux: Other Readers
	Linux: Opening PDF Files in the Nautilus File Manager
	Linux: Running Adobe Reader from the Gnome Panel
	Possible Syntax Error in Linux

	After Upgrading, My Application Stops Working

	Appendix: Oracle Tuning Parameters
	Example Parameters
	Setting Tuning Parameters
	Modifying Redo Log Size
	More Performance Tuning Information


	Appendix: Removing an Installation
	Removing the Oracle Server or OpenWorks Instance
	Warnings
	Deleting Oracle 11g

	Removing OpenWorks® Software
	Windows
	Linux



